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1. Overview

Features

New 3624 mm Full Frame CMOS
Image Sensor

Supports image capture at resolutions up to 6048
X 4032 pixels.* By switching the imager mode, the
unit can natively support many shooting formats,
including Super 35 24.3 x 12.8 mm, 4096 X 2160
pixel resolution (equivalent to 3-perforation
motion picture film) and 4:3 Anamorphic* Super
3524.3 x 18.3 mm, 4096 x 3024 pixel resolution

(equivalent to 4-perforation motion picture film).
* Full Frame and Anamorphic modes require licenses sold
separately.

Wide Latitude

The unit supports 15+ stops of latitude. It features
very low noise for delivering phenomenal images
in conditions from searing sunlight to almost

no light, allowing for unprecedented creative
freedom in grading.

Wide Color Space Capture

Images can be captured in a color space that
exceeds DCI-P3. The degree of freedom in the
grading is dramatically improved when using
Sony’s S-Gamut and S-Gamut3.Cine color space
together with S-Log3.

Dual Base ISO

The unit supports two selectable native 1SO
settings (150500 and 1SO2500). Using Base 1SO500
under normal lighting conditions and Base

ISO2500 under low light conditions allows you
to maintain the latitude balance between bright
and low light conditions when shooting, without
graining (noise).

PL Lens Mount

Equipped with the industry-standard PL lens
mount. The lens mount supports Cooke /i
technology, and lens information is recorded as
metadata frame by frame.

F Mount Lens

E mount lenses are supported by removing the PL
lens adaptor. E mount lenses are smaller and lighter
than PL lenses, and are available in a diverse lineup for
expanded possibilities in image reproduction.

Compact Body and Intuitive
Operation

A relatively compact design for a device equipped
with a large Full Frame image sensor, achieved
using Sony’s miniaturization technology, which
allows easier shooting in confined spaces or on
drones.

The position, shape, and size of the control
buttons reflect the requirements of camera
operators for intuitive operation. They also feature
backlighting for ease of use in dark locations.

Engineered to Survive

The chassis is made from magnesium alloy for
high robustness and durability. The ventilation
system is completely isolated from all electronic
components to prevent ingress of dust, sand, and
liquids.*

The silent-running fan can be cleaned or even
swapped out on set quickly and easily to maintain
high redundancy.

* Design protects against dust and rain, but cannot
completely prevent the ingress of dust and liquid.

Modular Design

Features a fully modular design, allowing you

to flexibly support various rigs and peripheral
equipment according to the shooting application.
The top handle and viewfinder are easily adjustable
to maintain ergonomic balance and ease of use with
lenses. The height of the optical axis is the same

as the PMW-F55, permitting the use of peripheral
devices used with the PMW-F55. And an optional
AXS-R7 Portable Memory Recorder can be securely
attached to the rear of the unit using four hex
SCrews.

8-Position Optical ND Filter

Employs an 8-position optical ND filter. It offers
a wide ND range of 0.3ND (1/2 = 1 stop) to
2.4ND (1/256 = 8 stops) that reduces time lost
on set changing external ND filters. The ND filter
mechanism is servo-controllable.

Intuitive and Familiar On-Set
Operation

The menu screen is available from both sides of
the camera, with the main control display on the
Assistant side of the camera for fast access to the
camera settings by the camera assistant while
shooting.

An OLED mini display on the Operator side allows
the operator to access commonly accessed
features such as ND filter position, shutter, white
balance, exposure index (El), and frame rate (FPS),
making it convenient for the operator to check the
status of the unit.

Various Recording Formats

The unit supports recording on SxS memory cards
in XAVC 4K/QFHD, MPEG HD, and HD ProRes 422
formats. In addition, it can record in 16-bit RAW or
X-OCN format onto AXS memory cards when used
in combination with an optional AXS-R7 Portable
Memory Recorder.
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1. Overview: Features

Effective Picture Size Software Licenses

The unit supports shooting in the following effective picture sizes.

You can select software licenses (optional) according to the intended usage of the unit.

[Note] Software licenses are installed using Maintenance > License Options (page 58) in the full menu.
A software license is required to shoot in 6K 17:9, 6K 1.85:1, 6K 3:2, 4K 4:3, and 4K 6:5.
Software license Imager mode  Effective W Xx H(mm) Project frame rate
6K 3:2 number of
1 pixels
S L. 4K 6:5 (Image pixels)
prL8sd 1 o License not required 38K 169 3840x 2160  228x128  23,24,25,29, 50,59
4K 4:3 38K 16:9 3840 % 2160 228x128  23,24,25,29
Surround View (4268 x 2400) (254 % 14.3)
6K 17:9 —¢ i 4K17:9 4096 x 2160  243x128  23,24,25,29,50,59
i i 4K 17:9 4096 x 2160 243%x128 23,24, 25,29
i i Surround View (4552 x 2400)  (27.0x 14.3)
| i ALre Anamorphic License 4K 43 40963024 243x183  23,24,25,29
i i (Det k) 4K 4:3 Surround 4096 x 3024 243 %183 23,24, 25,29
| i View (4552 3360)  (27.0 x 20.0)
i o - 3.8K16:9 4K 65 40963432 243X 204 23,24,25,29
i i (Ultra HD) Full Frame License 6K 3:2 6048 x 4032 359x%x 240 23,24,25
6K 1.85:1 6054 x 3272 36.0x 194 23,24, 25,29
6K 17:9 6054 x 3192 36.0%x19.0 23,24, 25,29
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1. Overview: Features

Surround View

Surround View is a mode available in the following imager modes that displays an image range that
includes a 5% outer region beyond the effective picture size (top/bottom/left/right) in the viewfinder and
SDI'monitor output, allowing you to view a larger image range when shooting. The recorded image area
does not include the outer region.

38K 16:9

4K17:9

4K 4:3

[Notes]
® |n this mode, limitations on the maximum project frame rate setting may apply.
® |n 4K 4:3 mode, you can view only the top and bottom outer regions.
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System Configuration

Microphone Holder (A-2182-620-A)
Rod Clamp (A-2182-621-A)
Rod (4-684-612-01)

DVF-EL200 DVF-L700 ECM-680S, ECM-678,
Viewfinder Viewfinder ECM-674
(VF cable (A-2201-632-A or Microphone
A-2201-633-A) is required) (EC-0.5X3F5M is required)

[] )

N =
=l AXS-R7 AXS-A256524, AXS-A512548, AXS-AR1, AXS-CR1
Sm: Portable Memory AXS-A512524, AXS-ATTS48, AXS- AXS Memory Card
E(M: Recorder A1TS24 Reader
gl: AXS Memory Card
SCL-PKe,
SCL-P11X15
S35 PL Lens
i ) E‘f BP-FL75, BP-FLX75
——— aD
0-(O — Battery Pack
80 Hi
y o
I(
CBKZ-3610A, 1N ©. E° )
CBKZ-3610AM, Anamorphic Lens / / S~
CBKZ-3610AW (PL mount / E mount) MPC-3610 AXS-ART1
Anamorphic AXS Memory Card Reader
License 'l
AC-DN2B, AC-DN10
— _—~ AC Adaptor
,TST—
% © ' SBAC-US30/UT100
G |' USB Card Reader
Full Frame Lens '
(PL mount / E mount) VETESAS SBP-64/128/256E, SBS-32/64/128G1C
CBKZ-3610F, Shoulder Adaptor 5xS Mermory Card
CBKZ-3610FM,
cBezo10my —_— QD-G32/64/128E

Full Frame License XQD Memory Card

(ODA-EX1 XQD ExpressCard Adaptor is required)

SELP28135G, SEL1635GM, SEL2470GM, SEL70200GM, SEL100400GM,
SEL1224G, SEL35F 147, SEL50F 147, SEL85F14GM, SEL90M?28G,
SELT00F28GM

E Mount Lens
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| ocation and Function of Parts

Operator Side

Airinlet
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SXS memory card
slot block (page 8)
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. ASSIGN (assignable) buttons 1/2 (page 36)
Assign functions using the EDIT page of the
user functions screen (page 36).

The assigned function toggles between on/off
(enable/disable) or is activated with each
press.

. ASSIGN (assignable) lamps 1/2 (page 36)
Each lamp is lit orange when the assigned
function is on (enabled) or activated, and not
lit when the function is off (disabled).

. Mini display ITEM keys 1 to 3
Controls the operation of functions on the
mini display (page 62).

. Mini display
Displays various setup items, such as shutter

angle, that you can check or modify
(page 62).

5. ACCESS lamps (SLOT A/B)

Each lamp is lit when the recording media in
SXS card slot A/B is the target for recording/
playback and when data is being written to or
read from the recording media in SxS card slot
A/B (page 23).

Network connector (RJ-45)

Connect to a wired LAN network using a LAN
cable (not supplied) for remote control of the
unit (page 65).

CLIPS button
Press to display the clip screen on the mini
display to enable clip operations (page 64).

10.

11.

12.

Simultaneously, the clip list screen is displayed
on the sub display and can also be used for
clip operations.

To switch from playback mode to shooting
mode, press the HOME button.

Power switch

Set to the ON position (1) to turn the power on.

Set to the OFF position (@) to turn the power
off.

[Notes]

® This unit uses a small amount of standby power
even when the power switch is set to OFF. Remove
the battery pack if the unit will not be used for a
prolonged period.

e When removing the battery pack or the DC IN
power, be sure to first set the power switch to the
OFF position. Interrupting the power supply during
recording or during memory card access could cause
a malfunction.

HOME button

Press to clear the item selection display and
return to the Home screen on the mini display.
If pressed when the unit is in playback state,
the unit transitions to shooting mode

(page 62).

LOCK switch

Locks the operation of the buttons on the
Operator side. When locked, the switch
background LED lights in orange.

Headphones connector (stereo mini jack)
Connect to earphones for audio monitoring.
You can monitor the input audio during
shooting/recording and playback sound
during playback (page 61).

Built-in speaker

You can monitor the input audio during
shooting/recording and playback sound
during playback. The speaker also sounds
alarms to reinforce visual warnings

(page 61).

If you connect earphones to the headphones
jack, the speaker output is suppressed
automatically.

. REC ACTIVE lamp

The lamp is lit green when the REC button is
enabled.

. ASSIGN (assignable) lamp 3 (page 36)

The lamp is lit orange when the assigned
function is on (enabled) or activated, and not
lit when the function is off (disabled).

. REC (recording start/stop) button/lamp

Press to start recording, turning the REC lamp
on. Press again to stop recording, turning the
REC lamp off (page 67).

The REC lamp flashes when a device error or
warning occurs.

. ¢ mark

The ¢ mark is on the same plane as the image
sensor.

To measure the precise distance between the
unit and the subject, use the ¢ mark as a
reference.
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1. Overview: Location and Function of Parts

xS memory card slot block (page 23)

The SxS memory card slots are located behind the
cover.

1.
2.

3.

Lo

SxS memory card slots A/B

Manufacturer calibration terminal
Manufacturer terminal for calibration and
servicing (cannot be used by users).

SLOT SELECT (SxS memory card select)
button
Press to switch the active slot.

Assistant Side

1.
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ASSIGN (assignable) button 4 (page 36)
Assign functions using the EDIT page of the
user functions screen (page 36).

The assigned function toggles between on/off
(enable/disable) or is activated with each
press.

ASSIGN (assignable) lamp 4 (page 36)

The lamp is lit orange when the assigned
function is on (enabled) or activated, and not
lit when the function is off (disabled).

Sub display

Allows you to check the operation status of
the unit and make various settings

(page 29).

12‘

11 10

With the Home screen displayed, press and
hold the BACK button (page 9) and turn

the SEL/SET dial to adjust the brightness of the
sub display and mini display.

The brightness can also be adjusted using
Technical > Control Display > Brightness level
(page 57) in the full menu.

Sub display ITEM keys 1 to 6
Controls the operation of functions on the sub
display (page 39).

. Tape measure hook

The tape measure hook is on the same plane
as the image sensor. To measure the precise

distance between the unit and the subject, use

the tape measure hook as a reference. You can
attach the end of a tape measure to the hook,
and measure the distance from the subject.

HOME button

Press to clear the display and return to the
Home screen on the sub display (page 31).

If pressed when the unit is in playback state,
the unit transitions to shooting mode.

MENU (menu display on/off) button (pages
39,47)

Press the MENU button to display the menu
screen on the sub display. Press and hold the
MENU button for 2 seconds or longer to
display the full menu screen on the sub
display. Press the button during menu screen
or full menu screen display to return to the
previous screen display.

SEL/SET (select/set) dial (MENU dial)
Changes the item selection or a setting within
the menu (pages 31, 39, 47).

+48V power lamp

Lights in green if the AUDIO IN switch is set to
MIC and +48 V phantom power is supplied on
the AUDIO IN connector. It is not lit if phantom
power is not supplied.

You can turn +48 V phantom power on/off
using Audio category > Audio Details > Audio
Configuration > Phantom Power +48V

(page 55) in the menu.

. AUDIO IN (audio selector) switch

Select the input signal type corresponding to

the audio source connected to the AUDIO IN

connector.

LINE: When connecting an external analog
audio signal source

AES/EBU: When connecting an external digital
audio signal source

MIC: When connecting a microphone
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1. Overview: Location and Function of Parts

1.

12.

13.

14.
15.

16.

17.

18.

AUDIO IN connector (XLR 5-pin)

Input external microphone or audio
equipment signals.

When the audio source is set to LINE or MIC
using the AUDIO IN switch, this connector
functions as the AUDIO IN CH-1 and AUDIO IN
CH-2 connector.

When the audio source is set to AES/EBU using
the AUDIO IN switch, this connector functions
as an AUDIO IN CH-3/4 connector.

BACK button

Cancels the menu setting and moves up one
level in the menu hierarchy during menu
display. Cancels the execution process or
pending process during process execution/
pending display (pages 31, 39, 47).

LOCK switch

Locks the operation of the buttons on the
Assistant side. When locked, the switch
background LED lights in orange.

ACCESS (SD card access) lamp (page 25)

REC ACTIVE lamp
The lamp is lit green when the REC button is
enabled.

REC (recording start/stop) button/lamp
Press to start recording, turning the REC lamp
on. Press again to stop recording, turning the
REC lamp off (page 67).

The REC lamp flashes when a device error or
warning occurs.

CLIPS button

Press to display the clip list screen on the sub
display to enable clip operations (page 59).
Simultaneously, the clip screen is displayed on
the mini display.

To switch from playback mode to shooting
mode, press the HOME button.

USER button

Press to display the user function list on the
sub display, and to operate the ITEM keys 1 to
5 user function buttons.

ITEM key 6 is the user function list EDIT button.

Press this button to display the function
selection screen for the user function buttons
and assignable buttons. Press again when the
user functions screen is displayed to return to
the previous display (page 36).

Front

AU
=1

\_‘_f | — —J

. ASSIGN (assignable) button 3 (page 36)

Assign functions using the EDIT page of the
user functions screen (page 36).

The assigned function toggles between on/off
(enable/disable) or is activated with each
press.

PL lens mount adaptor (page 18)

. VF (viewfinder output) connector

(page 21)

LENS connector (12-pin)
Not supported in firmware version 2.0.

. 24V OUT connector (DC OUT 24V, Fischer

3-pin)

24V DC power supply output connector
(page 70).

The output voltage and maximum output
current of this connector vary depending on

the input voltage to the unit. The maximum
current includes the output current from the
24V OUT connector on the rear panel
(page 10).
11Vto 17 Vinput

Output voltage : 24 V

Maximum output current: 1.0 A

22Vto32Vinput
Output voltage: Same as the input voltage
Maximum output current: 2.0 A
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Rear

1.
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24V OUT connector (DC OUT 24V, Fischer
3-pin)
24V DC power supply output connector
(page 70).
The output voltage and maximum output
current of this connector vary depending on
the input voltage to the unit. The maximum
current includes the output current from the
24V OUT connector on the front panel
(page 9).
11Vto 17 Vinput

Output voltage : 24 V

Maximum output current: 1.0 A

22Vto32Vinput
Output voltage: Same as the input voltage
Maximum output current: 2.0 A

12V OUT connector (DC OUT 12V, Hirose
4-pin)

12V DC power supply output connector
(page 70).

The output voltage and maximum output
current of this connector vary depending on

the input voltage to the unit.

11Vto 17 Vinput
Output voltage: Same as the input voltage
Maximum output current: 1.0 A
22Vto32Vinput
Output voltage: 15V
Maximum output current: 0.8 A

. MONITOR OUT connector (BNC type)

HD SDI monitor signal output connector
(page 70).

. GENLOCK (genlock input) connector (BNC

type)

To genlock the unit to an external source or to
lock the timecode of the unit to an external
source, input an external reference signal.
Digital signal and analog signal input are
supported.

Digital signal: 1.5G HDSDI interlaced signal
Analog signal: HD sync, Analog

. TCIN (timecode input) connector (BNC type)

To lock the timecode of the unit to an external

9.

10.

11.
12.
13.

source, input a reference timecode signal.

AUX connector (LEMO 5-pin)
Outputs the timecode signal (page 71).

REMOTE (remote control) connector (8-pin)
Not supported in firmware version 2.0.

12V/24V (DC power input) connector

(page 15)

DC power supply input connector for external
power supply to the unit. Supports 12V and
24V input voltages.

o, o
No. Signal
1 GND
2 NC
3 NC
4 DCIN(11Vto17Vor22Vto32V)

Battery attachment terminal (page 15)

SDI OUT 1 to 4 (serial digital output)
connectors (BNC type) (page 70)

Battery pack mount (page 15)
Battery release lever (page 15)

HDMI OUT connector (page 70)



0m 1. Overview: Location and Function of Parts

Top

Bottom

123 4
o) @) O

1)

L@OQOQOQOQJ_

ngﬁ%ﬁ
®

;[OOOOOOOOO}/

O

O

OO0

/

L

o

1. External device connector

Used when an optional AXS-R7 AXS (Access

Memory Card System) Recorder is attached to

the unit to upgrade the AXS-R7 (page 27)
2. Release button (page 17)
3. Handle/VF attachment mount (page 17)

4. Accessory mounting screw holes
Type of screw: 1/4-20UNC (8)
Type of screw: 3/8-16UNC (10)

Length of engagement: 10 mm (3/8 inch) or

less
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Air vent

1. Tripod plate attachment holes
Type of screw: 1/4-20UNC (2)
Type of screw: 3/8-16UNC (4)
Length of engagement: 9 mm (3/8 inch) or less

2. Bottom cover
Remove the four hex screws to remove the

cover.

3. SD card slot (page 25)
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Viewfinder Screen

During shooting (recording or standby) and playback, the status and settings of the unit are
superimposed over the picture on the viewfinder screen.

Information displayed on the screen while recording
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1. Recording frame rate indicator 1.5:1/32
Displays the recording frame rate and project 1.8:1/64
frame rate. 2.1:1/128

24:1/256

2. Shutter angle/shutter speed indicator
Displays the shutter angle or shutter speed of 4.
the electronic shutter.

Thermometer icon

Displayed when a high temperature warning
message is issued.

The description is displayed in the Info
category in the menu.

3. ND filter indicator
Displays the density of the ND filter. The
display value is a LOG (base 10) value
(page 48). 5.
0.3:1/2

Warning icon
Displayed when other than a high

0.6:1/4 temperature warning message is issued.
09:1/8 The description is displayed in the Info
1.2:1/16 category in the menu.

10.

11.

12.

13.

14.

15.

. Exposure index indicator

Displays the exposure index (El) value.

. Color temperature indicator

Displays the color temperature and Tint value
of the white balance.

Look information display
Displays the selected Look (page 49).

Battery capacity/voltage indicator
Displays the following indicators according to
the type of battery power source.

Battery type Display

InfoLithium Battery remaining capacity

battery and remaining recording
time

Anton/Bauer Remaining battery capacity

battery (% indicator)

Other batteries Input voltage

VF LUT indicator
Displays the viewfinder LUT (page 49).

VF Double Speed Scan indicator

Displays the on/off state of the function for
doubling the frame rate of the viewfinder
display.

VF Peaking indicator
Displays the on/off state of the peaking
function of the viewfinder display.

VF Zebra indicator
Displays the on/off state of the zebra function
of the viewfinder display (page 37).

SDI OUT 1/2 connector LUT indicator
Displays the LUT setting of the SDI OUT 1/2
connectors (page 49).

SDI OUT 3/4 connector LUT indicator
Displays the LUT setting of the SDI OUT 3/4
connectors (page 49).

16. Monitor LUT indicator
Displays the LUT setting of the Monitor output
(page 49).

17. HDMI LUT indicator
Displays the LUT setting of the HDMI output
(page 49).
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18. SDI output REC trigger indicator

Displays the SDI output REC trigger status.

State Display
Technical > System Configuration > SDI Rec Remote Recording command
Trigger in the full menu superimposed on the
SDI output
Off - (Blank)
HD SDI Remote I/F Stop command Top: SDI
Bottom: Stop
Rec command Top: SDI
Bottom: REC
Parallel Rec Stop command Top: SDI-P
Bottom: Stop
Rec command Top: SDI-P
Bottom: REC

19. Network connection status indicator

Displays the network connection status.

State Display

Disconnected or other error (valid
network connection settings)

Flashing

Connected (valid network connection On
settings)

Network connection function not Blank

used

20. Audio level meter indicators

21.

Displays the levels of audio channels 1 and 2
while recording.

Recording media state/remaining capacity
indicator for each media slot

Displays the state and remaining capacity of
the media in SxS memory card slots A/B and
AXS memory card slots A/B.

Al mark on the left of “AXS” or “SxS” indicates
the recording target media.

An indicator A® on the upper right of the slot
A/B icon on the right of “AXS" or “SxS” indicates
the playback target media (green indicator
indicates media is being played).

A A iconis displayed for media if a condition
occurs that could impact recording.

22.

23.

24,

25.

High Key/Low Key indicator (Monitor output)
Displayed when the Monitor output is High
Key (screen for checking blown-out highlights)
or Low Key (screen for checking blocked-out
shadows) (displayed for Monitor Out output).

Recording media format (codec) indicator
Displays the format of the recording on an AXS
memory card or an SxS memory card .

Recording status indicator
Displays the following recording operation
states of the unit.

Display Description

Rec Recording

Recording standby

Clip name display

Displays the first 8 characters of the name of
the next clip to be recorded in recording
standby mode.

Displays the first 8 characters of the name of
the clip currently being recorded when
recording.

26.

2].

28.

29.

30.

31.

32.

33.

34.

Time data display

Displays the duration or timecode, depending
on the TC/Media category > TC Display setting
in the menu (page 40).

Iris position indicator

Displays the iris position (only when a lens that
is compatible with the iris setting display
function is attached).

The iris position indicator displays in 1/3 stop
increments when using an E mount lens.
[Note]

The F-stop value is displayed instead of the T-stop value
if the T-stop value cannot be obtained.

Focus position indicator

Displays the focus position (only when a lens
that is compatible with the focus setting
display function is attached).

Zoom position indicator

Displays the focal length of the zoom
(displayed only when a lens that supports the
zoom setting indicator is attached).

High Key/Low Key indicator (viewfinder
output)

Displayed when the viewfinder output is High
Key (screen for checking blown-out highlights)
or Low Key (screen for checking blocked-out
shadows) (displayed for viewfinder output).

Simultaneous recording status indicator
Displays the sub clip recording format in 1-slot
simultaneous recording mode (page 68).

SxS Sub LUT indicator

Displays the LUT setting to register for a sub
clip in SxS 1-slot simultaneous recording
mode.

SxS LUT indicator
Displays the LUT setting for SxS recording.

Base ISO indicator
Displays the configured native sensitivity.

35. Effective picture size indicator

Displays the effective picture size and whether
anamorphic de-squeeze conversion is applied,
set using Project category > Imager Mode in
the menu. In Surround View mode, a “Sur.V"
icon is displayed below the anamorphic
conversion factor icon (page 40).
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1. Overview: Location and Function of Parts

Information displayed on the playback screen

The following information is displayed on the
playback picture.

8

. Time data display

Displays the duration or timecode, depending
on the TC/Media category > TC Display setting
in the menu (page 40).

Playback clip name display
Displays the first 8 characters of the name of
the playback clip.

Playback status indicator
Displays the playback status.

Playback media format (codec) indicator
Displays the recording format (codec) of the
playback clip.

Playback media indicator

Displays the type of recording media being
played.

A 1Jicon appears on the right if the memory
card is write-protected.

9
é)
|

e e e I et I e I
1 2 3 4 5

6. Audio level meter indicators

Displays the levels of audio channels 1 and 2
during playback.

. Network connection status indicator

Displays the network connection status.

State Display

Disconnected or other error (valid Flashing
network connection settings)

Connected (valid network On
connection settings)

Network connection function not Blank
used

. Thermometer icon

Displayed when a high temperature warning
message is issued.

The description is displayed in the Info
category in the menu.

. Warning icon

Displayed when other than a high
temperature warning message is issued.
The description is displayed in the Info
category in the menu.
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2. Preparation

Preparing a Power Supply

You can use a battery pack or AC power via an AC
adaptor.

For safety, use only the Sony battery packs and AC
adaptors listed below.

Lithium-ion battery pack
BP-FL75
BP-FLX75

AC adaptor
AC-DN2B
AC-DN10

Using a Battery Pack

Insert the battery pack into the battery pack

mount (page 10) of the battery adaptor, then

slide the battery pack down to lock it in place.

To remove it, unlock the battery pack by sliding

it up while pressing the battery release lever

(page 10), then remove it.

[Notes]

e Before use, charge the battery pack with the battery
charger.

e A warm battery pack immediately after use may not be
able to be fully recharged.

® Remove the battery adaptor while supporting the unit
by hand.

Checking the remaining battery charge

When recording or playback is in progress using
the battery pack, the current battery remaining
time and battery voltage are displayed on the sub
display screen (page 29) and viewfinder screen
(page 12).

The unit indicates the remaining usage time in
minutes by calculating the available time with
the battery pack if operation is continued at the
current rate of power consumption.

If the remaining battery charge becomes low

If the remaining battery charge decreases to a
certain level during operation, the remaining
battery capacity indicator flashes and the REC
lamp flashes to warn you.

If the remaining charge further decreases to a
level at which operation cannot be continued, a
battery-empty message appears.

Replace the battery pack with one that is fully
charged.

To change the message levels

Change levels using Technical > Battery
(page 57) in the full menu.

Using AC Power (DCIN Power)

The unit works with AC power using the AC-DN10
(optional) or AC-DN2B AC adaptor (optional) and
CCDD-X2 DC cable (optional).

11Vto 17Vand 22 Vto 32 Vinput voltage ranges
are supported.

[Notes]

® When switching to the DC IN power supply during battery
operation, use a power supply with a voltage in the range
12Vto 17 V.

® When using 22 V to 32V, first set the power switch to the
OFF position before connecting the power supply.

® Do not switch directly froma 11 Vto 17V power supply to
a22Vto 32V power supply, or vice versa. This may cause
a malfunction.

Using a Battery Pack and DCIN
Power Supply Together

Whenever an active power supply is applied using
a battery pack and a DC IN power supply, the DC
IN power supply takes precedence.

[Note]

When the power supply switches from battery operation to

the DC IN power supply, operation of the unit may stop if the

following occurs.

e Chattering of the connector contacts when inserting the
DC connector

® \/oltage drop when switching between power supplies

(more prevalent when the external load is greater)
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2. Preparation

Setting the Clock

When you use the unit for the first time, the initial
setup screen appears on the sub display when the
power is turned on.

Set the date and time of the built-in clock using
this display.

Time Zone

The value shows the time difference from UTC
(Coordinated Universal Time). Change the setting
if needed.

[Note]
When Time Zone is changed, the clock setting changes
according to the time difference.

Setting the Date and Time

Turn the MENU dial (page 8) to move the

cursor, then press the MENU dial to set each menu
item. When you press the MENU dial when the
cursor is on “Set,” the setting display disappears
and the clock setting is completed.

After the initial setup screen disappears, you can
change Time Zone and date/time settings using
Maintenance > Clock Set (page 58) in the full
menu.

[Notes]

e |fthe clock setting is cleared because the backup battery
fully discharged when no power was supplied (no battery
pack and no DC IN connection), the initial setup display
will be displayed when you next turn the unit on.

e While the initial setup display is shown, no other
operation, except turning the power off, is permitted until
you finish the setting for this display.



2. Preparation

Attaching the VF Attachment and Handle

Attaching the VF Attachment Attaching the Handle

] Slide the VF attachment on in the direction of 1 Slide the handle on in the direction of the
the arrow to attach it. arrow to attach it.

2 Position the VF attachment in the desired 2 Position the handle in the desired front/rear
front/rear position, then turn the lock lever to position, then turn the lock lever to secure it in
secure it in position. position.

Hex socket
bolt

Lock screw

[Notes]
® You can also attach the VF attachment in the front/ [Notes]
rear or left/right orientation. ® You can also attach a lock screw using a hex wrench
e |f the lock lever is difficult to tighten or loosen, you (5 mm) to secure it in position.
can use a hex wrench (3 mm) on the lock screw on e |[f the lock lever on the handle becomes loose during
the top of the lock lever. use, you can secure the handle by tightening a hex
socket bolt (2 mm) beside the lock screw.
e You can also attach the handle in the reverse
To remove the VF attachment orration,

Turn the lock lever to loosen, press the release T he handl
button and slide the VF attachment off in the 0 remove the handle

reverse direction from when attaching it.
s en attaching Turn the lock lever to loosen, press the release

button and slide the handle off in the reverse
direction from when attaching it.
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2. Preparation

Mounting a Lens and Adjusting the Flange Focal Length

Recommended PL mount lens (Super 35mm size)
SCL-PK6/F, SCL-PK6/M (set of 6 lenses, 20 mm/25
mm/35 mm/50 mm/85 mm/135 mm)
SCL-PK3/F, SCL-PK3/M (set of 3 lenses, 20 mm/25
mm/135 mm)

SCL-P11X15

Recommended E mount lens

SELP28135G, SEL1635GM, SEL2470GM,
SEL70200GM, SEL100400GM, SEL1224G,
SEL35F147, SEL50F14Z, SEL85F14GM, SELOOM28G,
SELTO0F28GM

For details about available lenses for the unit, contact a Sony
service representative.

[CAUTION]

Do not leave the lens facing the sun. Direct
sunlight can enter through the lens, be focused in
the unit, and cause fire.

[Notes]

e Turn the unit off before attaching or removing the lens
and adapter.

e Alensis a precision part. Do not place the lens down with
the mount side facing down. Attach the cap supplied
with the lens.

e The lens interface of the unit is configured by factory
default for an SCL-P11X15 and lenses with Cooke type
connector. To use an SCL-PK6, SCL-PK3, or other lenses
that do not have a Cooke type connector, set Technical
> System Configuration > Lens Interface (page 56)
to Off in the full menu. If this setting is not correct, an
alert message appears when the unit is turned on after
attaching the lens.

Attaching a PL Mount Lens

Remove the mount cover from the lens mount

by turning the PL mount lever
counterclockwise.

PL mount
lever

[Note]
Turn the PL mount lever counterclockwise to the
stopper position.

Insert the lens into the lens mount by aligning
the concave part of the lens with the
positioning pin on the upper right of the lens
mount.

Secure the lens by turning the PL mount lever
clockwise while holding the lens.

[Note]
Do not turn the lens when attaching the PL mount lens.
[t may cause damage to the hot shoe pin.

To attach a Cooke /ilens

Align the contacts on the lens with the hot shoe of
the unit. There are two connectors on the side of
the lens adaptor, and either can be used.

To remove the lens

] Turn the PL mount lever counterclockwise
while holding the lens from underneath.

2 Pull the lens forward.

[Notes]

If another lens will not be attached soon, carefully align
the concave part of the mount cover, then secure the
mount cover by turning the PL mount lever clockwise.

Adjusting the Flange Focal Length

The unit is shipped with the flange focal length
already adjusted. If you need to adjust the flange
focal length, remove the lens mount, and change
the shims with those of the appropriate thickness.
You can adjust the thickness by £0.1 mm in 0.01
mm increments.

Shims

The following shims are supplied with the unit.
0.05 mm x 1 (circular)

0.01 mmx 15 (1/3 arc)

1/3 arc shims should always be used as a set of
three shims. Insert shims to increase the flange
focal length. The unit is shipped with the flange
focal length already adjusted using the following
three types of shims.

0.10 mm (circular)

0.05 mm (circular)

0.01 mm (1/3 arc)

A seal is attached showing the shim thickness
when shipped.
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Adjusting the flange focal length

] Remove the six Torx screws and remove the PL
mount flange.

2 Loosen the four Phillips screws on both sides

of the PL connectors (two locations), and
remove the PL connectors and PL connector
plates.

3 Attach shims to the PL mount adaptor (three
locations).

PL connector plates

When using 1/3 arc shims
Attach shims so that they have the same
thickness in all three locations.

2. Preparation: Mounting a Lens and Adjusting the Flange Focal Length

{

Shims

When using circular shims
Attach with the surface that has markings on it
facing the front.

Markings

{

Markings

4 Reattach the PC connectors (two locations) to

their original positions, and tighten the four
Phillips screws with 0.18 N-m tightening
torque.

Reattach the PL mount flange in its original
position, and tighten the six Torx screws to a
tightening torque of 0.35 N-m using a T8
torque wrench.

(leaning the Filter

To clean the filter, first remove the adaptor.
Exercise care when wiping the adaptor center
part (shaded part) with a cloth or other material
to prevent fibers adhering to surfaces. If fibers are
adhering, wipe off using a soft brush.

Adaptor
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2. Preparation: Mounting a Lens and Adjusting the Flange Focal Length

Removing the PL Lens Adaptor

Remove the PL lens adaptor when you want to
mount an E mount lens to the unit. Attachment/
removal is performed with the rear side of the unit
facing down.

Remove the six hex screws (2.5 mm) and remove
the PL lens adaptor.

[Notes]

® Removing the battery and placing the rear side of the unit
face down provides stability.

e \When attaching/removing the adaptor, take care not
to touch the connector contacts of the unit and PL lens
adaptor.

To attach the PL lens adaptor

] Check that the mount lever is in the locked
position.

2 Place the PL lens adaptor back in its original
position, insert the six hex screws (2.5 mm),
and tighten the screws to a tightening torque

of 0.8 + 0.12 N-m using a hex wrench (2.5 mm).

Attaching an E Mount Lens

] Remove the PL lens adaptor (page 20).

2 Push the lock switch up, and turn the mount
lever clockwise to release the lock.

Mount lever

Lock switch

3 Align the mounting marks (white) on the unit
and lens mount, and then push the lens into
the mount.

4 Secure the lens by turning the mount lever
counterclockwise while holding the lens.

Mounting marks

To remove the lens

1

2

Push the lock switch up, and turn the mount
lever clockwise to release the lock.

Pull the lens forward.

[Note]

If another lens will not be attached soon, carefully
align the concave part of the mount cover, then
secure the mount cover by turning the mount lever
counterclockwise.
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2. Preparation

Attaching a Viewfinder

Available viewfinders for the unit
DVF-EL200: OLED color viewfinder
DVF-L700: LCD color viewfinder

Viewfinders are available separately.
This section describes attachment of the DVF-
EL200 as an example.

For details about attaching each viewfinder, refer to the
operating instructions of the viewfinder.

[CAUTION]

Do not leave the unit with the eyepiece of the
viewfinder facing the sun. Direct sunlight can
enter through the eyepiece, be focused in the
viewfinder, and cause fire.

[Notes]

e Attach/remove the viewfinder while the unit is turned off.

® AVF cable (A-2201-632 or A-2201-633-A) is required in

order to attach the DVF-L700. Also, turn the unit on after

setting the POWER switch of the DVF-L700 to the ON
position.

Attaching a Viewfinder

] Align the viewfinder shoe with the groove of

the viewfinder mount on the VF attachment,
and attach the viewfinder.

Turn the viewfinder lock lever in the LOCK
direction to secure it in position.

50— —— | ock lever

>

Connect the viewfinder and unit using the VF
connection cable.

Viewfinder side:

Position the connector with the mark (red) at
the top, and fully insert the connector.
Camera side:

Alight the concave part of the VF connector
with the connector mark (red), and fully insert
the connector.

- Clamper

[Note]
Secure the cable in the clamper as required.

To remove the viewfinder

1

Disconnect the VF connection cable from the
viewfinder and unit.

2 Turn the lock lever in the direction opposite to

LOCK, then remove the viewfinder from the VF
attachment.

Adjusting the Viewfinder Position

To adjust the front/rear position

1

2

3

Loosen one or both of the front/rear rod lock
levers of the VF attachment.

Slide the VF attachment forward/rearward to
adjust the viewfinder position.

.

S
5O
9

g

Rod lock
levers

i
A4

Tighten the rod lock levers.

[Note]

If a rod lock lever is difficult to turn, pull the lever out,
turn it to a position where it is easier to operate, and
then push the lever back in.
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To adjust the left/right position and height To adjust the viewfinder angle
(angle) You can adjust the angle of the viewfinder while

shooting.
1 Loosen the rod lock lever at the front of the VF

attachment. 1 Loosen the rotation lock lever on the

viewfinder mount.

2 Slide the VF attachment rod left/right and turn
the rod up/down to adjust the viewfinder
position.

2 Turn the viewfinder up/down to adjust the
angle.

Rotation lock lever

¢ 3 )
NS
Lock screw

~J
/%Z@\m Rod lock lever

3 Tighten the rotation lock lever.

3 Tighten the rod lock lever.

[Note]

When the rod lock lever is loosened, adjust the lock
screw using a hex wrench (3 mm) to prevent the
viewfinder from falling down.



023

2. Preparation

Handling SxS Memory Cards

This unit records audio and video on SxS memory
cards (optional) loaded in the card slots.

About 5xS Memory Cards

Use the following Sony SxS memory cards or XQD

memory cards.*
* When using an XQD memory card, the XQD ExpressCard
adaptor (QDA-EX1) is required.

The supported memory cards differ depending on
the recording format.

SxSPRO+
SBP-256D/E, SBP-128B/C/D/E, SBP-64B/C/D/E:
Supported for all recording formats

SXSPRO

SBP-64A, SBP-32:

MPEG 1920x1080i, HD ProRes 422,
HD ProRes 422 Proxy

X6-1

SBS-128G1B/C, SBS-64G1A/B/C, SBS-32G1A/B/C:
MPEG 1920x1080i, HD ProRes 422,

HD ProRes 422 Proxy

XQD memory card S series, G series
QD-S64E, QD-S32E, QD-G128A/E, QD-G64A/E,
QD-G32A/E: Supported for all recording formats

XQD memory card N series, M series
QD-N64, QD-M128A, QD-M64A, QD-M32A:
MPEG 1920x1080i, HD ProRes 422 Proxy

Operations are not guaranteed with other memory
cards.

These memory cards comply with the ExpressCard
standard.

For details on using SxS memory cards and usage-related
precautions, refer to the instruction manual for the SxS memory
card.

® SXS, SXS PRO, and SxS-1 are trademarks of Sony
Corporation.

® XQD is a trademark of Sony Corporation.

® The ExpressCard word mark and logo are
owned by Personal Computer Memory Card
International Association (PCMCIA) and are
licensed to Sony Corporation.

® ProRes is a registered trademark of Apple Inc.

All other trademarks are the property of their

respective owners.

Inserting an x5 Memory Card

Removing an 5xS Memory Card

] Open the cover of the card slot block
(page 8).

2 Insert the SxS memory card into the slot with
the SxS label facing to the right.
The ACCESS lamp (page 7) lights in red
then changes to green once the memory card
is ready for use.

3 Close the cover.

ACCESS lamp status

Card slots A and B each have an ACCESS lamp that
indicate the slot status.

Lamp Slot status

Lights in red Accessing the SxS memory card

(writing/reading data)

Lights in green Standby (ready for recording or
playback using the SxS memory

card)

Off ® No SxS memory card is loaded.
® The loaded card is invalid.
® An SxS memory card is loaded,
but the other slot is selected.

] Open the cover of the card slot block.

2 Pull out the SxS memory card.

[Note]

Data integrity is not guaranteed if the power is turned off or
a memory card is removed while it is being accessed. Data
on the card may be destroyed. Be sure that its ACCESS lamp
is lit in green or off when you turn off the power or remove a
memory card.

Switching Between SxS Memory
Cards

When SxS memory cards are loaded in both slot A
and slot B, you can press the SLOT SELECT button
(page 8) to select the SxS memory card to use.

If a card becomes full, recording continues after
automatically switching to the second card.

[Note]

The SLOT SELECT button is disabled while recording/
playback is in progress. The memory cards are not switched
even if you press the button.
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2. Preparation: Handling SxS Memory Cards

Formatting (Initializing) SxS Memory
Cards

When an unformatted SxS memory card or an SxS
memory card formatted in another specification
is loaded, a message notifying you that the media
has a different file system appears. In this case,
format the memory card in the following way.

1 Select TC/Media category > Format Media in
the menu.

2 Select SxS Slot A (slot A) or SxS Slot B (slot B),
then press the MENU dial.
A confirmation screen prompting whether to
format the card appears.

3 Press and hold ITEM key 1 and ITEM key 3 for 3
seconds to execute formatting.
Formatting starts, a message is displayed
during execution, and the ACCESS lamp lights
in red.
When formatting ends, a completion message
appears. Press the MENU dial to dismiss the
message.

If formatting fails

A write-protected SxS memory card or memory
card that cannot be used with this unit will not be
formatted.

A warning message is displayed. Replace the card
with an appropriate SxS memory card, according
to the instructions in the message.

[Note]

All the data, including recorded pictures and setup files, are
erased when a memory card is formatted.

Formatting while recording

Even while recording, the SxS memory card loaded
in the other card slot can be formatted.

Checking the Remaining Recording
Time

While shooting (recording or standby), you can
check the remaining capacity on the SxS memory
cards loaded in each slot using the recording
media remaining capacity indicator on the Home
screen of the sub display (page 29) or the
viewfinder screen (page 12).

The available time for recording with the current
video format (recording bit rate) is calculated
according to the remaining space on each card
and displayed in time units of minutes.

[Note]
A(g)icon appears if a memory card is write-protected.

Exchanging an SxS memory card

e [f the total remaining time on the inserted
memory cards during recording becomes less
than 5 minutes, the remaining media capacity
indicator flashes, the REC lamp flashes, and a
beep sound is emitted to warn you. Replace the
cards with those that have sufficient space.

e |f you continue recording, the message “Media
Full” appears, and recording stops when the
total remaining recording time falls to 0.

[Note]

Up to approximately 600 clips can be recorded on one SxS
memory card.

The display of remaining recording time changes to "0”
and the message “Media Full” appears when the clip limit is
reached.

Restoring an SxS Memory Card

If for any reason an error should occur in a memory
card, the card must be restored before use.

If an SxS memory card that needs to be restored is
loaded, a message prompting you to execute the

restore operation is displayed on the sub display.
To start the restore process, select Execute by
turning the MENU dial, then press the MENU dial.
The restoration starts.

During execution, a message is displayed and the
ACCESS lamp lights in red.

When restoration ends, a completion message
appears. Press the MENU dial to dismiss the
message.

If restoration fails

® A write-protected SxS memory card, or one on
which an error occurred, cannot be restored.
For such a card, a warning message is displayed.
Release the write protection or replace the card,
according to the instructions in the message.
® An SxS memory card on which an error occurred
may become usable again when reformatted.
® |n some cases, some clips can be restored while
others cannot. Playback of the restored clips
becomes possible again.
® The following operation may restore an SxS
memory card for which the message “Could not
Restore Some Clips” is repeatedly displayed each
time you try the restoration process.
[1] Copy the required clips to another SxS
memory card.
[2] Format the unusable SxS memory card on
the unit.
[3] Copy the required clips back to the newly
formatted SxS memory card.
[4] Update the management file as described
below.

[Note]

For restoration of media recorded with this unit, be sure to
use this unit.

Media recorded with a device other than this unit or with
another unit of different version (even of the same model)
may not be restored using this unit.

Updating the management file

If clips cannot be played back, updating the
management file on the card may improve the

situation.

Use TC/Media > Update Media (page 52) in the
full menu to update the management file.

If you write an XAVC file that is imported by RAW
Viewer V2.2 or later to the “XDROOT\Clip” directory
of an SxS memory card directly, that file can
become playable by executing Update Media.
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2. Preparation

Handling SD Cards for Saving Configuration Data

You can store the configuration file of the camera
on an SD card (optional). The stored file can be
loaded from the SD card.

Supported SD Cards

SDHC memory cards* (Speed Class: 4 to 10, non-
UHS, Capacity: 2 GB to 32 GB)

SD memory cards* (File system: FAT 16, Capacity:
up to 2 GB)

* Referred to as “SD cards” in this manual.

Inserting an SD Card

Insert an SD card into the SD card slot (page 11).
The ACCESS lamp (page 9) lights in red then
changes to green once the memory card is ready
for use.

ACCESS lamp status

Lamp Slot status

Lights in red Accessing the SD card (writing/

reading data)

Off ® No SD card is loaded.
® The loaded card is invalid.

Removing an SD Card

Press the SD card in slightly, then remove the card.

[Notes]

e Data integrity is not guaranteed if the power is turned off
or a memory card is removed while it is being accessed.
Data on the card may be destroyed. Be sure that its
ACCESS lamp is lit in green or off when you turn off the
power or remove a memory card.

® Make sure that the card does not pop out when inserting
or removing it.

Formatting (Initializing) an SD Card

SD cards must be formatted the first time they are
used in the unit.

SD cards for use in the unit should be formatted
using the format function of the unit. It is also
necessary to format an SD memory card if a
caution message is displayed when the card is
loaded.

If an SD card that was formatted in an
unsupported format is loaded in the unit, a file
system mismatch message is displayed.

] Select TC/Media category > Format Media >
SD Card in the menu, then press the MENU
dial.

A confirmation screen prompting whether to
format the card appears.

2 Press and hold ITEM key 1 and ITEM key 3 for 3
seconds to execute formatting.
Formatting starts, a message is displayed
during execution, and the ACCESS lamp lights
in red.
When formatting ends, a completion message
appears. Press the MENU dial to dismiss the
message.

[Note]
All data is erased when an SD card is formatted, and the data
cannot be restored.

To use media formatted with this unit in the slots
of other devices

Make a backup of the media, then format it using
the other device.
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Using with AXS-R7

You can record video/audio in RAW or X-OCN Docking module
to an AXS-R7 AXS (Access Memory Card System)
Recorder (optional) by attaching the recorder to
the unit.

Inserting an AXS Memory Card Switching Between AXS Memory
Cards

] Press the memory card slot cover open button

[Note]
To attach an AXS-R7 to the unit, the firmware version of the to open the cover. When two AXS memory cards are loaded, press
AXS-R7 may need to be updated according to the version the SLOT SELECT button of the AXS-R7 to switch

of the unit (page 27). The following shows the version active slot.
compatibility. e
OOO =
Version of unit Version of AXS-R7 S5
10,101 K \o ‘
S
20 2.0

(=
o)

SLOT SELECT button

[

Attaching the AXS-R7

3 Attach the AXS-R7 to the unit, and tighten the
four hex screws.
2 Insert the AXS memory card into the card slot

[Note]
with the label facing as indicated below.

Attach/remove the AXS-R7 while the unit is turned off.

1 Unscrew the four hex screws (3 mm) on the
rear of the unit, and remove the battery plate.

Removing an AXS Memory Card

Battery

Open the memory slot cover of the AXS-R7, and
pull out the AXS memory card.

[Note]

Data integrity is not guaranteed if the power is turned off or
an AXS memory card is removed while it is being accessed.
Data on the card may be destroyed. Be sure that its ACCESS
lamp is lit in green or off when you turn off the power or
remove a memory card.

To remove the AXS-R7

Unscrew the four hex screws, and remove the

AXS-R7.
2 3 Close the cover.
Unscrew the four hex screws on the rear of the

AXS-R7, and remove the docking module from
the AXS-R7.
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2. Preparation: Using with AXS-R7

Recording to an AXS Memory Card

You can select the format for recording to an AXS
memory card using Project category > AXS Rec
Format (page 40) in the menu.

[Note]

The AXS memory card in the AXS-R7 does not switch to
the second card automatically, even if the card becomes
full while recording. To switch cards, use the SLOT SELECT
button on the AXS-R7 during recording standby mode.

Formatting (Initializing) an AXS
Memory Card

AXS memory cards must be formatted the first
time they are used in the AXS-R7 attached to the
unit.

Use the format function of the unit to format
AXS memory cards for use in the AXS-R7. It is
also necessary to format an AXS memory card if
a caution message is displayed when the unit is
turned on with the AXS recorder attached.

If an AXS memory card that was formatted in a
format not supported by the AXS-R7 is loaded, a
file system mismatch message is displayed.

1 Select TC/Media category > Format Media in
the menu, then press the MENU dial.

2 Select AXS Slot A (slot A) or AXS Slot B (slot B).
A confirmation screen prompting whether to
format the card appears.

3 Press and hold ITEM key 1 and ITEM key 3 for 3
seconds to execute formatting.
Formatting starts, a message is displayed
during execution, and the ACCESS lamp lights
in red.

When formatting ends, a completion message
appears. Press the MENU dial to dismiss the
message.

[Note]

All data is erased when a memory card is formatted, and the
data cannot be restored.

Checking the Remaining Recording
Time

While shooting (recording or standby), you

can check the remaining capacity on a loaded

AXS memory card using the recording media
remaining capacity indicator on the Home screen
of the sub display (page 29) or the viewfinder
screen (page 12).

The available time for recording with the current
video format (recording bit rate) is calculated
according to the remaining space of each card and
displayed in time units of minutes.

[Note]
A (yicon appears if an AXS memory card is write-protected.

Restoring an AXS Memory Card

If for any reason an error should occur in a memory
card, the card must be restored before use.

If an AXS memory card that needs to be restored
is loaded, a message prompting you to execute
restoration is displayed.

To start the restore process, select Execute by
turning the MENU dial, then press the MENU dial.
The restoration starts.

During execution, a message is displayed and the
ACCESS lamp lights in red.

When restoration ends, a completion message
appears. Press the MENU dial to dismiss the
message.

If restoration fails

® A write-protected AXS memory card or one on
which an error occurred cannot be restored. For
such a card, a warning message is displayed.
Release the write protection or replace the card,
according to the instructions in the message.

® An AXS memory card on which an error
occurred may become usable again when
reformatted.

® |n some cases, some clips can be restored while
others cannot. Playback of the restored clips
becomes possible again.

[Note]

For restoration of media recorded with this unit, be sure to
use this unit.

Media recorded with a device other than this unit or with
another unit of different version (even of the same model)
may not be restored using this unit.

Updating the management file

If clips cannot be played back, updating the
management file on the card may improve the
situation.

Use TC/Media > Update Media (page 52) in the
full menu to update the management file.

Updating the AXS-R7 Firmware
Version

You can update the version of the AXS-R7
firmware with the AXS-R7 attached to the unit.

[Notes]

e The firmware version of the unit must be 2.0 or later in
order to perform this operation.

® Set AXS Rec Format (page 40) to Rec Off before
performing this operation.

] Prepare a USB flash drive updater according to
the update procedure for the AXS-R7.

2 Insert the USB flash drive updater in the
external device connector (page 11).

3 Execute the AXS-R7 update function using

Maintenance > Firmware > FW Update-AXS-R7
(page 58) in the menu.
The version update process takes about 15
minutes. When the version update process
finishes, the unit automatically restarts and
“Firmware Upgrade Done” is displayed.
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Sub Display

The sub display displays the Home screen, clip list screen, playback screen, menu screen, full menu screen, and user functions screen.
You can switch between the screens on the sub display using the buttons on the Assistant side of the unit.

User functions screen

User 1 User 2 [VE
SDI Frame Line Monitor Monitor
Status Info LUT bypass

On On Off

T2.8 T¢G 00:00:00:00
Auto

Monitor
Highlight Clip Ind
User 4

Fan Mode

User 5

HOME button

USER button

Home screen
FPS =] 2500]
Fixed—24 2500
7¢600:00:00:00 2398

DCIN 15.0V A001

MENU button

Isxs 120 min  XAVC QFHD C480 EH
SxS B 180min

1.8

ND

Shutter

180.0 HOME button

USER button

CLIPS button

Clip list screen

A001C001_180101CQ &

16:9
C004

12

3200+03

WB

CLIPS button

HOME button

MENU button

A001C002_180101G7 &
A001C003_180101HR &
A001C004_180101WK &
A001C005_180101S8 &
A001C006_180101GF &

3

Playback screen

bur 00:00:00:00 23.98fps

»» x24 DCIN 15.0V 60FPS
SXsS & 002/010 XAVC QFHD C480
A001C002_160328WW &

<« 24!

MENU button

CLIPS button

[ )
Menu screen Full menu screen
Imager Mode & Project Shutter
Project Frame Rate T TC/Media ND
Color Space S-Gamut3 3 Monitoring Exposure Index
AXS Rec Format D Audio White Balance
SxS Rec Format @ Technical LUT Select
Sub Rec Format £ Maintenance Look
Audio Info & Project Detail
\ S

USER button
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Home Screen

Press the HOME button on the Assistant side to display the
unit and set basic settings for the unit on the Home screen

Home screen. You can check the status of the

r FPS El Shutter
Fixed-24 = 2500 @ 180.0
17c600:00:00:00 23.98fps  3.8K 16:9

gi{?gf@% . DC IN 15.0V A001 C004 :

Function I SxS B 120 min  XAVC QFHD C480 dli;l)L\Jal/area

display area SxS E¥ 180 min

1 8 SDI 3/4: Look 3200+03
ND SxS: Log WB
Item name/Setting value/Function display area 1. FPS A

Displays and sets the video frame rate.

ITEM key 1 ITEM key 2 ITEM key 3 2. Exposure Index

Q Q Q Displays and sets the exposure index (El) (top
icon displays the base ISO sensitivity).
1 2 3
3. Shutter

Displays and sets the shutter speed/shutter
angle of the electronic shutter.

1¢G00:00:00:00 23.98fps 3.8K 16:9 4. ND Filter

DCIN 15.0V AOOY C004 Displays and sets the ND filter position.
I1SxS [ 120 min  XAVC QFHD C480
SxS B 180min 5. LUT
Displays and sets the monitor LUT.
6. WB (White Balance)

4 5 6
ITEM key 4 ITEM key 5 ITEM key 6

[Note]

The areas labeled 1 to 6 correspond to ITEM keys 1to 6
(page 36). Press an ITEM key to select the corresponding
item. The ITEM keys for functions displayed in orange text
color are enabled.

Displays and sets the white balance.

Status display area

1. Time data display
Displays the duration or timecode, depending
on the TC/Media category > TC Display setting
in the menu (page 40).
Displays the type of data currently shown in
the time data display, as follows.
TCG: Recorded timecode
TCR: Playback timecode
DUR: Duration

2. Frame rate indicator
Displays the value of the Project category >
Project Frame Rate setting in the menu
(page 40).

3. Imager mode indicator
Displays the Project category > Imager Mode
setting in the menu, and de-squeeze
information.

4. Clip name display

Displays “Reel: Camera ID + Reel Number” and
“ShotNumber”.

5. Audio level meters
Displays the audio recording or playback
levels. The numbers 1 and 2 Indicate channels
1 and 2.

6. Simultaneous recording indicator

When 1-slot simultaneous recording is
configured for the displayed media, a “Sub”
icon appears on the right of the displayed
main recording format.

2

3

Recording format (codec) indicator

Displays the format of the recording on an AXS
memory card or an SxS memory card

(page 43).

Power supply voltage/Remaining battery
capacity indicator

Displays the power supply voltage or
remaining battery capacity.

Remaining media capacity indicator

Displays the active media icon, media type, slot
type (A/B), and remaining recording time
(when recording in the current recording
format).

It also displays the clip name during playback.

. Recording status indicator

Displays the following recording operation
states of the unit.

Display Description
Stby Recording standby
@Rec Recording

. Thermometer icon

Displayed when a high temperature warning
message is issued.

The description is displayed in the Info
category in the menu.
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12.

13.

Warning icon

Displayed when other than a high
temperature warning message is issued.
The description is displayed in the Info
category in the menu.

Ext-LK icon

Displayed when the internal timecode
generator is locked to an external signal input
to the TC IN (timecode input) connector.
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Operations on the Home Screen of the Sub Display

Basic Operation

1 Press the HOME button.
The Home screen appears.

FPS [=2l2500)

Fixed-24 = 2500

Shutter

180.0

7cG00:00:00:00 23.98fps 4K 4:32xSV ==

DCIN 15.0V Reel A001 Shot C004 ==

I SxS B 120 min  XAVC QFHD C480
SxS Bl 180min 12

1.8 SDI 3/4: Look 3200+03
ND

SxS: Log WB

2 Select the item to set using the ITEM keys 1 to
6.
The setting value for items that can be
changed are displayed in orange.
The following diagram shows an example
when [TEM key 3 is pressed.

Step / Cont. t*
172.8

[ 144.0 |
e 900

45.0
22.5
Step Edit $

Current:

2A144.0 Use buttons or

(1/59.95)

dial to select.

3 Move the cursor to the item or setting value to
select using the B button (ITEM key 2), &
button (ITEM key 5), or MENU dial.

4 Press the MENU dial or Set button (ITEM key 3)
to apply the setting.

Changing the brightness of the sub display

You can change the brightness of the sub display
using Technical > Control Display > Brightness
level (page 57) in the full menu.

On the Home screen, you can also press and hold
the BACK button and turn the MENU dial clockwise
to change the brightness of the sub display in the
sequence Minimum — Low — Mid — High with
the current setting as the base point.

You can also press and hold the BACK button and
turn the MENU dial counterclockwise to change
the brightness of the sub display in the sequence
High — Mid — Low — Minimum with the
current setting as the base point.

[Note]

The display brightness setting is common to both the sub

display and the mini display, and is reflected on both displays
simultaneously.

Step Edit Operation

You can change the settings available for selection
when “Step Edit” is displayed for [TEM key 4 in step
2 in the basic operation. You can add and delete
settings on the settings edit screen.

1 On the settings selection screen, move the
cursor to the setting you want to change or
delete, and press the Step Edit button (ITEM
key 4).

The settings edit screen appears.

+

Step Edit

-~
Use buttons or

90.0

4

dial to select.

Add Delete Cancel

2 To delete a setting, press the Delete button (ITEM

key 4).

[Note]
The selected setting can be deleted if the “Delete”
character string is displayed in orange.

3 Usethe X button (ITEM key 2), § button
(ITEM key 5), or MENU dial to change a setting.

4 When finished, press the Add button (ITEM key

4).

The setting is added and the display returns to
the setting selection screen.

[Note]

A setting can be added if the "Add" character string is
displayed in orange.

When setting White Balance

On the White Balance settings edit screen, you
can press the Coarse/Fine button (ITEM key 1) to
change the 1-step increment variation to coarse
or fine. You can also press the Temp/Tint button
(ITEM key 3) to switch the value between color
temperature (Temp) and color tone (Tint).

Coarse / Fine + Temp / Tint

Step Edit 2+ Use buttons
or dial to

(User WB) 3200K +03

select temp.

Coarse=100K
Fine=1K

Base: m
A 4
3200 K + 03

Add Delete Cancel
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FPS Operation

Press ITEM key 1 on the Home screen to display
the FPS operation screen. You can press the
Variable/Fixed button (ITEM key 4) to switch
between “Fixed” for constant speed shooting and
“Variable (Select FPS)” for variable speed shooting.

Current:

FPS 26 Use buttons or

dial to select.

Project:
23.98fps

Variable/ Fixed Cancel

[Note]
Audio is not recorded in “Select FPS” mode.

AWB Operation

Press ITEM key 6 on the Home screen to display
the white balance operation screen. Press the Auto
White Bal. button (ITEM key 1) to execute white
balance. After execution, press the Add button
(ITEM key 4) to add the setting to a step. You can
also press the Temp/Tint button (ITEM key 3) to
switch the value between color temperature
(Temp) and color tone (Tint) to make fine
adjustments to the value before adding a value to
a step.

Auto White Bal. *

3200 +°
e 3200 *%2

Use buttons or

Current:
3200 K
+03 4300 +0°

dial to select.

(User WB) 5500 +00

Step Edit Cancel

[Note]
During AWB operation, shoot a white chart under
uniform lighting conditions.

LUT Operation

Settinga LUT

You can set a LUT for each output system using
ITEM key 5 on the Home screen.

1 Press ITEM key 5 on the Home screen.
The LUT selection screen appears.

Page/ 2
Outputs Log

SDI 1/2 SDI 3/4

Look Info  s709

. LOOk /1
HDMI

Edit Look Monitor

The LUT selection screen has two pages, and
you can switch the page by pressing ITEM key
1.

On page 1, you can set the LUT settings for SDI
1/2 (display only), SDI 3/4, Monitor, and HDMI.
On page 2, you can set the LUT settings for the
viewfinder, SxS Rec, and Sub Rec.

2 Select the output to set using ITEM keys 2, 3, 5,
and 6.
The settings edit screen appears.

3 Use the B button (TEM key 2), 8 button
(ITEM key 5), or MENU dial to change a setting.

4 Press the MENU dial or Set button (ITEM key 3)
to apply the setting.

Changing Preset Look

You can set a LUT when Look is selected on the
LUT selection screen using the Edit Look button
(ITEM key 4) on page 1 or page 2.

1 Press the Edit Look button (ITEM key 4) on the
LUT selection screen.
The Look selection screen appears.

S 5 Select

Preset look

Category

Preset Look

Load File
2 Press the Select button (ITEM key 3).

The items that can be selected are displayed.

3 Usethe X button (ITEM key 2), $ button
(ITEM key 5), or MENU dial to change a setting.

4 Press the MENU dial or Set button (ITEM key 3)
to apply the setting.

Changing the LUT category

You can change the target category for LUT
operations to User 3D LUT or Preset Look.

1 Press the Edit Look button (ITEM key 4) on the
LUT selection screen.
The Look selection screen appears.

7 Usethe X button (ITEM key 2), § button
(ITEM key 5), or MENU dial to enable category
selection.

3 Press the MENU dial or the Select button (ITEM
key 3).

4 Use the 1 button (ITEM key 2), & button
(ITEM key 5), or MENU dial to select a category
(User 3D LUT or Preset Look).

5 Press the MENU dial or Set button (ITEM key 3)
to apply the setting.
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Loading a User 3D LUT file

You can load a User 3D LUT file stored on an SD
card into the unit.
[Note]
Save the User 3D LUT file in the following directory on the SD
card (page 69).
PRIVATE\SONY\PRO\LUT\
1 Insert the SD card into the SD card slot
(page 11).

2 Press the Edit Look button (ITEM key 4) on the
LUT selection screen.
The Look selection screen appears.

3 Press the Load File button (ITEM key 3).

e . Select
User 3D LUT
s709.cube

Category

User 3D LUT

Load File

4 Press the MENU dial or the Select button (ITEM
key 3).
The load destination numbers (01 to 16) are
displayed.
A file name is displayed for loaded numbers.

* Select
01: sLog2 to Linear.cube
02: LMT ACES v0.1.1.cube
03: Lightlllusion_LP.cube
04: Binary_Through_17.13D
05: Test0312_EI+0.6/Cube

Load 3D LUT

»m Stepl:
Select
Destination

¥ Back

5 Use the B button (ITEM key 2), & button
(ITEM key 5), or MENU dial to select a load
destination number.

6 Press the MENU dial or the Select button (ITEM

key 3).

The file name of the User 3D LUT file stored on

the SD card is displayed.

* Load
3535-Big v3.cube
Rec709 to DCI-XYZ.cube
Raw Viewer_LP2.cube
Test0312_EI+0.6.cube
ACES_RRT709_V1--_f5_V7.13

Load 3D LUT

Ol Step2:

Select File to
Load on 03

@ Back

/' Use the T button (TEM key 2), & button
(ITEM key 5), or MENU dial to select a file.

8 Press the MENU dial or the Load button (ITEM
key 3).
When the file is loaded successfully,
“Successfully loaded” is displayed.

9 Press the OK button (ITEM key 6).

Changing the User 3D LUT File

You can change the currently selected User 3D
LUT file.

1 Press the Edit Look button (ITEM key 4) on the
LUT selection screen.
The Look selection screen appears.

* Select
User 3D LUT
s709.cube

Category

User 3D LUT

Load File

2 Press the MENU dial or the Select button (ITEM
key 3).

3 Use the B button (ITEM key 2), & button
(ITEM key 5), or MENU dial to change the User
3D LUT file.

* Set

01: s709.cube

User 3D LUT  g5. | MT ACES v0.1.1.cube
s709 03: Lightlllusion_LP.cube

04: Binary_Through_17.13D

05: Test0312_EI+0.6/Cube

$ Cancel

4 Press the MENU dial or Set button (ITEM key 3)
to apply the setting.
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Home Screen [tems on the Sub Display

The names of items and corresponding setting values are given below.
Default values are shown underlined and in bold text.

Iltem

Description

Item

Description

FPS

Sets the shooting frame rate.

Variable/Fixed: Switch between variable speed and constant speed shooting.
When “Fixed" is selected, the setting is determined by the Project category >

Project Frame Rate (page 40) setting in the menu.

Exposure Index

Sets the El value. The setting changes as follows depending on the Project > Basic

Setting > Base ISO (page 50) setting in the full menu.

1SO 500:
125El/160EI/200El/250E1/320E1/400EI/500El/640EI/800EI/1000EI/1250El/
1600EI/2000E!

ISO 2500:
640EI/800EI/1000EI/1250El/1600EI/2000El/2500E1/3200EI/4000El/5000El/
6400EI/8000EI/10000EI

Project Frame Rate Display

23.98 Fixed-24
24 Fixed-24
25 Fixed-25
29.97 Fixed-30
50 Fixed-50
59.94 Fixed-60

When “Variable" is selected, the setting changes as follows depending on the
Project category > Imager Mode (page 50) setting in the menu.

Shutter

Sets the electronic shutter angle/shutter speed.
Press the Step/Cont. button (ITEM key 1) to switch between step and continuous
selection methods.
Step: Select from up to 16 preset values registered as shutter steps. You can press
the Step Edit button (ITEM key 4) to change any setting from the preset value
after selection.
Displays the following selection options depending on the Technical >
System Configuration > Shutter Mode (page 56) setting in the full menu.

Angle: Shutter angle indicator

Default selection options
360/180/172.8/144/90/45/22.5/11.2/5.6

Speed: Shutter speed indicator

Default selection options
1/24,1/25,1/30, 1/50, 1/60, 1/100, 1/120, 1/250, 1/500, 1/1000, 1/2000"

[Note]

The default speed values for different Project Frame Rate (page 40) settings are
given below.

23.98/24:1/24,25:1/25,29.97:1/30, 50: 1/50, 59.94: 1/60

Cont.: Select an angle/speed within the supported range.

ND Filter

Sets the ND filter position. The following settings are available.
Clear/0.3/0.6/0.9/1.2/1.5/1.8/2.1/2.4

Imager Mode Setting
3.8K16:9 1to 60 FPS
4K17:9

3.8K 16:9 Surround View 1t0 48 FPS
4K 17:9 Surround View

4K 4:3

4K 4:3 Anamorphic Surround 1to 30 FPS
4K 6:5

6K 17:9

6K 1.85:1

6K 3:2 1to 25 FPS
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ltem Description
LUT Configures settings related to the LUT to apply to the output video.
Page 1

SDI 1/2 (ITEM key 2): Log
Display only, as LUT cannot be applied to the SDI 1/2 output image.

SDI'3/4 (ITEM key 3): Log/Look
Selects the LUT to apply to the SDI 3/4 output image.
Disabled when Monitoring category > Output Format > SDI 1/2 is set to 4K/
QFHD in the menu.

Monitor (ITEM key 5): Log/s709/R709(800%)
Selection becomes Log/Look when Monitoring category > Output Format >
SDI 1/2 is set to 4K/QFHD in the menu.

HDMI (ITEM key 6): Log/s709/R709(800%)
Fixed to Log when Monitoring category > Output Format > SDI 1/2 is set to
4K/QFHD and HDMI is set to 4K/QFHD in the menu. In all other cases, the
options are the same as for Monitor.

Page 2

Viewfinder (ITEM key 2): Log/s709/R709(800%)
Selects the LUT to apply to the viewfinder output image.

SxS Rec (ITEM key 5): Log/Look
Disabled when Project category > SxS Rec Format is set to Rec Off in the
menu, or fixed to Log when set to XAVC.

Sub Rec (ITEM key 6): Log/Look
Disabled when Project category > SxS Rec Format is set to Rec Off in the
menu.

Page 1/2 common items

Edit Look: Sets a LUT to apply as a Look.
s709 / R709(800%) / S-Gamut3.Cine/SLog3 / S-Gamut3/SLog3 / User 3D LUT

WB (White Balance) Sets the color temperature/color tone of the white balance.
Default selection options
3200K+00/4300K+00/5500K+00
You can press the Step Edit button (ITEM key 4) to change the white balance
preset value and Tint value.
Auto White Bal.: Execute auto white balance.

V" The options are 1/60 and subsequent values when the project frame rate is 59.94, 1/50 and subsequent values when 50.0,
1/30 and subsequent values when 29.97, and 1/25 and subsequent values when 25.0.
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User Functions Screen

You can press the USER button (page 9) to
display the user functions screen on the sub
display and use the ITEM keys 1 to 5 as assignable
buttons (User 1 to 5).

There are also four assignable buttons (pages

7,8, 9) to which you can assign various

functions.

Functions can be assigned to these buttons using
the user functions screen, in addition to using
Project > Assignable Button in the full menu.

ITEM key 1 [TEM key 2 ITEM key 3
User 1 User 2 User 3
SDI Frame Line Monitor Monitor
Status Info LUT bypass
On On Off
7¢600:00:00:00
Off Auto
Monitor Fan Mode
Highlight Clip Ind
User 4 User 5
ITEM key 4 ITEM key 5 ITEM key 6

[Note]

When a lens that supports the iris setting display function is
attached, the iris position is displayed in the center left of the
user functions screen.

Changing Button Functions

The user functions selection screen is displayed by
pressing the Edit button (ITEM key 6) on the user
functions screen. You can set the functions for the
User 1 to 5 buttons and assignable buttons 1 to 4
on the user functions selection screen.

Select

SDI Frame Line
User 2
User 3
User 4
User 5
Assign Btn 1

Monitor Status Info

Monitor LUT bypass

Monitor Highlight Clip Ind
Fan Mode
VF Highlight Clip Ind
¥ Done

1 On the user functions selection screen, move
the cursor to the button you want to change,
and press the Select button (ITEM key 3).

The functions that can be selected are
displayed.

*
Not Assigned
SDI Frame Line
SDI Status Info

<User 1>
SDI Frame Line

SDI LUT bypass

Monitor Frame Line

Monitor Status Info

$ Cancel

2 Use the B button (TEM key 2), & button
(ITEM key 5), or MENU dial to change a setting.

3 When finished, press the Set button (ITEM key
3).
The display returns to the user functions
screen, and displays the changed function.

The following tables lists the functions that are assigned when the unit is shipped from the factory.

Button Function Assignable Button setting

Assignable 1 Displays clipped highlight areas in red in the VF Highlight Clip Ind
viewfinder.

Assignable 2 No assignment Not Assigned

Assignable 3 No assignment Not Assigned

Assignable 4 No assignment Not Assigned

[TEM key 1 No assignment Not Assigned

ITEM key 2 No assignment Not Assigned

[TEM key 3 No assignment Not Assigned

ITEM key 4 Displays clipped highlight areas in red on the Monitor Highlight Clip Ind
Monitor output.

ITEM key 5 Sets the fan control mode. Fan Mode

Functions that can be Assigned to ITEM Keys 110 5

Assignable Button
setting

Function

State when unit is
powered on

Not Assigned

No assignment

SDI Frame Line

Turns superimposition of frame lines on the SDI
3/4 output image on/off.

Setting retained

SDI Status Info

Turns display of information on the SDI 3/4 output
image on/off.

Setting retained

Press & Hold for SDI Log

Disables the LUT applied to the SDI 3/4 output
image while the key is pressed, and sets Log
image quality without applying a LUT.

Setting not retained

Monitor Frame Line

Turns superimposition of frame lines on the
Monitor output image on/off.

Setting retained

Monitor Status Info

Turns display of information on the Monitor
output image on/off.

Setting retained

Press & Hold for Monitor

Log

Disables the LUT applied to the Monitor output
image while the key is pressed, and sets Log
image quality without applying a LUT.

Setting not retained

Monitor Highlight Clip Ind

Turns the function that displays clipped highlight
areas in red on the Monitor output image on/off.

Setting retained

Color Bars

Turns color bars on/off.

Setting retained

AXS Slot Change

Switches the active slot when two AXS memory
cards are inserted.

Switches between A and B each time the key is
pressed.

Setting retained
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Assignable Button
setting

Function

State when unit is
powered on

Functions that can be Assigned to Assignable Buttons 1to 4

Assignable Button setting

Function

State when unit is
powered on

SxS Slot Change Switches the active slot when two SxS memory Setting retained
cards are inserted.
Switches between A and B each time the key is
pressed.

Fan Mode Sets the fan control mode. Setting retained

Switches between Auto — Max — Off in Rec/
Auto — Off in Rec/Max each time the key is
pressed.

Not Assigned

No assignment

SDI Frame Line

Turns superimposition of frame lines on the
SDI 3/4 output image on/off.

Setting retained

Format Media AXS Slot A

Formats media in AXS slot A.

SDI Status Info

Turns display of information on the SDI 3/4
output image on/off.

Setting retained

Format Media AXS Slot B

Formats media in AXS slot B.

Format Media SxS Slot A

Formats media in SxS slot A.

Format Media SxS Slot B

Formats media in SxS slot B.

Press & Hold for SDI Log

Disables the LUT applied to the SDI 3/4 output
image while the key is pressed, and sets Log
image quality without applying a LUT.

Setting not retained

APR

Executes APR.

Lens Interface

Selects the lens interface.
Switches between Off — Type C each time the
key is pressed.

Setting retained

Monitor Frame Line

Turns superimposition of frame lines on the
Monitor output image on/off.

Setting retained

Monitor Status Info

Turns display of information on the Monitor
output image on/off.

Setting retained

VF Highlight Clip Ind

Turns the function to display clipped highlight
areas in red in the viewfinder on/off.

Setting retained

Auto White Balance

Executes auto white balance.

Press & Hold for Monitor Log

Disables the LUT applied to the Monitor
output image while the button is pressed, and
sets Log image quality without applying a LUT.

Setting not retained

Iris Open (1/16 stop)

Opens the lens iris.

Press and hold to open the iris until fully open.
This function is available when an E mount lens
with power iris is attached.

The setting is in 1/16 stop increments, whereas
the iris indication is in units of 1/3 stop
increments.

Monitor Highlight Clip Ind

Turns the function that displays clipped
highlight areas in red on the Monitor output
image on/off.

Setting retained

Iris Close (1/16 stop)

Closes the lens iris.

Press and hold to close the iris until fully closed.

This function is available when an E mount lens
with power iris is attached.

The setting is in 1/16 stop increments, whereas
the iris indication is in units of 1/3 stop
increments.

Monitor High/Low Key

Selects the Monitor output mode.

Switches between High Key (screen for
checking for blown-out highlights) — Low
Key (screen for checking for blocked-out
shadows) — Off (normal display) each time
the button is pressed.

Setting not retained

Color Bars

Turns color bars on/off.

Setting retained

AXS Slot Change

Switches the active slot when two AXS
memory cards are inserted.

Switches between A and B each time the
button is pressed.

SxS Slot Change

Switches the active slot when two SxS
memory cards are inserted.

Switches between A and B each time the
button is pressed.

Rec Review

Executes the Rec Review function.

Setting not retained

VF Frame Line

Turns superimposition of frame lines on the
viewfinder output image on/off.

Setting retained

VF Zebra

Turns the zebra function of the viewfinder
output image on/off.

Setting retained
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Assignable Button setting Function State when unit is
powered on
VF Status Info Turns the information display on the Setting retained
viewfinder output image on/off.
VF Focus Magnifier Turns the focus magnifier function of the Setting not retained
viewfinder on/off.
Press & Hold for VF Log Disables the LUT applied to the viewfinder Setting not retained

output image while the button is pressed, and
sets Log image quality without applying a LUT.

VF Highlight Clip Ind Turns the function to display clipped highlight = Setting retained
areas in red in the viewfinder on/off.

VF High/Low Key Selects the viewfinder output mode. Setting not retained
Switches between High Key (screen for
checking for blown-out highlights) — Low
Key (screen for checking for blocked-out
shadows) — Off (normal display) each time
the button is pressed.

Auto White Balance Executes auto white balance. Stops execution -
if pressed during auto white balance.
Iris Open (1/16 stop) Opens the lens iris. -

Press and hold to open the iris until fully open.
This function is available when an E mount
lens with power iris is attached.

The setting is in 1/16 stop increments, whereas
the iris indication is in units of 1/3 stop
increments.

Iris Close (1/16 stop) Closes the lens iris. -
Press and hold to close the iris until fully
closed.
This function is available when an E mount
lens with power iris is attached.
The setting is in 1/16 stop increments, whereas
the iris indication is in units of 1/3 stop
increments.
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Menu Operations

By pressing the MENU button while shooting

(during recording or recording standby) or during

playback, you can display and operate the menu

screen on the sub display.

® Project category: Basic settings and recording
format settings

® TC/Media category: Timecode value and TC
format settings

® Monitoring category: SDI/HDMI/Monitor
external signal output format, OSD, and marker
overlay status settings

® Audio category: Audio source and audio level
settings

¢ |nfo category: Camera, media, and battery status
information

Controls

MENU button (page 8)
Press to display the menu on the sub display.

ITEM keys 110 6 (page 8)
Selects the category of the menu.

SEL/SET dial (MENU dial) (page 8)

Turn to move the cursor in the corresponding
direction to select setting items or setting values.
Press the MENU dial to apply the selected item.

BACK button (page 9)
Press to return to the previous menu. Unconfirmed
changes are canceled.

Basic Operation

1 Press the MENU button.
The menu screen appears.

2 Select the category to set using ITEM keys 1 to
6.

3 Turn the MENU dial to move the cursor to the
setting item to select.
For each setting item, the setting value is
displayed.

‘Menu Item List” (page 40)

Project TC/Media Monitoring
4K 17:9
23.98
S-Gamut3.Cine/SLog3
Rec Off
XAVC 4K Class300
Rec Off

ﬁ Project Details

Imager Mode
Project Frame Rate
Input Color Space
AXS Rec Format
SxS Rec Format
Sub Rec Format
Audio

4 Press the MENU dial.
The setting value selection screen appears
next to the selected item.

TC/Media Monitoring

4K 4:3

4K 17:9
3.8K 16:9
Rec Off
XAVC 4K Class300
Rec Off
ﬁProject Details

Project
Imager Mode
Project Frame Rate

Input Color Space

AXS Rec Format
SxS Rec Format

Sub Rec Format
Audio

5 Turn the MENU dial to move the cursor to the
setting value.

6 Press the MENU dial to apply the setting.
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Menu ltem List

The items available in each category are given below.

Project category

Default values are shown underlined and in bold text.

ltem Settings Description
Imager Mode 6K 3:2/6K 1.85:1/6K 17:9/ Sets the effective picture size.
4K 6:5/4K 4:3/

4K 4:3 Surround View/
4K 17:9/

4K 17:9 Surround View/
3.8K16:9/

3.8K 16:9 Surround View

[Notes]

® (6K 3:2/6K 1.85:1/6K 17:9 are displayed only when a
Full Frame license is installed.

® 4K 6:5/4K 4:3/4K 4:3 Surround View are displayed
only when an Anamorphic license is installed.

Project Frame Rate

23.98/24/25/29.97/50/59.94

Sets the project frame rate.

Input Color Space

S-Gamut3.Cine/SLog3 /
S-Gamut3/SLog3

Sets the color space.

AXS Rec Format "
(Only when an AXS-R7 is
attached)

Rec Off/RAW SQ/
X-OCN ST/X-OCN LT

Sets the recording format for AXS memory cards
when an AXS-R7 is connected.

T(/Media category
Default values are shown underlined and in bold text.
Item Settings Description
TC Mode Preset F-Run (Ext-Lk)/ Sets the timecode mode.
Preset R-Run/ Preset F-Run (Ext-Lk): Timecode
Int Regen advances continuously from specified
value, regardless of whether recording or
not.
Preset R-Run: Timecode advances from
specified value only when recording.
Int Regen: Timecode continues from that
of the previous clip.
TC Display Timecode/Duration Switches the time data indication.
TC Setting Setting Sets the timecode to a desired value.

(set when switching  (H,M, S, F)

to another screen) Reset

Resets the timecode to 00:00:00:00.

TC Format

DF/NDF

Sets the timecode format.
DF: Drop frame
NDF: Non drop frame

TC Source

Internal/External

Display only.

SxS Rec Format "

Rec Off/XAVC 4K Class480/
XAVC 4K Class300/

XAVC QFHD Class480/
XAVC QFHD Class300/
MPEG HD P/MPEG HD i/
ProRes 422 HQ HD P/
ProRes 422 HQ HD i/
ProRes 422 HD P/

ProRes 422 HD i/

Sets the main recording format for SxS memory
cards.

CamID

AtoZ

Sets the camera ID used when
generating clip names.

Clip name: Camera ID + Reel Number +
Shot Number + date + random string

Reel#

001 to 999

Sets the numeric portion of the Reel
Number used when generating clip
names.

Clip name: Camera ID + Reel Number +
Shot Number + date + random string

ProRes Proxy HD P/
ProRes Proxy HD i
Sub Rec Format " Rec Off/ Sets the sub recording format for SxS memory
MPEG HD P/ cards.
MPEGHD i

Camera Position

C/L/R

Sets the first character portion of the
Shot Number used when generating clip
names.

Clip name: Camera ID + Reel Number +
Shot Number + date + random string

Project Details
(ITEM key 6)

Displays the contents of the Project menu
(page 50) in the full menu.

U The recording formats available vary depending on the combination of the effective picture size and project frame rate
settings. For details about settings, see “Recording Format Settings” (page 43).

Format Media AXS Slot A

Formats the AXS memory card in slot A.

(executed when AXS Slot B

Formats the AXS memory card in slot B.

switching to another g c gjo A

Formats the SxS memory card in slot A.

screen)

SxS Slot B Formats the SxS memory card in slot B.
SD Card Formats the SD card.
Media Details Displays the contents of the TC/Media
(ITEM key 6) menu (page 51) in the full menu.
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Monitoring category

Default values are shown underlined and in bold text.

[Notes]
® The unit supports independent configuration of Info and Frame Line for each system. The display information for the A and

Iltem Settings Description
Moni. Details Displays the contents of the Monitoring
(ITEM key 6) menu (page 52) in the full menu.

" For details about formats available for selection, see “SDI OUT Connector Output Formats” (page 76).
2 For details about formats available for selection, see “MONITOR OUT Connector/HDMI OUT Connector Output Formats”

B output images is configured using the Monitoring menu (page 52).

setting cannot be changed.

e |nfo and Frame Line may not be displayed depending on the Output Format setting. In this case, “~" is displayed and the

Item

Settings

Description

(page 79).

VF Info A/B/Off Selects the information to display Audio (ategory
- superimposed on Fhe wevvfmder IMage. Default values are shown underlined and in bold text.
Frame Line  A/B/Off Selects the frame lines to display
superimposed on the viewfinder image. Item Settings Description
SDI'1/2 Output The available settings vary Selects the SDI 1/2 output format.” Source Switch LINE / AES/EBU / MIC Displays the position of the AUDIO IN switch
Format according to the imager (page 8) that sets the CH1 and CH2 input
mode, project frame rate, and source.
x5 recording format settings. CH-1 Audio Level Auto/Manual The audio recording level is adjusted
Info - Information display is not superimposed -99 to +0 to +99 automatically when set to Auto.
on the SDI'1/2 output. The audio recording level is adjusted manually
Frame Line  A/B/Off Selects the frame lines to display when set to Manual.
superimposed on the SDI 1/2 output. CH-2 Audio Level Auto/Manual The audio recording level is adjusted
[Note] -99to £0 to +99 automatically when set to Auto.
Frame lines are only superimposed if the The audio recording level is adjusted manually
output format is 4K/QFHD. when set to Manual.
SDI3/4 Output The available settings vary Selects the SDI 3/4 output format. " MIC Reference -60dB/-50dB/-40dB Selects the reference input level of the
Note] Format depending on the SDI 1/2 microphone.
Depending on the setting. Monitor CH When Monitor Output CH Pair  Selects the audio channel that is output to the
Output Format setting  Info A/B/Off Selects the information to display is set to CH-1/CH-2 headphones and speaker.
of SDI'1/2, the Output superimposed on the SDI 3/4 output. CH-1/CH-2, CH-1,CH-2
E%rssagétlizgé erasrrleT Frame Line  A/B/Off Selects the frame lines to display When Monitor Output CH Pair
3/4 may be blank and superimposed on the SDI 3/4 output. is set to CH-3/CH-4
cannot be changed. CH-3/CH-4,CH-3,CH-4
Monitor Output The available settings vary Selects the Monitor output format.? Monitor Level 0t099 Adjusts the monitor audio level.
Format depending on the SDI 1/2 CH1 Level Meter - Displays the CH1 level meter.
setting. CH2 Level Meter - Displays the CH2 level meter.
Info A/B/Off Selects the information to display CH3 Level Meter - Displays the CH3 level meter.
superimposed on the Monitor output. CH4 Level Meter - Displays the CH4 level meter.
Frame Line  A/B/Off Selects the frame lines to display Audio Details Displays the contents of the Audio menu
superimposed on the Monitor output. (ITEM key 6) (page 55) in the full menu.
HDMI Output The available settings vary Selects the HDMI output format.?
Format depending on the SDI 1/2

setting.
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No. Page

Description

Checking the Status using the Info Category

6 Lens

You can check the status of media and the battery, and check the contents of warnings and errors that
are issued using the Info category. The contents of the display update in realtime as the status of the unit
changes.

The Info category consists of the following six information pages. Turn the MENU dial to switch the page.

Displays the following information for the lens attached to the
unit.
® [ ens model name
® Tvalue of iris
[Note]
The F-stop value is displayed instead of the T-stop value if the T-stop
value cannot be obtained.
® Focal length
® Focus distance
Depth of field
® Serial number

No. Page Description

1 Camera Condition Displays warning messages and error messages. When there are
no messages, “All Systems are OK" is displayed at the top of the
display area.

2 Firmware Displays the firmware version of the unit, the serial number and

firmware version of the AXS-R7 attached to the unit, and the
name and validity of option software licenses on the unit. If an
option is not added or currently valid, “Not Installed” or “Expired”
is displayed.

3 System Displays the following system information.
® Date and time
® Fan rotation speed
® Sensor detection temperature
® Hours meter

IP Address

[Note]
The same value is displayed using Technical > Network > LAN > I[P
Address (page 56) in the full menu. “0.0.0.0" is displayed if the IP
address cannot be obtained.
4 Battery Displays the following battery information.
® Detected battery name or type
® Remaining capacity (%)
® Estimated remaining time
® Remaining capacity (Ah)
® \/oltage (V)
e Number of times that the battery has been charged
® Power source
® Supplied power source voltage
5 Media Displays the remaining capacity, remaining recording time, and
lifespan data of SxS memory cards, AXS memory cards (when
AXS-R7 is attached), and SD cards.
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Project Frame Effective picture Main recording format SxS sub recording

Recording Format Settings

Rate size (Imager Mode) ~aAxs Rec Format 6 Fare Heimme format (Sub Rec
Format)
The following recording formats can be selected for different combinations of effective picture size and 23.98/25/2997  3.8K169 Rec Off Rec Off -
project frame rate settings. (3840%2160) QFHD XAVC-I Class480  Rec Off
If a value shown underlined and in bold text is selected, a LUT setting can be applied to the recorded MPEG HD422
video signal. QFHD XAVC-l Class300  Rec Off
MPEG HD422

Project Frame

Effective picture

Main recording format

SxS sub recording

Rate size (Imager Mode) ~ Ay Rec Format SxS Rec Format format (Sub Rec MPEG HD422 -
Format) FHD ProRes 422 HQ -
23.98/25/29.97 4K 17:9 Rec Off Rec Off - FHD ProRes 422 -
(4096x2160) 4K XAVC-| Class480 Rec Off RAW/X-OCN 5T/ Rec Off -
MPEG HD422" X-OCN LT MPEG HD422 -
4K XAVC-| Class300 Rec Off FHD ProRes 422 HQ -
MPEG HD422" FHD ProRes 422 -
RAW/X-OCN ST/ Rec Off Rec Off FHD ProRes 422 Proxy -
X-OCN LT MPEG HD422" _ 3.8K16:9 Rec Off Rec Off -
FHD ProRes 422 HQ - Surround MPEG HD422 -
FHD ProRes 422 - (3840x2160) FHD ProRes 422 HQ -
FHD ProRes 422 Proxy - Picture size FHD ProRes 422 7
Y (4268x2400)

4K 179 Rec Off - _ RAW/X-OCN ST/ Rec Off -
Surround RAW/X-OCN ST/ Rec Off - X-OCN LT MPEG HD422 -
(4096x2160) X-OCN LT MPEG HD422 - FHD ProRes 422 HQ -
Picture size FHD ProRes 422 ~

FHD ProRes 422 H - roRes

(4552%2400) fones Q

FHD ProRes 422

FHD ProRes 422 Proxy

FHD ProRes 422 Proxy
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Project Frame

Effective picture

Main recording format

SxS sub recording

Project Frame Effective picture

Main recording format

SxS sub recording

Rate size (Imager Mode) ~aAxs Rec Format 6 Bar Faime format (Sub Rec Rate size (Imager Mode) ~aAxs Rec Format 6 Fare Heimme format (Sub Rec
Format) Format)
23.98/25/29.97 4K 43 Rec Off Rec Off - 23.98/25/29.97 4K 6:5 Rec Off Rec Off -
Anamorphic 4K XAVC-I Class481 Rec Off Anamorphic 4K XAVC-I Class480 Rec Off
(4096x3024) MPEG HD422 (4096x3432) MPEG HD422
4K XAVC-I Class300 Rec Off 4K XAVC-I Class300 Rec Off
MPEG HD422 MPEG HD422
MPEG HD422 - MPEG HD422 -
FHD ProRes 422 HQ - FHD ProRes 422 HQ -
FHD ProRes 422 - FHD ProRes 422 -
X-OCN ST/X-OCN LT  Rec Off - X-OCN ST/X-OCN LT Rec Off -
MPEG HD422" - MPEG HD422 -
FHD ProRes 422 HQ - ProRes 422 HQ -
FHD ProRes 422 - ProRes 422 -
FHD ProRes 422 Proxy - FHD ProRes 422 Proxy -
4K 4:3 Rec Off Rec Off - 6K 17:9 Rec Off Rec Off -
Anamorphic MPEG HD422 - (6054%3192) 4K XAVC- Class480 Rec Off
surround FHD ProRes 422 HQ - MPEG HD422
lfi‘gtgﬁ:iioj:) FHD ProRes 422 - 4KXAVCI Class300  Rec Off
(4552x3360) X-OCN ST/X-OCN LT  Rec Off - MPEG HD422
MPEG HD422 - X-OCN ST/X-OCN LT Rec Off -
FHD ProRes 422 HQ - MPEG HD422 -
FHD ProRes 422 - ProRes 422 HQ -
FHD ProRes 422 Proxy - ProRes 422 -

FHD ProRes 422 Proxy
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Project Frame Effective picture

Main recording format

SxS sub recording Project Frame

Effective picture

Main recording format

SxS sub recording

Rate size (Imager Mode) ~aAxs Rec Format 6 Bar Faime format (Sub Rec Rate size (Imager Mode) ~aAxs Rec Format 6 Fare Heimme format (Sub Rec
Format) Format)
23.98/25/29.97 6K 1.85:1 Rec Off Rec Off - 24 4K17:9 Rec Off Rec Off -
(6054x3272) 4K XAVC-l Class480 Rec Off (4096x2160) 4K XAVC- Class480 -
MPEG HD422 4K XAVC-I Class300 -
4K XAVC-I Class300 Rec Off RAW/X-OCN ST/ Rec Off -
MPEG HD422 X-OCNLT FHD ProRes 422HQ -
MPEG HD422 - FHD ProRes 422 -
FHD ProRes 422 HQ - FHD ProRes 422 Proxy -
FHD ProRes 422 - 4K 17:9 Rec Off Rec Off -
X-OCN ST/X-OCN LT  Rec Off - Surround RAW/X-OCN ST/ Rec Off -
MPEG HD422 - (4096x2160) X-OCN LT FHD ProRes 422HQ -
FHD ProRes422HQ - Picture size FHD ProRes 422 -
(4552x2400)
FHD ProRes 422 - FHD ProRes 422 Proxy -
FHD ProRes 422 Proxy - 3.8K 16:9 Rec Off Rec Off -

6K 3:2 (6048x4032)  Rec Off

* This effective X-OCN ST/X-OCN LT
picture size is not

supported when

Project Frame

Rate is set to

29.97.

Rec Off

MPEG HD422

FHD ProRes 422 HQ

FHD ProRes 422

FHD ProRes 422 Proxy

(3840x2160)

FHD ProRes 422 HQ

FHD ProRes 422

RAW/X-OCN ST/

Rec Off

X-OCN LT FHD ProRes 422 HQ -

FHD ProRes 422 -

FHD ProRes 422 Proxy -

3.8K 16:9 Rec Off Rec Off -
Surround FHD ProRes 422 HQ -
(3840x2160) FHD ProRes 422 -
Z%“gi;fgo) RAW/X-OCN ST/X-  Rec Off -
OCN LT FHD ProRes 422 HQ -

FHD ProRes 422 -

FHD ProRes 422 Proxy -

4K 4:3 Rec Off Rec Off -
Anamorphic 4K XAVC-I Class481 -
(4096x3024) 4K XAVC-l Class300 -

FHD ProRes 422 HQ

FHD ProRes 422

X-OCN ST/X-OCN LT

Rec Off

FHD ProRes 422 HQ

FHD ProRes 422

FHD ProRes 422 Proxy
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Project Frame

Effective picture

Main recording format

SxS sub recording

Project Frame Effective picture

Main recording format

SxS sub recording

Rate size (Imager Mode) ~aAxs Rec Format 6 Bar Faime format (Sub Rec Rate size (Imager Mode) ~aAxs Rac Format SxS Rec Format format (Sub Rec
Format) Format)
24 4K 43 Rec Off Rec Off - 50/59.94 4K17:9 Rec Off Rec Off -
Anamorphic FHD ProRes 422 HQ - (4096x2160) 4K XAVC-I Class300 Rec Off
surround FHD ProRes 422 - MPEG HD422"
(4096x3024) X-OCN ST/X-OCN LT Rec Off - RAW/X-OCNST/  Rec Off -
Picture size
(4552%3360) FHD ProRes 422HQ - X-OCNLT MPEG HD422" -
FHD ProRes 422 - FHD ProRes 422 HQ -
FHD ProRes 422 Proxy - FHD ProRes 422 -
4K 6:5 Rec Off Rec Off - FHD ProRes 422 Proxy -
Anamorphic 4K XAVC-I Class481 - 3.8K16:9 Rec Off Rec Off -
(4096x3432) 4K XAVC Class300 - (3840%2160) QFHD XAVC Class300  Rec Off
FHD ProRes 422 HQ - MPEG HD422
FHD ProRes 422 - MPEG HD422 -
X-OCN ST/X-OCN LT Rec Off - FHD ProRes 422 HQ -
FHD ProRes 422 HQ - FHD ProRes 422 -
FHD ProRes 422 - RAW/X-OCN ST/ Rec Off -
FHD ProRes 422 Proxy - X-OCNLT MPEG HD422 -
6K 17:9 Rec Off Rec Off - FHD ProRes 422 HQ -
(6054x3192) 4K XAVC-| Class481 - FHD ProRes 422 -
4K XAVC-I Class300 - FHD ProRes 422 Proxy -
X-OCN ST/X-OCN LT Rec Off - U Horizontal frame with black bars across top and bottom (letterboxing).
ProRes 422 HQ -
ProRes 422 -
FHD ProRes 422 Proxy -
6K 1.85:1 Rec Off Rec Off -
(6054x3272) 4K XAVC-I Class480 -
4K XAVC-I Class300 -
FHD ProRes 422 HQ -
FHD ProRes 422 -
X-OCN ST/X-OCN LT Rec Off -
FHD ProRes 422 HQ -
FHD ProRes 422 -
FHD ProRes 422 Proxy -
6K 3:2 Rec Off - -
(6048x4032) X-OCN ST/X-OCN LT Rec Off -

FHD ProRes 422 HQ

FHD ProRes 422

FHD ProRes 422 Proxy
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Full Menu Operations

The full menu for configuring the required settings

Setting Menu ltems

for shooting and playback is displayed on the sub COHUO|S
display be pressing and holding the MENU button
for 2 seconds or longer.
MENU button (page 8)

Press and hold for 2 seconds or longer to display
the full menu on the sub display.

Menu Structure

SEL/SET dial (MENU dial) (page 8)

Turn to move the cursor in the corresponding
Shooting menu direction to select setting items or setting values.

Press the MENU dial to apply the selected item.
Menu used to make settings related to shooting.

_ BACK button (page 9)
Project menu Press to return to the previous menu. Unconfirmed

) i ) changes are canceled.
Menu used to make basic settings for a project.

TC/Media menu

Menu used to make settings related to timecode
and recording media.

Monitoring menu

Menu used to make settings related to video
output and viewfinder output.

Audio menu

Menu used to make settings related to audio.

Technical menu

Menu used to make settings related to technical
matters.

Maintenance menu

Menu used to make unit settings, such as the clock
and language settings.

Turn the MENU dial to move the cursor to the

menu item you want to set, then press the MENU

dial to select that item.

® The menu item selection area can show a
maximum of nine lines. When all the selectable
items cannot be displayed at one time, you can
scroll the display up or down by moving the
cursor.

® Foritems having a wide range of available
values (example: =99 to +99), the selection
area is not displayed. The current setting is
highlighted to indicate that the value can be
changed.

® |f you select Execute for an executable item, the
corresponding function is executed.

® \When you select an item that you must confirm
before execution, a confirmation message
appears. Follow the instructions in the message
to execute or cancel the operation.
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Full Menu List

The functions and available settings of each menu item are given below.

Shooting Menu

Default values are shown underlined and in bold text.

Shooting > Shutter

Makes settings related to the electronic shutter.

Menu item

Settings

Description

Shooting > FPS
Sets the shooting frame rate.
[Note]

FPS cannot be configured if Project > Basic Setting > SxS Rec Format in the full menu is set to interlaced recording. In this
case, the Fixed/Variable Select setting changes to Fixed.

Shutter Select

When Shutter Mode (page 56)

is set to Speed

Default selection options
1/24,1/25,1/30, 1/50, 1/60,
1/100, 1/120, 1/250, 1/500,
1/1000, 1/2000"

When Shutter Mode (page 56)

is set to Angle

Default selection options
360.0/180.0/172.8/144.0/

Selects shutter angle or speed of the electronic
shutter.
The default speed values for different Project
Frame Rate (page 50) settings are given below.
23.98/24:1/24
25:1/25
29.97:1/30
50:1/50
59.94:1/60

Menu item Settings Description 90.0/45.0/22.5/11.2/5.6
Fixed/Variable Select  Fixed/Variable Selects whether the FPS setting is set to constant When Step/Cont. Selegt is set to
speed shooting or variable speed shooting. Continuous, the selection rang;e
FPS Select When Fixed/Variable Select is set ~ Selects the shooting frame rate. 5 360.0z)to 4.2 (Angle) or 1/24" to
to Fixed, one of the following The default values vary as shown below 1/8000 (Speed). ‘
values is displayed. depending on the Project Frame Rate setting. Step/Cont. Select Step/Continuous Selects vvhetherthg electronic shutter values are
Fixed 24/Fixed 25/Fixed 30/ step values or continuous.
Fixed 50/Fixed 60 Project  Default when Display value Add/Change Step Adds or edits a selection option available in
When Fixed/Variable Selectis set ~ Frame Fixed/Variable  when Fixed/ Shutter Select in Step mode.
to Variable, you can set FPS inthe  Rate Select is Variable Variable Select is Up to 16 selection options can be added.
following range. Fixed Delete Step Deletes a selection option available in Shutter
1 to 60l 5004 60 Fixed 60 Select in Step mode.
50 50 Fixed 50 Shooting > ND
2097 30 Fixed 30 Sets the ND filter position.
5 25 Fixed 25 Menu item Settings Description
24 24 Fixed 24 ND Position Clear/0.3/0.6/0.9/1.2/1.5/1.8/2.1/  Selects the density of the ND filter.

2397 24 Fixed 24

24
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Shooting > Exposure Index

Sets the El value.

Shooting > LUT Select

Makes settings related to the LUT to apply to the output image.

Menu item Settings Description Menu item Settings Description
El Select The setting changes as follows Selects the El value. HDMI Log/s709/R709(800%)/Look Displays the LUT to apply to HDMI output image.
depending on the Project > Basic The default values are given
Setting > Base 1SO (page 50) below.
setting in the full menu. When Output Format > SDI
1ISO 500: 1/2 is 2K/HD: s709
125E1/160El/200El/250EI/320El/ When Output Format > SDI
400EI/500EI/640El/800El/ 1/2 is 4K/QFHD and HDMl is
1000EI/1250EI1/1600El/2000E! not 4K/QFHD: Look
ISO 2500: When Output Format >
640EI/800EI/1000EI/1250El/ HDMI is 4K/QFHD: Log
1600EI/2000El/2500El/
3200E1/4000El/5000El/ VF LUT Log/s709/R709(800%) Selects the LUT to apply to the viewfinder output
6400EI/8000EI/10000EI image.
SxS Rec Log/Look/--- Selects the LUT to apply to SDI Main clip recorded
Shooting > White Balance video.
WENSES el e e Eie] 0 W 2 96 e, Sub Rec Log/Look/--- Selects the LUT to apply to SDI Sub clip recorded
Menu item Settings Description video.
Color Temp. Select 3200K+00/4300K+00/ Displays and selects the color temperature/color
5500K+00 tone of the white balance. Shooting > Look

+ other added options (up to 16)

Makes settings related to Preset Look.

Add/Change Step

Adds or edits a selection option by changing the

color temperature and tint value of white balance.

Menu item

Settings

Description

Delete Step

Deletes an added selection option.

Category

Preset Look/User 3D LUT

Selects the LUT category.

Auto White Balance

Execute/Cancel

Executes auto white balance (execute by
selecting Execute).

Shooting > LUT Select

Makes settings related to the LUT to apply to the output image.

Menu item Settings Description

SDI1/2 Log Display only, as LUT cannot be applied to the SDI
1/2 output image.

SDI3/4 Log/Look/--- Selects the LUT to apply to the SDI 3/4 output
image.

Monitor Log/s709/R709(800%)/Look/-—-  Selects the LUT to apply to the Monitor output

The default values are given
below.
When Output Format > SDI
1/2is 2K/HD: s709
When Output Format > SDI
1/2 is 4K/QFHD: Look

image.

Preset Look Select

5709/ R709(800%) / S-Gamut3.

Cine/SLog3 / S-Gamut3/SLog3

Selects the Preset Look.

Outputs images that are suitable as the starting
point for color grading or images that are close to
print film quality.

$709: Cinema color

R709(800%): Faithful color

S-Gamut3/SLog3: Wide color space
S-Gamut3.Cine/SLog3: Color space for digital
cinema

[Notes]

e Configurable only when Category is set to Preset
Look.

® S-Gamut3/SLog3 can be selected only when Project
> Basic Setting > Input Color Space (page 50) in the
full menu is set to S-Gamut3/SLog3.

User 3D LUT Select

File name (01 to 16) of User 3D
LUT files stored in internal
memory

Selects the User 3D LUT file.

[Note]
Configurable only when Category is set to User 3D LUT.
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Shooting > Look File

Loads a User 3D LUT file into the unit.

Project Menu

Default values are shown underlined and in bold text.

Menu item Settings Description

Load User 3D LUT Loads a User 3D LUT file stored on an SD card into
the unit.

Reset User 3D LUT Resets a User 3D LUT data setting.

Reset All User 3D LUTs  Execute/Cancel Resets all User 3D LUT data settings (execute by

selecting Execute).

Project > Basic Setting

Makes settings related to picture size and project frame rate.

V" The options are 1/60 and subsequent values when the project frame rate is 59.94, 1/50 and subsequent values when 50.0,
1/30 and subsequent values when 29.97, and 1/25 and subsequent values when 25.0.
2 The options are 1/7000 and preceding values when the project frame rate is 50.0 or 25.0, and 1/6000 and preceding values

when 24.0 or 23.98.

Menu item Settings Description

Imager Mode 6K 3:2/6K 1.85:1/6K 17:9/ Selects the effective picture size.
4K 6:5/4K 4:3/ ' [Notes]
4K 4:3 Surround View/ ® 6K 3:2/6K 1.85:1/6K 17:9 are displayed only when a
4K17:9/ Full Frame license is installed.
4K 17:9 Surround View/ ® 4K 6:5/4K 4:3/4K 4:3 Surround View are displayed only
3.8K 16:9/ when an Anamorphic license is installed.

3.8K 16:9 Surround View

Project Frame Rate

23.98/24/25/29.97/50/59.94

Selects the project frame rate.

Input Color Space

S-Gamut3.Cine/SLog3 /
S-Gamut3/SLog3

Sets the color space.

AXS Rec Format
(Only when an AXS-R7
is attached)

Rec Off/RAW SQ/X-OCN ST/X-
OCN LT

Selects the video format for recording onto an
AXS memory card inserted into an AXS-R7.

SxS Rec Format

Rec Off/XAVC 4K Class480/
XAVC 4K Class300/
XAVC QFHD Class480/
XAVC QFHD Class300/
MPEG HD P/MPEG HD i/
ProRes 422 HQ HD P/
ProRes 422 HQ HD i/
ProRes 422 HD P/
ProRes 422 HD i/
ProRes Proxy HD P/
ProRes Proxy HD i

Selects the video format to be recorded on an SxS
memory card.

Sub Rec Format

Rec Off/MPEG HD P/MPEG HD i

Selects the sub recording format for SxS memory
cards.

Base ISO ISO 500/1S0 2500 Sets the base ISO sensitivity.
SxS/Output De- x2.0 Displays the de-squeeze process status for SxS
Squeeze recording signals and video output signals.

Displayed when Imager Mode is set to 4K 4:3, 4K
4:3 Surround View, or 4K 6:5.
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Project > Assignable Button :

JAssigns fugctions to assignable buttons. TC/Med ld Men u

For details about assigning functions, see “User Functions Screen” (page 36).

Menu item Settings Description Default values are shown underlined and in bold text.
<1> page 36 Assigns a function to assignable button 1. TC/Media > Timecode
<2> page 36 Assigns a function to assignable button 2. Miles selgs eletied) 1 feduse.
<3> page 36 Assigns a function to assignable button 3. ME EER DESETEEE
4> page 36 Assigns a function to assignable button 4 Mode Preset F-Run (Ext-Lk)/Preset Selects the timecode njode.

- - R-Run/Int Regen Preset F-Run (Ext-Lk): Timecode advances
<User 1> page 36 Assigns a function to ITEM key 1. continuously from specified value, in sync
<User 2> page 36 Assigns a function to ITEM key 2. with external input timecode.
<User 3> page 36 Assigns a function to ITEM key 3. Preset R-Run: Timecode advances from specified
<User 4> page 36 Assigns a function to ITEM key 4. value only when recording.
<User 5> page 36 Assigns a function to ITEM key 5. Int Regen: Timecode continues from that of the

- - previous clip.
Pro;i/‘ct; All F!Ie ' . Manual Setting 00:00:00:00 to 23:59:59:29 Sets an arbitrary timecode value.
a. Sssettingsrelated to 'A\I—settmgs fles. — Reset Execute/Cancel Resets the timecode to 00:00:00:00 (execute by
Menu item Settings Description selecting Execute).
Load SD Card Load an All-settings file from an SD card. TC Format DF/NDF Selects the timecode format.
Save SD Card Save an All-settings file on an SD card. DF: Drop frame
File ID Displays the file ID of the All-settings file for NDF: Non drop frame
editing. TC Source Internal/External Displays the TCG sync source.
Format SD Card Formats an SD card.

Time Data Display Timecode/Duration Selects the time data to display.

TC/Media > Clip Name Format
Sets clip names. (Clip name: Camera ID + Reel Number + Shot Number + date + random string)

Menu item Settings Description

Camera ID AtoZ Sets the camera ID used when generating clip
names.

Reel Number 001 to 999 Sets the numeric portion of the Reel Number
used when generating clip names.

Camera Position C/L/R Sets the first character portion of the Shot

Number used when generating clip names.

TC/Media > Format Media
Formats media.

Menu item Settings Description

AXS Slot A Execute/Cancel Initializes the AXS memory card in slot A (execute
(Only when an AXS-R7 by selecting Execute).

is attached)

AXS Slot B Execute/Cancel Initializes the AXS memory card in slot B (execute
(Only when an AXS-R7 by selecting Execute).

is attached)
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TC/Media > Format Media
Formats media.

Monitoring Menu

Menu item Settings Description
SxS Slot A Execute/Cancel Initializes the SxS memory card in slot A (execute Default values are shown underlined and in bold text.
by selecting Execute). Monitoring > Output Format
SxS Slot B Execute/Cancel Initializes the SxS memory card in slot B (execute Makes settings related to output format.
by selecting Execute). Menu item Settings Description
sbCard Execute/Cancel Formats the SD card (execute by selecting SDI1/2 The available settings vary Selects the SDI 1/2 output format.
Execute). according to the imager mode,  Settings vary according to the recording format
TC/Media > Update Media project frame rate, and SxS (page 76).
Updates the media’s management file. recording format settings.
Menu item Settings Description SDI'3/4 The available settings vary Selects the SDI 3/4 output format.
AXS Slot A Execute/Cancel Updates the management file on the AXS dep{ending on the SDI 1/2 Settings vary according to the recording format
(Only when an AXS-R7 memory card in slot A of the AXS recorder setting. (page 76).
is attached) (execute by selecting Execute). Monitor The available settings vary Selects the Monitor output format.
AXS Slot B Execute/Cancel Updates the management file on the AXS dep'ending on the SDI'1/2 Settings vary according to the recording format
(Only when an AXS-R7 memory card in slot B of the AXS recorder setting. (page 79).
is attached) (execute by selecting Execute). HDMI The available settings vary Selects the HDMI output format.
SXS Slot A Execute/Cancel Updates the management file on the SxS memory depAending on the SDI1/2 Settings vary according to the recording format
card in slot A (execute by selecting Execute). setting. (page 79).
SxS Slot B Execute/Cancel Updates the management file on the SxS memory Monitoring > VF OSD
card in slot B (execute by selecting Execute). Makes settings related to information and frame lines superimposed on the viewfinder output signal.
Menu item Settings Description
Status Info On/Off Turns the function to superimpose information on
the viewfinder output signal on/off.
Status Info Select Info. A/Info. B Selects the information to display superimposed
on the viewfinder output signal.
Frame Line On/Off Turns the function to superimpose frame lines on

the viewfinder output signal on/off.

Frame Line Select

Frame Line A/Frame Line B

Selects the frame lines to display superimposed
on the viewfinder output signal.

VF Magnifier Ratio

%x2.0 /x4.0/ %x2.0/%x4.0

Selects the focus magnification ratio for the
viewfinder.

Monitoring > SDI OSD

Makes settings related to information and frame lines superimposed on the SDI output signal.

Menu item Settings Description

Status Info On/Off Turns the function to superimpose information on
the SDI 3/4 output signal on/off.

Status Info Select Info. A/Info. B Selects the information to display superimposed
on the SDI 3/4 output signal.

Frame Line On/Off Turns the function to superimpose frame lines on

the SDI 3/4 output signal on/off.
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Monitoring > SDI OSD
Makes settings related to information and frame lines superimposed on the SDI output signal.

Menu item Settings Description

Monitoring > Status Info B
Makes settings related to information displayed on the output image when Status Info Select is set to
“Info. B” for each OSD menu item.

Frame Line Select Frame Line A/Frame Line B Selects the frame lines to display superimposed

on the SDI 3/4 output signal.

Monitoring > Monitor OSD
Makes settings related to information and frame lines superimposed on the Monitor/HDMI output signal.

Menu item Settings Description

Status Info On/Off Turns the function to superimpose information on
the Monitor/HDMI output signal on/off.

Status Info Select Info. A/Info. B Selects the information to display superimposed
on the Monitor/HDMI output signal.

Frame Line On/Off Turns the function to superimpose frame lines on

the Monitor/HDMI output signal on/off.

Menu item Settings Description

Project On/Off Turns the project information display on/off.

Timecode On/Off Turns the timecode information display on/off.

Audio Level Meter On/Off Turns the audio level meter indicators on/off.

Look Status On/Off Turns the Look type indicator on/off.

Output LUT On/Off Turns the output LUT information display on/off.

Recording LUT On/Off Turns the recording LUT information display on/
off.

VF Status On/Off Turns the viewfinder status indicator on/off.

Lens Status On/Off Turns the lens information display on/off.

Frame Line Select Frame Line A/Frame Line B Selects the frame lines to display superimposed

on the Monitor/HDMI output signal.

Monitoring > Display Info
Makes settings related to focus position display units.

Menu item Settings Description

Monitoring > HDMI OSD
Makes settings related to information superimposed on the HDMI output signal.

Focus Distance Format Meter/Feet Selects the focus position display units.

Menu item Settings Description

OSD Status Same as SDI/Same as Monitor Selects whether the information displayed
superimposed on the HDMI output signal is the
same as for the SDI output signal or Monitor

output signal.

Monitoring > Frame Line A
Makes settings related to information displayed on the output image when Frame Line is set to Frame
Line A for each OSD menu item.

Monitoring > Status Info A
Makes settings related to information displayed on the output image when Status Info Select is set to
“Info. A" for each OSD menu item.

Menu item Settings Description

Center Marker On/Off Turns the center marker on/off.

Aspect Ratio On/Off Turns the aspect marker on/off.

Aspect Safety Zone On/Off Turns the aspect safety zone marker on/off.
Picture Area On/Off Turns the picture area indicator on/off.
Safety Zone On/Off Turns the safety zone indicator on/off.

User Frame Line On/Off Turns the user frame lines indicator on/off.

Monitoring > Frame Line B
Makes settings related to information displayed on the output image when Frame Line is set to Frame
Line B for each OSD menu item.

Menu item Settings Description

Project On/Off Turns the project information display on/off.

Timecode On/Off Turns the timecode information display on/off.

Audio Level Meter On/Off Turns the audio level meter indicators on/off.

Look Status On/Off Turns the Look type indicator on/off.

Output LUT On/Off Turns the output LUT information display on/off.

Recording LUT On/Off Turns the recording LUT information display on/
off.

VF Status On/Off Turns the viewfinder status indicator on/off.

Lens Status On/Off Turns the lens information display on/off.

Menu item Settings Description

Center Marker On/Off Turns the center marker on/off.

Aspect Ratio On/Off Turns the aspect marker on/off.

Aspect Safety Zone On/Off Turns the aspect safety zone marker on/off.
Picture Area On/Off Turns the picture area indicator on/off.
Safety Zone On/Off Turns the safety zone indicator on/off.

User Frame Line On/Off Turns the user frame lines indicator on/off.




054

3. Camera Operations: Full Menu List

Monitoring > Frame Line
Makes settings related to lines and markers displayed on the output image.

Monitoring > User Frame Line
Makes settings related to the user frame lines.

Menu item Settings Description Menu item Settings Description
Color White/Yellow/Cyan/Green/ Selects the display color of frame lines. V Position Max. -266 to 266 (+0) Sets the vertical position of the center of the user
Magenta/Red/Blue frame lines.
Center Marker Cross/Open Cross/Dot Selects the display form of the center marker. The setting range becomes narrower as the
Safety Area 80%/90%/92.5%/95% Selects the safety zone range. Height setting increases above 3.
Surround View Type Line/Mask Selects the display form of the Surround View Monitoring > VF Display
marker. Makes settings related to the viewfinder display.
Line: Displays the recording area using lines. Menu item Settings Description
Mask: D|sp\ays the recgrd\ng area by mask\ng VF LUT Log/s709/R709(800%) Selects the LUT to apply to the viewfinder output
(reducing) the video signal level outside the image
di . -
A Patio T Mk reclor ma a(rfa - i " Status Info On/Off Turns the function to superimpose information on
spect Ratio Type Line/Mas S'e ectsvt e display form o the aspect marker. the viewfinder output image on/off
Line: Displays lines with color set by Color. - - - -
T ) ) Status Info Select Info. A/Info. B Selects the information to display superimposed
Mask: Displays a lower video signal level for areas L :
) on the viewfinder output image.
outside the marker area.
Frame Line On/Off Turns the function to superimpose frame lines on

Aspect Ratio Select

17:9/16:9/15:9/14:9/13:9/4:3/
1.66:1/1.85:1/2.35:1/2.39:1

Selects the mode when displaying the aspect
marker.

the viewfinder output image on/off.

Frame Line Select

Frame Line A/Frame Line B

Selects the frame lines to display superimposed
on the viewfinder output image.

Mask Level 0to15(12) Selects the brightness of the image outside the
marker when Aspect Ratio Type or Surround View
Type is set to Mask.

Aspect Safety Area 809%/90%/92.5%/95% Selects the size (percentage of the entire screen)

of the aspect safety zone marker.

Frame Line on
Playback

On/Off

Turns the function to superimpose frame lines
during playback on/off.

VF Magnifier Ratio %x2.0 /x4.0/x2.0/x4.0 Selects the focus magnification ratio for the
viewfinder.
Color -99 10 £0 to +99 Adjusts the color depth of the viewfinder image.

Monitoring > VF Function
Makes settings related to viewfinder functions.

Monitoring > User Frame Line
Makes settings related to the user frame lines.

Menu item Settings Description

Width 3t0 479 (240) Sets the user frame line width (distance from the
center to the left and right edges).

Height 3t0 269 (135) Sets the user frame line height (distance from the
center to the top and bottom edges).

H Position Max. —476 to 476 (£0) Sets the horizontal position of the center of the

user frame lines.
The setting range becomes narrower as the Width
setting increases above 3.

Menu item Settings Description
Double Speed Scan On/Off Turns the viewfinder double speed scan function
on/off.
Peaking Frequency Normal/High Selects whether the peaking frequency is normal
or high during peaking.
[Note]
The peaking level is set using the viewfinder menu.
Zebra On/Off Turns the zebra function on/off.
Zebra Select 1/2/Both Selects the zebra pattern type (Zebra 1, Zebra 2,

Both).

Zebral Level

0% to 107% (41%)

Sets the display level of zebra 1.

Zebral Aperture Level

1% to 20% (10%)

Sets the aperture level of zebra 1.

Zebra2 Level

0% to 109% (61%)

Sets the display level of zebra 2.
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Audio Menu

Default values are shown underlined and in bold text.

Audio > Audio Configuration

Makes settings related to audio input/output.

Audio > Audio Input
Makes settings related to audio recording levels.

Menu item Settings Description

AGC Mono/Stereo Mono/Stereo Automatically adjusts the input level of analog
audio signals recorded on channels 1 and 2, and
selects whether to make the adjustments
separately for each channel (Mono) or in stereo
mode (Stereo).

MIC Input Mono/ Mono/Stereo Selects whether the front microphone is

Stereo monaural (Mono) or stereo (Stereo).

Phantom Power +48V  On/Off Turns the function to supply a +48 V external

source (phantom power) to the microphone on/
off.

Monitor Output CH
Pair

CH-1/CH-2, CH-3/CH-4

Sets the audio output channels to either channels
1and 2 or channels 3 and 4.

[Note]

The audio recording level with AES/EBU signal selected is fixed.

Menu item Settings Description

CH-1 Audio Select Auto/Manual Automatically adjusts the audio recording when
set to Auto.

CH-2 Audio Select Auto/Manual Automatically adjusts the audio recording when
set to Auto.

CH-1 Audio Level -99 to £0 to +99 Adjusts the audio recording level when CH-1
Audio Select is set to Manual.

CH-2 Audio Level -99 to £0 to +99 Adjusts the audio recording level when CH-2

Audio Select is set to Manual.

Headphone Mono/ST

Mono/Stereo

Sets the headphones output to monaural (Mono)
or stereo (Stereo).

MIC Reference -60dB/-50dB/-40dB

Selects the reference input level of the
microphone.

Audio > Audio Monitor
Makes settings related to audio monitoring.

Menu item Settings

Description

Monitor CH When Monitor Output CH Pair is
set to CH-1/CH-2
CH-1/CH-2, CH-1, CH-2
When Monitor Output CH Pair is
set to CH-3/CH-4
CH-3/CH-4, CH-3,CH-4

Selects the audio channel that is output to the

headphones and speaker.

CH-1/CH-2 (CH-3/CH-4): Channel 1+2 (Channel
3+4)

CH-1 (CH-3): Channel 1 (Channel 3) only

CH-2 (CH-4): Channel 2 (Channel 4) only

Monitor Level 0to99

Adjusts the monitor audio level.

Audio > Audio Configuration
Makes settings related to audio input/output.

Menu item Settings

Description

Alarm Level 0to 99

Adjusts the alarm audio level.

[Note]

This also sets the audio level of the beep emitted when
recording starts/stops if Technical > Switch & Rec Light >

Rec Start/Stop Beep in the full menu is set to On.

Off/-6dB/-9dB/-12dB/-15dB/
-17dB

Input Limiter Mode

Selects the limiter characteristic (saturation level)

for large input signals when adjusting the audio
input level manually. Select Off if not using the
limiter.

AGC Level

-6dB/-9dB/-12dB/-15dB/-17dB  Selects the AGC characteristic (saturation level).
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Technical Menu

Default values are shown underlined and in bold text.

Technical > System Configuration
Makes settings related to control of the unit.

Technical > Test Signals
Makes settings related to color bars.

Menu item Settings Description

Color Bars On/Off Turns color bars on/off.

Color Bars Type ARIB/SMPTE Selects the type of color bars.

1KHz Tone on Color On/Off Turns the function to output a 1 kHz test signal in
Bars color bars mode on/off.

Test Saw On/Off Turns the test signal on/off.

Menu item Settings Description
SDI Rec Remote Off / HD SDI Remote I/F / Parallel  Selects the SDI remote mode control method.
Trigger Rec Off: Disables remote control.
HD SDI Remote I/F: Uses HD SDI Remote control
method.
Parallel Rec: Uses valid flag control method.
SD HDMI On/Off Turns the function to set the HDMI output signal
to SD format on/off.
Shutter Mode Speed/Angle Selects the operating mode of the electronic

shutter.

Technical > Switch & Rec Light
Makes settings related to the REC button.

Technical > Authentication

Makes basic settings related to network authentication.

Description

Menu item Settings
Lock Operator Side without Rec Button/with Rec
Button

Sets whether to lock the REC button operation
when buttons are locked using the LOCK switch
on the Operator side.

Lock Assistant Side without Rec Button/with Rec

Sets whether to lock the REC button operation

Menu item Settings Description
User Name (Displays the current user name.)  Sets the user name to use for access
authentication.
Set to “admin” by factory default.
Password (FrxxREX) Sets the password to use for access

authentication.
Set to “mpc3610” by factory default.

Button when buttons are locked using the LOCK switch
on the Assistant side.
Rec Light On/Off Turns the REC lamp on/off.
Rec Start/Stop Beep On/Off Turns the function to emit a beep sound when

recording starts and stops on/off.

Technical > Network
Makes settings related to the network.

Technical > System Configuration
Makes settings related to control of the unit.

Menu item Settings

Description

Fan Control Auto / Max / Off in Rec/Auto /
Off in Rec/Max

Selects the fan control mode.

Auto: Controls the fan automatically in response
to the internal temperature.

Max: Fan rotates at maximum speed.

Off in Rec/Auto: The fan is silent when recording,
and operates automatically in response to the
internal temperature when not recording.

Off in Rec/Max: The fan is silent when recording,
and rotates at maximum speed when not
recording.

Menu item Settings Description
Setting LAN/Off Turns the network connection on/off.
LAN DHCP (On/Off) Enables/disables DHCP.

When set to [On], an IP address is automatically
assigned to the unit. To enter the IP address of the
unit manually, set to [Off].

IP Address (DHCP/On: obtain
automatically, DHCP/Off:
192.168.2.50)

Enter the IP address of the unit.
Enabled only when DHCP is [Off].

Subnet Mask (DHCP/On: obtain
automatically, DHCP/Off:
255.255.255.0)

Enter the subnet mask of the unit.
Enabled only when DHCP is [Off].

Lens Interface Type C/Off

Sets the lens interface, before attaching a lens,
according to the lens type to attach.

[Note]
If changing this setting while the lens is attached to the
unit, turn the turn off and then on again.
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Technical > APR

Executes APR (Auto Pixel Restoration: auto adjustment of the image sensor).

Technical > DC Voltage Alarm
Sets alarms relating to external DC supply voltage.

Menu item Settings Description Menu item Settings Description

APR Execute/Cancel Executes the automatic pixel noise reduction DC(24V) Low Voltage2  22.0V to 28.0V (0.1V increments) ~ Sets the threshold value for displaying an
function (execute by selecting Execute). undervoltage warning when using a 24 V external

Reset Execute/Cancel Deletes white flecks added by execution of the power source connected to the DC IN connector.

APR function (execute by selecting Execute).

Technical > Battery
Makes settings related to batteries.

Technical > Control Display
Makes settings related to the displays.

Menu item Settings

Description

Menu item Settings

Description

Near End:Info Battery 5% to 100% (5% increments)

Sets the threshold value at which the remaining
battery capacity indicator starts flashing when
using an InfoLithium battery.

Brightness level High/Mid/Low/Minimum

Adjusts the brightness of the sub display and mini
display.

End:Info Battery 0% to 5%

Sets the threshold value for displaying the “Battery
End” warning when using an Infolithium battery.

Technical > Genlock
Makes settings related to genlock.

Menu item Settings

Description

Input Source HD SDI/Analog

Selects the genlock input signal.
HD SDI: Digital
Analog: Analog

Internal/External(HD)/
External(SD)

Reference Lock Type

Displays the genlock status. Displays the signal
type when genlocked.

Internal: Not genlocked.

External(HD): Genlocked by the HD signal.
External(SD): Genlocked by the SD signal.

Near End:Sony Battery ~ 11.5V to 17V (0.1V increments) Sets the threshold value at which the remaining
battery capacity indicator starts flashing when
using a Sony non-InfoLithium battery.

End:Sony Battery 11.0Vto 11.5V (0.1Vincrements)  Sets the threshold value for displaying the “Battery
End” warning when using a Sony non-InfoLithium
battery.

Near End:Other Battery 11.5Vto 17V (11.8V) (0.1V Sets the threshold value at which the remaining

increments) battery capacity indicator starts flashing when
using a non-Sony battery.

End:Other Battery 11.0V to 14V (0.1V increments) Sets the threshold value for displaying the “Battery

End” warning when using a non-Sony battery.

Technical > Lens Configuration
Makes settings related to E mount lenses.

Detected Battery Sony Info Battery/Sony Battery/
Other Battery/DCIN (12V)/DC IN

(24V)

Displays the result of automatic battery pack type
detection.

Menu item Settings Description
E-Mount Shading Auto/Off Sets whether to compensate for a drop in
Comp. peripheral lighting when a compatible lens is

attached.

Technical > DC Voltage Alarm
Sets alarms relating to external DC supply voltage.

Menu item Settings

Description

E-Mt Chro. Aber. Comp. Auto/Off

Sets whether to compensate for chromatic
aberration in peripheral lighting when a
compatible lens is attached.

DC Low VoltageT 11.5V to 17V (0.1V increments)

Sets the threshold value for displaying a low
voltage warning when using an external power
source connected to the DC IN connector.

DC Low Voltage2 11.0V to 14V (0.1V increments)

Sets the threshold value for displaying an
undervoltage warning when using an external
power source connected to the DC IN connector.

DC(24V) Low Voltagel = 22.5V to 34.0V (0.1V increments)

Sets the threshold value for displaying a low
voltage warning when using a 24 V external
power source connected to the DC IN connector.
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Maintenance Menu

Default values are shown underlined and in bold text.

Maintenance > Reset to Default
Returns the unit to factory default state.

Menu item Settings

Description

Maintenance > Clock Set
Makes settings related to the built-in clock.

Reset Execute/Cancel

Initializes all unit settings (execute by selecting
Execute).

Maintenance > License Options
Installs software options.

Menu item Settings

Description

Install: <target_ Execute/Cancel

license>

Installs software options (execute by selecting
Execute).

Menu item Settings Description
Time Zone UTC + 14:00 to UTC Greenwich  Selects the difference in time from UTC
to UTC = 12:00 (30-minute (Greenwich Mean Time) in increments of 30
increments) minutes.
Date Mode YYMMDD/MMDDYY/DDMMYY  Selects the display format for dates.
YYMMDD: Year, month, day
MMDDYY: Month, day, year
DDMMYY: Day, month, year
Date Sets the current date (apply by pressing Set).
Time Sets the current time (apply by pressing Set).

Maintenance > Language
Selects the display language for menus and messages.

Permanent License Installed/XX
days Remaining (YY keys)/
Expired/Not Installed

Anamorphic

Displays whether the Anamorphic option is
enabled.

Permanent License Installed: Permanent license is
installed

XX days Remaining (YY keys): Expiration of timed
license

Expired: Timed license has expired

Not Installed: Not installed

Menu item Settings

Description

Select English/ 53 (f8)

Selects the display language for the full menu and
messages.

Maintenance > Hours Meter
Displays the accumulated usage time.

Permanent License Installed/XX
days Remaining (YY keys)/
Expired/Not Installed

Full-Frame

Displays whether the Full Frame option is
enabled.

Permanent License Installed: Permanent license is
installed

XX days Remaining (YY keys): Expiration of timed
license

Expired: Timed license has expired

Not Installed: Not installed

Unique Device ID

Displays the ID used for issuing the software
option license key.

Maintenance > Firmware

Displays the version of the unit and AXS recorder, and updates the unit.

Menu item Settings Description

Camera(System) Displays the accumulated time of use of the unit
(cannot be reset).

R7 Recorder Displays the accumulated time of use of the AXS

(System) recorder connected to the unit (cannot be reset).

(Only when an AXS-R7

is attached)

Camera(Resettable) Displays the accumulated time of use of the unit
(can be reset).

R7 Recorder Displays the accumulated time of use of the AXS

(Resettable) recorder connected to the unit (can be reset).

(Only when an AXS-R7

is attached)

Reset-Cam Execute/Cancel Resets the Camera(Resettable) display to 0

(Resettable) (execute by selecting Execute).

Reset-R7 Execute/Cancel Resets the R7 Recorder(Resettable) display for the

(Resettable)
(Only when an AXS-R7
is attached)

AXS recorder connected to the unit to 0 (execute
by selecting Execute).

Menu item Settings Description

Camera Displays the firmware version of the unit (Vx.xx).
AXS Displays the firmware version of the AXS recorder
(Only when an AXS-R7 connected to the unit (Vx.xx).

is attached)

FW Update-camera Execute/Cancel Updates the unit (execute by selecting Execute).
FW Update-AXS-R7 Execute/Cancel Updates the firmware version of the AXS recorder

connected to the unit (execute by selecting
Execute).
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(lip List Screen

—

BY/ Axs

A001C001_180101CQ
A001C002_180101G7
A001C003_180101HR
A001C004_180101WK

A001C005_180101S8
A001C006_180101GF

. Media select button

Displays “SxS/AXS" if both SxS and AXS media
are playable. Press ITEM key 1 to switch the
playback media.

. Cursor up button

Press ITEM key 2 to select the clip to play from
the clip list.

Playback start button
Press ITEM key 3 to display the playback screen
(page 14) and start playback.

. Clip list

Displays a list of clips on the active playback
media. It also displays the clips status using
icons.

5.

6.

7.

Clip Operations on the Sub Display

Clip operations are performed using the clip list screen and the playback screen. You can play a clip by
selecting the clip to play from the clip list screen displayed on the sub display.

When AXS Rec Format is not set to Rec Off in the Project category in the menu, AXS media becomes
playable. Similarly, when SxS Rec Format is not set to Rec Off, SxS media becomes playable.

Press the CLIPS button (page 9) on the Assistant side to display the clip list screen for playable media
on the sub display.

2 3

a B
a B
a B
a B
a6 B
a B

Icon Meaning

Sub Clip with a created sub clip

Locked (write protection) clip

Cursor down button
Press ITEM key 5 to select the clip to play from
the clip list.

Clip position in playback media
Displays the number of the clip indicated by
the cursor and total number of clips.

Creation date and time
Displays the creation date and time of the clip
indicated by the cursor.

10.

11.

12.

13.

Format (codec)
Displays the recording format (codec) of the
clip indicated by the cursor.

Picture size indicator

Displays the effective picture size when the
clip indicated by the cursor was recorded.
[Note]

Not displayed when the playback media is an SxS
memory card.

Project frame rate/special recording mode
indicator

Displays the project frame rate and special
recording mode of the clip indicated by the
cursor.

Duration (Dur)
Displays the duration of the clip indicated by
the cursor.

Timecode (TCR)
Displays the timecode of the first frame of the
clip indicated by the cursor.

Active playback media
Displays the active playback media of the
displayed list.
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Playback Screen

The playback screen is displayed when you select a clip to play on the clip list screen and press the MENU
dial or Play button (ITEM key 3).

Function display area

Dur 00:00:00:00 23.98fps 3.8K 16:9

»» x24 DCIN 15.0V 30FPS
SXS @ 002/010 XAVC QFHD C480
A001C002_160328WW &

1. FRev button 4. Prev button
Play back at high speed in the reverse Skip to the start of the previous clip.

direction. 5. Stop/Clips button

2. Play/Pause button

Play a clip or pause playback. 6. Next button

3. FFwd button Skip to the start of the next clip.
Play back at high speed in the forward

direction.

Stop playback and return to the clip list screen.

Status display area

. Time data display

Displays the timecode of the playback
position.

. Clip number

Displays the Current playback clip number/
Total number of playable clips.

. Frame rate/imager mode indicator

Displays the project frame rate and picture
size.
[Note]

The picture size is not displayed when the playback
media is an SxS memory card.

. Special recording mode indicator

Displays the special recording mode
information of the playback clip.

. Audio level meters

Displays the playback audio level.

. Playback clip format (codec) indicator

Displays the format (codec) of the playback
clip.

Icon display
Displays the clip status using icons.

Icon Meaning

Sub Clip with a created sub clip

Locked (write protection) clip

Clip name indicator
Displays the name of the clip.

Media indicator
Displays the media being played.

. Playback status indicator

Displays the playback status.
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Playback

You can play recorded clips while the unit is in
standby mode.

[Note]

The playback controls appear on ITEM keys 1 to 6

(page 8). Press an ITEM key to select the corresponding
item.

1 Insert the SxS memory card to play.

2 Press the CLIPS button (page 9) on the
Assistant side.
The clip list on the active playback media
appears on the sub display.

3 Use the 4 button (ITEM key 2), § button
(ITEM key 5), or MENU dial to select a clip to

play.

4 Press the MENU dial or the Play button (ITEM
key 3).
The playback image appears on the viewfinder
screen.

Playback operations

Playback operation is performed using the buttons

on the sub display (page 60).

Play/Pause button: Pause playback. To resume
playback, press this button again.

F Fwd button/F Rev button: Fast forward/reverse.
To return to normal playback, press the Play/
Pause button.

Stop/Clips button: Stop playback and return to the
clip list screen.

Monitoring audio

In normal playback mode, you can monitor the
recorded audio through the built-in speaker
(page 7) or connected headphones.

When headphones are connected to the
headphones connector (page 7), the built-in
speaker is turned off.

You can select the channel to monitor and adjust
the volume using Audio category > Monitor CH
and Monitor Level (page 41) in the menu.

Cueing up

To play from the start of a clip, press the Prev
button on the sub display (page 60).

You can skip clips and cue-up another clip
by pressing the Prev button or Next button
repeatedly.

Switching the SxS memory cards

When two SxS memory cards are loaded, press
the SLOT SELECT button (page 8) to switch
memory cards.

[Note]

You cannot switch SxS memory cards during playback.
Continuous playback of cards in slots A and B is not possible.

Switching to an AXS memory card

You can quickly play video recorded on an AXS
memory card in the AXS-R7.

To switch to an AXS memory card, press I[TEM key
1 (page 59) on the sub display.
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Operations on the Home Screen of the Mini Display

You can check the status of the unit and set basic

settings for the unit on the Home screen of the
mini display.

5 WB o..

1. FPS
Sets the shooting frame rate.
2. Shutter

Displays and sets the shutter speed/shutter
angle of the electronic shutter.

3. ND Filter

Displays and sets the density of the ND filter.

4. Exposure Index
Displays and sets the exposure index (El).

5. WB (White Balance)
Displays and sets the white balance.

Controls

HOME button (page 7)
Press to return to the Home screen. Unconfirmed
changes are canceled.

ITEM key 1 () (page 7)

Press to select items on the Home screen.

ITEM key 2 (@) (page 7)

Press to apply the selected item.

ITEM key 3 (@) (page 7)

Press to select items on the Home screen.

Basic Operation

1

2

Press ITEM key 1, 2, or 3.
The cursor appears.

Select the item to set using the B button
(ITEM key 1) or & button (ITEM key 3).

FPS Fixed 24
A 180.0

ND  Clear

500
WB 5600+

Press the @ button (ITEM key 2).
The setting value selection screen appears for
the selected item.

[Note]

The @ mark indicates the current setting.

Move the cursor to the item or setting value
using the B button (ITEM key 1) or § button
(ITEM key 3).

Press the @ button (ITEM key 2) to apply the
setting.

6 Press the HOME button to hide the cursor.
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Home Screen Items on the Mini Display ftem meesipio
Exposure Index Sets the El value. The setting changes as follows depending on the Project > Basic
Setting > Base ISO (page 50) setting in the full menu.
The names of items and corresponding setting values are given below. 1SO 500:
Default values are shown underlined and in bold text. 125EI1/160El/200El/250EI/320E1/400EIl/500EI/640El/800El/1000EI/1250El/
1600EI/2000E!
Item Description 1SO 2500:
EPS Sets the shooting frame rate. 640E1/800EI/1000E1/1250El/1600E1/2000E1/2500E1/3200E1/4000E1/5000El/
Variable/Fixed: Switch between variable speed and constant speed shooting on 6400EI/8000EI/T0000EI
the Home screen (page 34) of the sub display. Shutter Sets the electronic shutter angle/shutter speed.
When “Fixed" is selected, the setting is determined by the Project category > Select from preset values registered as shutter steps.
Project Frame Rate (page 40) setting in the menu. [Note]

Not available when the electronic shutter operation is set to Continuous.

Project Frame Rate plsplay Displays the following selection options depending on the Technical > System
2398 Fixed 24 Configuration > Shutter Mode (page 56) setting in the full menu.
24 Fixed 24 Angle (A): Shutter angle indicator
25 Fixed 25 360.0/180.0/172.8/144.0/90.0/45.0/22.5/11.2"
99.97 Fixed 30 Speed (SS): Shutter speed indicator
50 Fixed 50 1/24,1/25,1/30, 1/50, 1/60, 1/100, 1/120, 1/250, 1/500, 1/1000, 1/2000"
5004 Fived 60 ND Filter Sets the density of the ND filter. The following settings are available.
: Clear/0.3/0.6/0.9/1.2/1.5/1.8/2.1/2.4
WB (White Balance) Sets the color temperature of the white balance.
When “Variable” is selected, the setting changes as follows depending on the Select from preset values registered as WB steps.
Project category > Imager Mode (page 50) setting in the menu. 3200K-+00/4300K+00/5500K+00 "
) The selection options can be changed using Step Edit on the Home screen of the sub display.
Imager Mode Setting
3.8K16:9 110 60 FPS
4K17:9
3.8K 16:9 Surround View 1t0 48 FPS
4K 17:9 Surround View
4K 4:3
4K 4:3 Surround View 1to 30 FPS
4K 6:5
6K 17:9
6K 1.85:1

6K 3:2 1to 25FPS
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Clip Operations on the Mini Display

You can play a clip by selecting the clip to play
from the clip screen displayed on the mini display.
When AXS Rec Format is not set to Rec Off in the
Project category in the menu, AXS media becomes
playable. Similarly, when SxS Rec Format is not set
to Rec Off, SxS media becomes playable.

When both AXS and SxS media playback is
enabled, you can select the active media on the
clip list screen (page 59) of the sub display.

(lip Screen

Press the CLIPS button (page 7) on the
Operator side to display the clip screen for
playable media on the mini display.

1. Playback status indicator
Displays the clip playback status.

2. Active playback media
Displays the active playback media of the
selected clip.

3. Clip name
Displays the clip name of the selected clip.

4. Clip position in playback media
Displays the clip number/total number of the
selected clip.

5. FFwd/Next button
Jumps to the next clip when ITEM key 3 (&) is
pressed while playback is paused.
Fast forwards the clip when ITEM key 3 (§) is
pressed during playback.

6. Play/Pause button
Plays/pauses clip playback when ITEM key 2
(@) is pressed.

7. F Rev/Prev button
Jumps to the previous clip when ITEM key 1 (
1) is pressed while playback is paused.
Fast reverses the clip when ITEM key 1 () is
pressed during playback.

Playing

You can play recorded clips while the unit is in
standby mode.

1 Insert the SxS memory card to play.

2 Press the CLIPS button (page 7) on the
Operator side.
The active playback clip appears on the mini
display.

3 Use the Prev button (ITEM key 1) or Next
button (ITEM key 3) to select a clip to play.

4 Press the Play/Pause button (ITEM key 2).
The playback image appears on the viewfinder
screen.

12:34:56: 00 A001C001 Play XCON ST

Playback operations

Playback operation is performed using the buttons
on the mini display (page 64).

Play/Pause button: Pause playback. To resume
playback, press this button again.

F Fwd button/F Rev button: Fast forward/reverse.
To return to normal playback, press the Play/Pause
button.

Monitoring audio

In normal playback mode, you can monitor the
recorded audio through the built-in speaker
(page 7) or connected headphones.

When headphones are connected to the
headphones connector (page 7), the built-in
speaker is turned off.

You can select the channel to monitor and adjust
the volume using Audio category > Monitor CH
and Monitor Level (page 41) in the menu.

Switching the SxS memory cards

When two SxS memory cards are loaded, press
the SLOT SELECT button (page 8) to switch
memory cards.

[Note]

You cannot switch SxS memory cards during playback.
Continuous playback of cards in slots A and B is not possible.
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Network Setup and Operations

Connecting the unit to a network allows you
to control various settings of the unit from

a computer or other device and to display
information about the unit.

Overview of Network Function

When the unit and a device are connected via
wired LAN, the unit can be accessed from a
browser on the device, displaying the web remote
control and enabling the following operations.
® Control recording on the unit (page 66)
® Configure shooting settings on the unit
(page 66)
® Control the lens attached to the unit
(page 66)
® Configure and operate assignable buttons on
the unit (page 66)
Using the web remote control allows you to start/
stop recording or configure settings remotely,
and is useful in applications where the unit is fixed
in a remote location or mounted on a crane, for
example.

Compatible Devices

You can use a computer to configure and operate
the unit. The supported devices, OS, and browsers
are shown in the following table.

Device oS Browser
Computer  Microsoft Windows 8/ Chrome
Microsoft Windows 10
macOS 10.12/10.13 Safari

[Note]

The controls may not be displayed normally, depending on
the version of the browser you are using. Operation in the
following versions of the browsers has been verified.

Safari: 11.0.1

Chrome: V66.0.3359.181

Connecting the Unit and Device

You can connect the unit to a device via a wired
LAN connection or via a router using the network
connector of the unit.

1 Connect the network connector (page 7)
of the unit to the computer or router using a
LAN cable.

2 Set Technical > Network > Setting (page 56)
in the full menu to LAN.,

3 Configure the unit.
To obtain the IP address of the unit
automatically:
Set Technical > Network > LAN > DHCP
(page 56) in the full menu to On, then select
Set to apply the setting.
To enter the IP address of the unit manually:
Set Technical > Network > LAN > DHCP in the
full menu to Off, enter the specified address
using LAN > IP Address, and select Set to apply
the setting.
[Note]
Select Set on the Technical > Network > LAN setup

screen in the full menu. If Set is not selected, the
configured settings are not applied.

When the wired LAN connection is enabled,
the LAN icon of the network connection status
indicator (page 13) is displayed.

Displaying the Web Remote Control

The web remote control is displayed when the
unit is accessed from the browser of a device. The
web remote control screen is automatically resized
to match the screen size of the connected device.

1 Connect the unit and device as described in
“Connecting the Unit and Device".

2 Launch a browser on the device and enter
“http://IP address of unit/rm.html” in the URL
bar.

You can check the IP address of the unit using
Info category > System > [P Address

(page 42) in the menu.

For example, if the IP address is 192.168.1.1,
enter "http://192.168.1.1/rm.htm!” in the URL
bar.

3 Enter the user name and password (Technical
> Authentication (page 56) in the full menu)
on the browser screen.

When connection is successful, the web
remote control screen appears on the device.

Web Remote Control Screen

Global Menu

Click B at the top left of the web remote control
screen to display the Global Menu. Click the item
you want to configure.

ntrol
0SS Information

Camera Control screen

The Camera Control screen contains the Camera

screen and Lens screen. Click the Camera tab to

display the Camera screen, and click the Lens tab

to display the Lens screen.

Various display items and operation buttons are

displayed on the Camera Control screen (common

to Camera screen, Lens screen, and playback

screen).

® Network connection status (Connected/
Disconnected)

® Camera D

® Rec button

® Assignable buttons (1 to 4)
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(Camera screen

= Camera Control

You can configure the same items that are
displayed on the Home screen of the sub display
on the Camera screen.
® Shooting settings (page 29)

FPS, El, Shutter, ND, LUT, WB

[Note]

LUT is for display only, and cannot be configured using
the web remote control. Also, Shutter and Step Edit
operations are not supported.

® (Camera status display (page 29)
Operating status, time data, audio level meter,
clip name, recording format, media status/
free space, battery voltage/remaining battery
capacity

Lens screen

= Camera Control

Assign
Roc Rovi

Focus.

1.5m

Zoom

105mm

Lens controls for zoom, focus, and iris are
displayed on the Lens screen.

0SS (Open Source Software) Information screen

Click OSS Information in the Global Menu to
display the open source software information.

Playback screen

= Camera Control

FPS £ B ‘Shutter

Fied-24 2000 1/50  ‘Home

23.98fps

Clear soia# ook 5500 +00
xS Log

ND ws

Information about the playback clip is displayed in

the status display area on the playback screen.

® Shooting settings (page 29)
FPS, El, Shutter, ND, LUT, WB
Displays the camera settings. The El value can be
changed in playback mode.

® Playback status display (page 60)
Playback operation status, time data, clip
number, playback clip format/frame rate, special
recording mode, clip name, playback media,
audio level meter

[Note]

Playback cannot be controlled from the web remote control,
except Rec Review assigned to an assignable button.

HOME button

Press the HOME button to return to the Camera
screen.

When the camera is in playback mode, pressing
the HOME button returns to the camera shooting
status even when the playback screen is displayed
on the web remote control screen.

Recording

Click the Rec button on the Camera Control screen
to start recording and to display the REC lamp in
red. Click again to stop recording.

The Rec button is enabled when the REC ACTIVE
lamp below and to the right of the Rec button is
green.

To lock the Rec button

Slide the Lock slider below the Rec button to the
right to disable the Rec button operation.

Configuring Shooting Settings

You can configure and operate the same items
that are displayed on the Home screen of the sub
display of the unit on the Camera screen.

The operation is the same as on the Home screen
of the sub display.

“Operations on the Home Screen of the Sub Display” (page 31)

[Note]

The selection options for step shutter values cannot be
edited using the web remote control. LUT is also for display
only, and cannot be configured.

Controlling the Lens

You can check the status of E mount lens settings
(zoom, focus, iris) on the Lens screen, and also
control the zoom, focus, and iris using sliders if the
attached lens is controllable.

Configuring/Operating Assignable
Buttons

Assignable buttons 1 to 4 are displayed on the
Camera Control screen.

Click assignable buttons 1 to 4 to toggle the
assigned functions between on/off (enable/
disable) or to activate the assigned functions in the
same way as assignable buttons 1 to 4 on the unit.
Click the function name of an assignable button

to display selection options in a pull-down. Select
an option to change the function assigned to the
assignable button.

“Functions that can be Assigned to Assignable Buttons 1 to 4"
(page 37)

[Note]
Functions assigned to assignable switches that are enabled
only while a button is pressed or are enabled by a long press
cannot be operated from the assignable buttons of the web
remote control. These comprise the following functions.

- Press &Hold for SDI Log

- Press & Hold for Monitor Log

- Press &Hold for VF Log
Iris Open (1/16 stop)
- lris Close (1/16 stop)

Locking the Web Remote Control
Screen
You can disable web remote control screen

operation by sliding the Lock slider to the right on
the top right of the web remote control screen.
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Basic Operations

Basic recording can be performed with the
following procedures.

1

Make sure that the necessary devices are
attached to the unit and power is supplied to
them.

Set the power switch (page 7) to the ON
position.

The recording screen is displayed on the
viewfinder screen.

Load the memory card(s).

If you load two SxS memory cards, recording is
continued by automatically switching to the
second card when the first card becomes full.

Press the REC button (pages 7, 9).
The REC lamp lights and recording begins.

[Note]

If the unit cannot start recording immediately after the
pressing the REC button, the REC lamp flashes. The REC
lamp lights when recording starts.

To stop recording, press the REC button again.
Recording stops and the unit enters STBY
(recording standby) mode.

When you stop recording, the video, audio,
and subsidiary data from the start to the end
of the recording are recorded as a single clip.

(lip names

Clip names are recorded using the “Cam ID +
Reel#” format. The clip name is created according
to the following rules.

When there is already a clip that is stored using
the “Cam ID + Reel#” name format on the
inserted SxS memory card or AXS memory card,
the new file inherits from the last file.

Example: If “B002CO03_XXXXXXXX" exists on the
AXS memory card, the next created clip will be
named “B002C004_XXXXXXXX."

If the inserted AXS memory card has no files, “1"
is added to the Reel Number of the clip that was
recorded last.

Example: If you record on empty card 2 after
recording up to “D00TCXXX_XXXXXXXX" on
card 1, the next created clip will be named
“D002CO0T_XXXXXXXX." The clip name flashes
until recording starts.

If you set Camera ID and Reel Number using TC/
Media category > Clip Naming in the menu, that
information is applied.

Example: If you change Camera ID to “F” and
Reel Number to “001" in the menu for the

AXS memory card that has recorded up to
"EO03CXXX_XXXXXXXX,” the next clip will

be named “FOOTCXXX_XXXXXXXX." When

you change Camera ID only, Reel Number is
changed to “001."

Maximum duration of a clip

The maximum single clip length that you can
record to an SxS memory card is 6 hours.
Recording stops if the recording time exceeds the
maximum clip duration.
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Useful Functions

Simultaneous Recording (Simul Rec)

You can simultaneously record two sizes of
pictures on an SxS memory card in one slot. You
can also simultaneously record an HD signal on an
SxS memory card in the unit while recording video
and audio in RAW format on the AXS-R7.

You can perform simultaneous recording using
Project category > AXS Rec Format and SxS Rec
Format or SxS Rec Format and Sub Rec Format

in the menu as described in “Recording Format
Settings” (page 43).

[Note]

In simultaneous recording mode, the unit cannot switch to
the second card automatically even if a card becomes full.

In 1-slot simultaneous recording, the XAVC 4K
Class480/XAVC 4K Class300/XAVC QFHD Class480/
XAVC QFHD Class300 clip is recorded in the
XDROQOT/Clip directory on the SxS memory card,
but the MPEG2 1920x1080 clip is recorded in the
XDROOT/Sub directory on the SxS memory card.
The suffix “S02" is appended to the end of the clip
name.

Recording Review (Rec Review)

You can review the last recorded clip on the
screen by assigning the Rec Review function to
one of assignable buttons 1 to 4 (page 36).
When you stop recording and press the button
assigned with Rec Review, the clip is played at
normal speed starting from the first frame.

The clip is played to the end, then Rec Review
ends and the unit returns to STBY (recording
standby) mode.

If the HOME button is pressed on the Operator
side or Assistant side during playback, playback
stops and the unit switches to shooting mode.

High-Definition Focus Magnifier
Function

By pressing the FOCUS MAG button of the
viewfinder (DVF-EL200, DVF-L700) attached to

the unit, you can expand the center part of the
viewfinder, making it is easier to adjust the focus.
The magnified display does not affect the recorded
image or output signal.

Normal focus magnification reduces the resolution
because it simply magnifies a part of the displayed
image. However, the two-times (x2) focusing

by the unit provides focus magnification while
maintaining the display resolution by cutting out
the portion to magnify from the 4K signal instead
of the recorded image or other output signal.
Four-times (x4) focus magnification selection

is also supported using the 4K image cutout
function.

The FOCUS MAG button magnification sequence
can be changed using Monitoring category >
Moni. Details > VF OSD (page 52) and VF Display
(page 54) > VF Magnifier Ratio in the menu.

When VF Magnifier Ratio is set to x2.0/x4.0, the
magnification sequence each time you press
assignable buttons 1 to 4 assigned with VF Focus
Magnifier is x2.0 — x4.0 — x1.0 — x2.0.

Highlight Clip Indicator

You can display clipped highlight areas in red in
the Monitor output image and viewfinder output
image.

Press the assignable buttons (pages 36, 37)
assigned with Monitor Highlight Clip Ind and VF
Highlight Clip Ind to switch the highlight clip
indicators on/off.

High Key / Low Key

You can check for blown-out highlights and
blocked-out shadows in the Monitor output image
and viewfinder output image.

Turn High Key on to differentiate areas of high
luminance, making them easier to see, to check for
blown-out highlights.

Turn Low Key on to differentiate areas of low
luminance, making them easier to see, to check for
blocked-out shadows.

Press assignable buttons 1 to 4 (page 37)

assigned with Monitor High/Low Key and VF
High/Low Key to switch the high key and low key
settings.
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4. Shooting: Useful Functions

False Color Display

You can display false color in the viewfinder (DVF-
EL200) attached to the unit by pressing the B/False
Color button on the viewfinder.

Display  Signal level S-Log3 description

color

Red 93.3% or higher ~ White clipping

Yellow 91.3%1t093.3%  Just below white
clipping

Pink 47.8%t050.8%  One stop over mid
gray

Green 389%t0422%  18% mid gray

Blue 2.6% 10 5.5% Just above black
clipping

Purple —-2.4% to 2.6% Black clipping

Viewfinder Double Speed Scan
Function

If the project frame rate is 23.98P, 24P, 25P, or
29.97P, the image may become blurred and hard
to see due to low frame frequency when you
shoot while swaying the unit to the right and the
left.

In this case, you can decrease image blur and
make it easier to see by activating the viewfinder
double speed scan function.

To activate the function, set Monitoring category >
Moni. Details > VF Function > Double Speed Scan
(page 54) in the menu to On.

[Notes]

e When this function is activated, the shutter angle of the
electronic shutter function is limited to 180 degrees or
lower.

e This function is set to Off during variable speed shooting.

e This function is enabled for the following combinations of
image size and project frame rate.
3.8K 16:9 (23.98p, 24p, 25p, 29.97p)
4K 17:9 (23.98p, 24p, 25p, 29.97p)
3.8K 16:9 Surround (23.98p, 24p)
4K 17:9 Surround (23.98p, 24p)
4K 4:3 (23.98p, 24p)

User 3D LUT

You can load a CUBE file (*.cube) for a 17-point

or 33-point 3D LUT created using RAW Viewer

or DaVinci Resolve (by Blackmagic Design)

(page 33).

Set Input Color Space to match the input color
space of when the CUBE file was created.

If the file was created using S-Gamut3.Cine/S-Log3, set
Project category > Basic Setting > Input Color Space
(page 50) in the menu to S-Gamut3.Cine/S-Log3.

Save the User 3D LUT file in the following directory
on the SD card.

PRIVATEASONY\PRO\LUT\
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5. Connecting External Devices

Connecting External Monitors and Recording Devices

To display the recording/playback image on an
external monitor, select the output signal and
use an appropriate cable for the monitor to be
connected.

The output signal from the unit can be recorded
by connecting a recording device, such as a VTR.
The same status information and menus can be
displayed on the external monitor as those on
the viewfinder screen. Set the content to display,
according to the output signal for the monitor,
using the Monitoring menu (page 52).

SDIOUT Connector (BNC Type)

Set the output format using the Monitoring menu
(page 52).

Use a commercially available 75-ohm coaxial cable
for connection.

[Note]

Check that the ground connection between the unit and
external device is securely grounded before turning the
power on. (We recommend turning on the unit and external
device after connecting a 75-ohm coaxial cable.)

When connecting an external device to the unit while the
unitis turned on, connect to the unit after connecting a 75-
ohm coaxial cable to the external device.

To start synchronized recording on an external
device

With SDI signal output selected, synchronized
recording is possible by feeding a REC

trigger signal to an external recording device
connected to the SDI OUT connector. Enable
synchronized recording by setting Technical >
System Configuration > SDI Rec Remote Trigger
(page 56) in the menu to HD SDI Remote I/F or
Parallel Rec.

[Note]

When a connected external device does not support a REC
trigger signal, the device cannot be operated.

MONITOR OUT Connector (BNC Type)

Outputs an HD SDI signal.

Set the output format using the Monitoring menu
(page 52).

Use a commercially available 75-ohm coaxial cable
for connection.

HDMI OUT Connector (Type A
Connector)

Set the output format using the Monitoring menu
(page 52).

Use a commercially available HDMI cable for
connection.

If the output format has the same resolution as the
MONITOR OUT connector signal, the same video
signal is output.

12V 0UT Connector (DCOUT 12V,
Hirose 4-pin)

24V OUT Connector (DCOUT 24V,
Fischer 3-pin)

Supplies 12V DC power to an accessory when the
power switch is set to ON. You can output a REC
Tally signal and input a REC Trigger signal through
the 12V OUT connector.

OO
®Q

Supplies 24V DC power to an accessory when the
power switch is set to ON. You can output a REC
Tally signal and input a REC Trigger signal through
the 24V OUT connector.

@
€

No. Signal 1/0  Specification No. Signal Specification

1 UNREG GND - GND for UNREG 1 GND

2 REC TALLY OUT  Open-collector 2 24V-AUX 11Vto 17 Vinput
output Output voltage : 24 V
(Max. 50 mA) Maximum output current:
Low: REC 1.0A

3 RECTRIGGER N Open or +5V DC: 22Vto 32 Vinput
Normal Output voltage: Same as
GND: Active (REQ) the input voltage

4 UNREG+12V  OUT +11Vto17VDC Maximum output current:

ouT output 20A

11Vto 17 Vinput 3 R/S
Output voltage:
Same as the input
voltage

Maximum output
current: 1.0 A

22 Vto 32 Vinput
Output voltage :
15V

Maximum output
current: 0.8 A
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AUX Connector (LEMO 5-pin)

Outputs the timecode signal.

%
©]0)
No. Signal
1 Factory Use
2 NC
3 —
4 TCOUT
5 GND
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5. Connecting External Devices

External Synchronization

When shooting with multiple units, synchronized
recording can be performed using a specific
reference signal to synchronize the timecode
among all the units.

Synchronizing the Phase of the Video
Signal (Genlock)

Genlock operation is enabled by supplying one of
the following reference signals to the GENLOCK IN
connector (page 10) of the unit.

® HDSDI 1.5G digital (Interlaced or PsF)

® HD Y analog

® SDVBS analog

Set the genlock input signal using Technical >
Genlock > Input Source (page 57) in the full
menu.

Valid input reference signals vary depending on
the project frame rate setting.

Project framerate  Valid reference signal

23.98P 1920x1080 47.95i (23.98PsF)

24P 1920x1080 48i (24PsF)

25P 1920x1080 50i
720x576 50i

29.97P 1920x1080 59.94i
720x486 59.94i

50i 1920x1080 50i
720x576 50i

50P 1920x1080 50i
720x576 50i

59.94i 1920x1080 59.94i
720x486 59.94i

59.94P 1920x1080 59.94i

720x486 59.94i

You can check the genlock status using Technical
> Genlock > Reference Lock Type (page 57) in
the menu.

[Notes]

e |[f the reference signal is unstable, genlock is not possible.

® The subcarrier is not synchronized.

Synchronizing the Timecode with
Another Device

Set the unit that supplies the timecode to a mode
in which the timecode output keeps advancing
(Free Run mode).

1 Set TC/Media > Timecode > Mode (page 51)
in the menu to Preset F-Run (Ext-Lk).

2 Supply an HD or SD reference video signal to
the GENLOCK IN connector (page 10) and a
reference timecode synchronized with that
signal to the TC IN (page 10) connector.

The built-in timecode generator of your unit locks
to the reference timecode, and the message “Ext-
Lk" is displayed on the screen.

Once about ten seconds have elapsed after

the timecode locks, the external lock state is
maintained even if the external timecode source is
disconnected.

[Notes]

e Check that the reference timecode and the reference
video signal are in a phase relationship that complies with
the SMPTE timecode standards.

e When you finish the above procedure, the timecode is
immediately synchronized with the external timecode,
and the time data indication will show the value of the
external timecode. However, wait for a few seconds until
the timecode generator stabilizes before recording.

e |[fthe frequency of the reference video signal and the
frame frequency are not the same, lock cannot be
acquired, and the unit will not operate properly. If this
occurs, the timecode will not acquire successful lock with
the external timecode.

e \When the connection is removed, the timecode advance
may shift one frame per hour with respect to the
reference timecode.

To release external lock

Change the TC/Media > Timecode > Mode
(page 51) setting in the menu.
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6. Appendix

Usage Precautions

Read this section in conjunction with the
information provided in the supplied “Before Using
This Unit” document.

Use and Storage

Do not subject the unit to severe shock

The internal mechanism may be damaged or the
body warped.

Do not cover the unit while operating

Putting a cloth, for example, over the unit can
cause excessive internal heat build-up.

After use

Always set the power switch to OFF.

Before storing the unit for a long period

Remove the battery pack.

Do not leave the unit with the lens facing the sun

Direct sunlight can enter through the lens, be
focused in the unit, and cause fire.

Shipping

® Remove the memory cards before transporting
the unit.

e |f sending the unit by truck, ship, air or other
transportation service, pack it in the shipping
carton of the unit.

(are of the Unit

If the body of the unit is dirty, clean it with a soft,
dry cloth. In extreme cases, use a cloth moistened
in a little neutral detergent, then wipe dry.

Do not use organic solvents, such as alcohol or
thinners, as these may cause discoloration or other
damage to the finish of the unit.

Refrain from cleaning with high air pressure
equipment, such as an air duster, as these may
damage optical components.

In the event of operating problems

If you should experience problems with the unit,
contact your Sony dealer.

Periodic Replacement of Fan and
Battery

The fan and battery are consumable parts that will
need periodic replacement.

When operating at room temperature, a

normal replacement cycle will be about 5 years.
However, this replacement cycle represents only
a general guideline and does not imply that the
life expectancy of these parts is guaranteed. For
details on parts replacement, contact your dealer.

Life Expectancy of the Electrolytic
Capacitor

The life expectancy of the electrolytic capacitor

is about 5 years under normal operating
temperatures and normal usage (8 hours per day;
25 days per month).

If usage exceeds the above normal usage
frequency, the life expectancy may be reduced
correspondingly.

Note about the Battery Terminal

The battery terminal of this unit (the connector for
battery packs and AC adaptors) is a consumable
part.

Power may not be supplied to the unit properly

if the pins of the battery terminal are bent or
deformed by shock or vibrations, or if they become
corroded due to prolonged outdoor use.

Periodic inspections are recommended to keep
the unit working properly and to prolong its
usable lifetime. Contact a Sony service or sales
representative for more information about
inspections.

Use and Storage Locations

Store in a level, ventilated place.

Avoid using or storing the unit in the following

places.

® |n excessive heat or cold (operating temperature

range: 0 °C to 40 °C (32 °F to 104 °F))

Remember that in summer in warm climates

the temperature inside a car with the windows

closed can easily exceed 50 °C (122 °F).

In damp or dusty locations

Locations where the unit may be exposed to

rain

Locations subject to violent vibration

Near strong magnetic fields

Close to radio or TV transmitters producing

strong electromagnetic fields.

® |n direct sunlight or close to heaters for
extended periods

To prevent electromagnetic interference from
portable communications devices

The use of portable telephones and other
communications devices near this unit can result
in malfunctions and interference with audio and
video signals.

It is recommended that the portable
communications devices near this unit be
powered off.

Note on laser beams

Laser beams may damage the CMOS image
sensor. If you shoot a scene that includes a laser
beam, be careful not to let the laser beam be
directed into the lens of the unit. Specifically, high-
power laser beams from medical devices or other
devices may cause damage due to reflected light
and scattered light.
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6. Appendix: Usage Precautions

About the Screens

® Do not leave the screens facing direct sunlight,
as this may damage the screens.

® Do not press/swipe the screens forcefully, or
leave objects on the screens, as it may cause a
malfunction, such as picture irregularity, etc.

® The screens may become warm in use. This is
not a malfunction.

LCD Panels

The LCD panel fitted to this unit is manufactured
with high precision technology, giving a
functioning pixel ratio of at least 99.99%. Thus a
very small proportion of pixels may be “stuck’,
either always off (black), always on (red, green, or
blue), or flashing. In addition, over a long period
of use, because of the physical characteristics of
the liquid crystal display, such “stuck” pixels may
appear spontaneously.

These problems are not a malfunction.

Note that any such problems have no effect on
recorded data.

OLED Panels

The OLED panel fitted to this unit is manufactured
with high precision technology, giving a
functioning pixel ratio of at least 99.99%. Thus a
very small proportion of pixels may be “stuck’,
either always off (black), always on, or flashing.

In addition, over a long period of use, because

of the physical characteristics of the organic
light-emitting diode, such “stuck” pixels may
appear spontaneously. These problems are not a
malfunction. Note that any such problems have no
effect on recorded data.

Due to the characteristics of the material used in
the OLED panel, permanent burn-in or reduction
in brightness may occur.

These problems are not a malfunction.

On Condensation

If the unit is suddenly taken from a cold to a warm
location, or if ambient temperature suddenly

rises, moisture may form on the outer surface of
the unit and/or inside of the unit. This is known

as condensation. If condensation occurs, turn off
the unit and wait until the condensation clears
before operating the unit. Operating the unit while
condensation is present may damage the unit.

Phenomena Specific to CMOS Image
Sensors

The following phenomena that may appear in
images are specific to CMOS (Complementary
Metal Oxide Semiconductor) image sensors. They
do not indicate malfunctions.

White flecks

Although the CMOS image sensors are produced

with high-precision technologies, fine white

flecks may be generated on the screen in rare

cases, caused by cosmic rays, etc. This is related

to the principle of image sensors and is not a

malfunction.

The white flecks especially tend to be seen in the

following cases.

® \When operating at high environmental
temperatures

Aliasing

When fine patterns, stripes, or lines are shot, they
may appear jagged or flicker.

Focal plane

Owing to the characteristics of the pickup
elements (CMOS sensors) for reading video signals,
subjects that quickly move across the screen may
appear slightly skewed.

Flashbanding

The luminance at the top and bottom of the
screen may change when shooting a flashlight
beam or a light source that quickly flashes.

Flicker

If recording is made under lighting produced

by discharge tubes, such as fluorescent, sodium,
or mercury-vapor lamps, the screen may flicker,
colors may vary, or horizontal stripes may appear
distorted.

Notes on the Display

® Pictures on the viewfinder screen may be

distorted by the following operations.
- Changing the video format

® \When you change the line of sight in the
viewfinder, you may see primary colors red,
green, and blue, but this is not a defect of the
unit. These primary colors are not recorded on
any recording media.

Fragmentation

If pictures cannot be recorded/reproduced
properly, try formatting the recording medium.
While repeating picture recording/playback with
a certain recording media for an extended period,
files in the media may be fragmented, disabling
proper recording/storage. In such a case, make

a backup of clips in the media then perform
formatting of the media using TC/Media > Format
Media (page 51) in the menu.
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Output Voltages of the Unit

The total output power that can be supplied to
peripheral devices from the unit varies depending
on the input voltage to the unit and the state of
the connected accessories. The maximum output
capacity ratings of the following connectors

that can supply power may not be achieved
depending on the conditions.

LENS connector: 1T A max.

12V OUT connector (4-pin):
0.8 A max. (Input voltage: 22 Vto 32 V)
1 A max. (Input voltage: 11 Vto 17 V)

24V OUT connector (3-pin):
2 A max. (Input voltage: 22 Vto 32 V)
1 A max. (Input voltage: 11 Vto 17 V)

When an AXS-R7 and DVF-EL200 are attached and
the input voltage to the unit is 14 V or lower, the
power rating available for peripheral devices is
limited.

Total power rating of peripheral devices: Y [W]
Voltage of power supply to the unit: X [V]
Power consumption of the unit: Approx. 60 W
Power consumption of the AXS-R7: Approx. 24 W
Power consumption of the DVF-EL200: Approx.
25W

Y [W] =X [V] x 9.0 [A]" - (60 + 24 + 2.5) [W]

When supplying power from the unit to

peripheral devices, make sure that the total power
requirement does not exceed the total power
rating given by the equation above.

(Note that the equation does not apply if the
calculated result exceeds the sum of the maximum
allowable output power of each power output

connector.)
V6.0 [A] when using the AC-DN10.

Notes on security

® SONY WILL NOT BE LIABLE FOR DAMAGES OF
ANY KIND RESULTING FROM A FAILURE TO
IMPLEMENT PROPER SECURITY MEASURES
ON TRANSMISSION DEVICES, UNAVOIDABLE
DATA LEAKS RESULTING FROM TRANSMISSION
SPECIFICATIONS, OR SECURITY PROBLEMS OF
ANY KIND.

® Depending on the operating environment,
unauthorized third parties on the network may
be able to access the unit. When connecting the
unit to the network, be sure to confirm that the
network is protected securely.

® From a safety standpoint, when using the unit
connected with the network, it is strongly
recommended to access the Control window
via a Web browser and change the access
limitation settings from the factory preset values
(page 56).
Changing the password regularly is also
recommended.

® Do not browse any other website in the Web
browser while making settings or after making
settings. Since the login status remains in the
Web browser, close the Web browser when you
complete the settings to prevent unauthorized
third parties from using the unit or harmful
programs from running.
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6. Appendix

Recording Formats and Output Signals

SDIOUT Connector Output Formats

The serial digital signal from an SDI OUT connector is output according to the Project category and Monitoring category settings in the menu.

For details about Project category settings combinations, see “Recording Format Settings” (page 43).

Default values are shown underlined and in bold text.

Project Monitoring > Output Format Output format
Project Frame Rate  Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 SDI'1 SDI 2 SDI 3 SDI 4
59.94/50 4K17:9 XAVC-1 4K Class300/  4096x2160P 25| 4096x2160P 28 4096x2160P YPbPr 3G Level B-DL
Rec Off 4096x2160P Square 4096x2160P Square 4096x2160P YPbPr 3G Level B-DL
2048x1080P 1920x1080i 2048x1080P YPOPr 3G | 2048x1080PYPBPI3G 1 5)0 1000 vPbpr 156 | 192010801 YPbPY 1.5G
Level B-DL Level B-DL
1920%1080P 1920x1080i 19201080 YPOPr3G | 1920xT080P YPOPr3G | 15 1 0anivppr 156 | 1920%10801 YPbPr 1.5G
Level B-DL Level B-DL
19201080 1920x1080i 1920x1080i YPBPr 1.5G | 1920x1080i YPbPr 15G | 1920x1080i YPbPr 1.5G | 1920x1080i YPbPr 1.5G
3.8K 169 XAVC-1 QFHD 3840x2160P 25| 3840x2160P 2| 3840x2160P YPbPr 3G Level B-DL
Class300/Rec Off 3840x2160P Square  3840x2160P Square 3840x2160P YPbPr 3G Level B-DL
19201080P 1920x1080i 1920X1080P YPBPr3G | 1920xT080P YPOPI3G | 105 10801 vpbpr15G | 1920%10801 YPbPr 1.5G
Level B-DL Level B-DL
1920x1080i 19201080 1920x1080i YPbPr 1.5G | 1920x1080i YPbPr 15G | 1920x1080i YPHPr 1.5G | 1920x1080i YPbPr 1.5G
4K 17:9/ ProRes 422 HQ HD P/
38K 169 ProRes 422 HD P/ 1920%1080P 19201080 19201080P YPOPr3G | 1920xT080P YPOPr3G | 15 1 0enivpopr 156 | 1920%10801 YPbPr 1.5G
Level B-DL Level B-DL
ProRes 422 Proxy HD P
MPEG 192010801/
ProRes 422 HQ HD i/ 1920%1080i 1920%1080i 1920x1080i YPOPr 15G | 1920x1080i YPbPr 15G | 19201080 YPbPr 15G | 1920%1080i YPbPr 1.5G

ProRes 422 HD i/
ProRes 422 Proxy HD i
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Project Monitoring > Output Format Output format
Project Frame Rate  Imager Mode  SxS Rec Format SDI1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4
29.97/25 6K 1.85:1/ XAVC-1 4K Class480/ 4096x2160P 2SI - 4096x2160P YPbPr 3G Level B-DS No output No output
Note] 6K3:2/ XAVC-14K Class300/  4096x2160P Square  4096x2160P Square 4096x2160P YPbPr 1.5G
i 6K 17:9/ Rec Off
6K 32 is not supported 2048x1080PsF 2048x1080PsF 1920x1080PsF 1920x1080PsF
when Project Frame 4K 4:3/4K 6:5/ 2048x1080PsF 1920>1080PsF YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G
Ratels sett02097. 4K 17:9 020 1080P<E 10200 1080p<t 1920x1080PsF 1920%1080PsF 1920x1080PsF 1920%1080PsF
YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G
3.8K16:9 XAVC-I QFHD Class480/  3840x2160P 2SI - 3840x2160P YPbPr 3G Level B-DS No output No output
XlAVC" QFHD . 3840x2160P Square  3840x2160P Square 3840x2160P YPBPr 15G
Class300/Rec O S —— S — 1920x1080PsF 1920%1080PsF 1920%1080PsF 1920x1080PsF
YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G
6K 1.85:1/ MPEG 1920x1080P/
6K 3:2/ ProRes 422 HQ HD P/
6K 17:9/ ProRes 422 HD P/ 1920x1080PsF 1920%1080PsF 1920%1080PsF 1920x1080PsF
AK43/4K65/  ProRes422 ProxyHDP  1220xX1080PsE 1920x1080PsE YPbPr 156G YPbPr 15G YPbPr 1.5G YPbPr 15G
4K17:9/
38K16:9
24 6K 1.85:1/ XAVC-l 4K Class480/  4096x2160P 28 - 4096x2160P YPbPr 3G Level B-DS No output No output
6K 3:2/ XAVC-14K Class300/  4096x2160P Square  4096x2160P Square 4096x2160P YPbPr 1.5G
6K17:9/ Rec Off 2048x1080PsF 2048x1080PsF 1920x1080P 1920%1080P
4E 413;4K 6:5/ 20481080P 19201080 YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G YPbPr 15G
4K17:
1920x1080PsF 1920x1080PsF 1920x1080P 1920%1080P
1220x1080PsF 1920x1080F YPbPr 155G YPbPr 15G YPbPr 15G YPbPr 155G
ProRes 422 HQ HD P/
1920x1080PsF 1920x1080PsF 1920%1080P 1920%1080P
ProRes 422 HD P/ 1920x1080PsF 1920x1080F YPbPr 15G YPbPr 15G YPbPr 15G YPbPr 155G

ProRes 422 Proxy HD P
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Project Monitoring > Output Format Output format
Project Frame Rate  Imager Mode SxS Rec Format SDI1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4
23.98 6K 1.85:1/ XAVC-1 4K Class480/ 4096x2160P 2SI - 4096x2160P YPbPr 3G Level B-DS No output No output
6K 3:2/ XAVC-14K Class300/  4096x2160P Square  4096x2160P Square 4096x2160P YPbPr 1.5G
6K 17.9/ Rec Off 04810807 ] 2048x1080PsF 2048x1080PsF 1920%1080P 1920x1080P
4E 43/4K6:5/ YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G
4K 17:9
1920x1080PsF 1920x1080PsF 1920x1080P 1920x1080P
12201 080FF 12201 080F YPbPr 1.5G YPBPr 15G YPbPr 1.5G YPBPr 15G
3.8K16:9 XAVC-1 QFHD Class480/  3840x2160P 2SI - 3840x2160P YPbPr 3G Level B-DS No output No output
élAVC;)S/FHD 3840x2160P Square  3840x2160P Square 3840x2160P YPbPr 1.5G
ass
1920x1080PsF 1920x1080PsF 1920x1080P 1920x1080P
Rec Off 12201 080PF 1220>1 080F YPBPr 15G YPBPr 1.5G YPbPr 1.5G YPBPr 15G
6K 1.85:1/ MPEG 1920x1080P/
6K 3:2/ ProRes 422 HQ HD P/
6K 17:9/ ProRes 422 HD P/ 1920x1080PsF 1920x1080PsF 1920x1080P 1920x1080P
AK4:3/4K 65/ ProRes 422 ProxyHD P 220X 1080PsE 192010808 YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G
4K 17:9/

3.8K16:9
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MONITOR OUT Connector/HDMI OUT Connector Output Formats

The digital signal from the MONITOR OUT and HDMI OUT connectors is output according to the Project category and Monitoring category settings in the menu.

For details about Project category settings combinations, see “Recording Format Settings” (page 43).

Default values are shown underlined and in bold text.

Project Monitoring > Output Format Output format
Project Frame Rate  Imager Mode SxS Rec Format SDI1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
59.94/50 4K17:9 XAVC-I 4K Class300/ 4096x2160P 4096x2160P
Rec Off 4096x2160P 2SI 4096x2160P 2SI 1920x1080i 1920x1080i YPbPr 1.5G
1920x1080i 1920x1080i
4096x2160P Square 4096x2160P Square 1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i
2048x1080P 1920x1080i 1920x1080i 1920x1080i 1920%1080i YPbPr 1.5G 1920x1080i
1920x1080P 1920x1080i 1920x1080i 1920x1080i 1920%1080i YPbPr 1.5G 1920x1080i
1920x1080i 1920x1080i 1920x1080i 1920x1080i 1920%1080i YPbPr 1.5G 1920x1080i
3.8K 169 XAVC-1 QFHD Class300/ 3840%x2160P 3840x2160P
Rec Off 3840x2160P 2SI 3840x2160P 2SI 1920x1080i 1920%1080i YPbPr 1.5G
1920x1080i 1920x1080i
3840x2160P Square 3840x2160P Square 1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i
1920x1080P 1920%1080i 1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i
1920%1080i 1920x1080i 1920%1080i 1920x1080i 1920%1080i YPbPr 1.5G 1920x1080i
4K17:9/ ProRes 422 HQ HD P/
3.8K16:9 ProRes 422 HD P/ 1920x1080P 1920x1080i 1920x1080i 1920x1080i 1920%1080i YPbPr 1.5G 1920x1080i
ProRes 422 Proxy HD P
ProRes 422 HQHD i/
ProRes 422 HD i/ 1920%1080i 1920x1080i 1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i
ProRes 422 Proxy HD i
MPEG 1920x1080i 1920%1080i 1920%1080i 1920x1080i YPbPr 1.5G 1920x1080i
1920x1080i 1920x1080i 720x480P V2 No output 720x480P
720x576P V3 No output 720x576P
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Project Monitoring > Output Format Output format
Project Frame Rate  Imager Mode SxS Rec Format SDI1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
29.97/25 6K 1.85:1/ XAVC-1 4K Class480/ 4096x2160P 4096X2160P
. . 4096x2160P 2SI - 1920x%1080PsF ~ ————————— 1 1920x1080PsF YPbPr 1.5G
Note] o632/ XAVC-L4K Class300/ 1020x1080PsF 1920x1080PsF
6K 3:2 is not supported 6K 17:9/ Rec Off
when Project Frame 4K 4:3/4K 65/ 4096x2160P Square  4096x2160P Square 1920x1080PsF  1920x1080PsF | 1920x1080PsF YPbPr 1.5G 1920%1080PsF
Rate is set t0 29.97. 4K17:9 2048x1080PsF 1920x1080PsF 1920x1080PsF 1920%1080PsF 1920%1080PsF YPbPr 1.5G 1920%1080PsF
1920%1080PsF 1920x1080PsF 1920x1080PsF  1920x1080PsF | 1920x1080PsF YPbPr 1.5G 1920x1080PsF
3.8K 16:9 XAVC-I QFHD Class480/ 3840x2160P 3840x2160P
. 3840x2160P 25| - 1920x1080PsF ~ ———————— 1 1920x1080PsF YPbPr 1.5G
é:cvgf;QFHD Class300/ 1920%1080PsF 1920x1080PsF
3840%2160P Square 3840%2160P Square 1920x1080PsF  1920x1080PsF | 1920x1080PsF YPbPr 1.5G 1920x1080PsF
1920%1080PsF 1920%1080PsF 1920x1080PsF  1920x1080PsF | 1920x1080PsF YPbPr 1.5G 1920x1080PsF
6K 1.85:1/ MPEG 1920x1080P/
6K 3:2/ ProRes 422 HQ HD P/
6K 17:9/ ProRes 422 HD P/
AK43/4K 65/ ProRes 422 Proxy HD P 1920%1080PsF 1920%1080PsF 1920x1080PsF  1920x1080PsF | 1920x1080PsF YPbPr 1.5G 1920x1080PsF
4K 17:9/
3.8K 16:9
24 6K 1.85:1/ XAVC-1 4K Class480/ 4096x2160P 4096x2160P
. . 4096x2160P 2SI - 1920x1080P ——— 1920x1080P YPbPr 1.5G
6K 3:2/ XAVC-| 4K Class300/ 19201080P 192051 080P
6K 17:9/ Rec Off
4K 4:3/4K 6:5/ 4096x2160P Square  4096x2160P Square 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
4K17:9 2048x1080P 1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
1920%1080PsF 1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
ProRes 422 HQ HD P/
ProRes 422 HD P/ 1920x1080PsF 1920x1080P 1920x1080P 1920%1080P 1920x1080P YPbPr 1.5G 1920x1080P

ProRes 422 Proxy HD P
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Project Monitoring > Output Format Output format
Project Frame Rate  Imager Mode SxS Rec Format SDI1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
23.98 6K 1.85:1/ XAVC-I 4K Class480/ 4096x2160P 4096x2160P
. ~ 4096x2160P 2SI - 1920x1080P —— 1920x1080P YPbPr 1.5G
6K 3:2/ XAVC-| 4K Class300/ 1920%1080P 1920%1080P
6K 17:9/ Rec Off
4K 4:3/4K 6:5/ 4096x2160P Square  4096x2160P Square  1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
4K17:9 2048x1080P 1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
1920x1080PsF 1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
3.8K16:9 XAVC-I QFHD Class480/ 3840x2160P 3840x2160P
_ 3840x2160P 2SI - 1920x1080P — 1920x1080P YPbPr 1.5G
é:cvgf;QFHD Class300/ 1920x1080P 1920x1080P
3840x2160P Square 3840x2160P Square 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
1920x1080PsF 1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
6K 1.85:1/ MPEG 1920x1080P/
6K 3:2/ ProRes 422 HQ HD P/
6K 17:9/ ProRes 422 HD P/
4K 4:3/4K 6:5/ ProRes 422 Proxy HD P 1920x1080PsF 1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
4K 17:9/
3.8K16:9

U When AXS Rec Format is set to Rec Off, this output is selected when Technical > System Configuration > SD HDMI is set to On in the menu.
2 When Project Frame Rate is 59.94.
3 When Project Frame Rate is 50.0.
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Error/Warning Indications

If a warning, caution, or operating condition that requires confirmation occurs on the unit, a message is
displayed on the sub display, the REC lamp starts flashing, and a warning sound is emitted.
The buzzer is output to the built-in speaker or to the headphones connected via the headphone

connector.

When the unit is turned on, a message appears on the sub display screen prompting you to execute APR
if the auto adjustment for the image sensor (APR) has not been performed for a certain period of time. In
this case, follow the on-screen instructions to execute APR (page 56).

Error Display

The unit will stop operation when the following kind of display occurs.

Error display Buzzer REC lamp Cause and Solution

indication

E + Error code Intermittent  High-speed The unit may be defective. Recording stops even if
flashing @REC is displayed on the viewfinder screen.

Turn off the power and check the connected
equipment, cables, and media. If the error persists
when the unit is turned on again, contact your Sony
service representative. (If power cannot be turned off
by setting the power switch to OFF, remove the
battery pack or the DC IN source.)

Warning Display

When one of the following messages occurs, use the following table to resolve the problem.

Warning display Buzzer REC lamp Cause and Solution

indication

Insufficient Voltage " Continuous  High-speed The DCIN voltage is too low. Recording is disabled.
flashing Connect another power source.

EXT. I/F Signal Error -

An error was detected with the signal on the
mounting terminal for an expansion unit.
Check the connection to the AXS-R7 or other device.

Cannot use AXS -
recorder

The AXS recorder cannot be operated correctly.
Update the firmware version of the AXS recorder.

AXS Recorder Temp. -
High"

The internal temperature of the AXS recorder is high.
Turn off the unit and allow it to cool down before
operating it again.

Lens Signal Error -

An error was detected with the signal on the
mounting terminal for an expansion unit.
Check the connection to the lens or other device.

) Message is not displayed on the monitor screen.

Caution and Operation Confirmation Display

The following caution and operation confirmation messages may appear on the monitor screen or sub
display, and warning icons may be displayed and messages displayed in the Info category > Camera
Condition in the menu. Follow the instructions provided to resolve the issue.

Display indication

Cause and Solution

Battery Error
Please Change Battery

An error was detected in the battery pack.
Replace with a normal battery pack.

Backup Battery End
Please Change

The remaining capacity of the backup battery is
insufficient.
Replace the backup battery.

Warning display Buzzer REC lamp Cause and Solution
indication
Media Full " Continuous  High-speed Clips could not be recorded, copied, or split because
flashing there is no remaining capacity on the SxS memory
card.
Replace immediately.
Battery End " Continuous  High-speed The battery pack is dead. Recording is disabled.
flashing Stop operation and recharge the battery pack.
Temperature High " Intermittent  Flashing The internal temperature is high.

Turn off the unit and allow it to cool down before
operating it again.

Cannot Use SxS(A)*
Please Change

A memory card that has been partitioned or a
memory card containing more clips that can be
handled by the unit was inserted.

The card cannot be used in the unit, and must be
replaced.

Cannot Use SxS(A)*
Unsupported File System

A card using a different file system or an unformatted
card was inserted.

The card cannot be used in the unit, and must be
replaced or formatted using the unit.

Media Error
SXS(A)* Needs to be Restored

An error occurred with the memory card. The card
requires restoration.
Restore the card.
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Display indication

Cause and Solution

SxS(A)* Error
Recording Stopped
Playback Stopped

Recording or playback stopped because an error
occurred on the memory card.
If the problem persists, replace the memory card.

Input AES/EBU is Invalid Emphasis

Emphasis signal that is not compatible with the AES/
EBU input was input.
The unit is compatible with 50u-15u Emphasis only.

Input AES/EBU is not Pro Use

A signal other than Professional Use was input to the
AES/EBU input.
The unit is compatible with Professional Use only.

Fan Stopped

The fan in the unit has stopped.
Avoid use under high temperature conditions. Turn
the unit off and contact a Sony service representative.

AXS Recorder Fan Stopped

The fan in the AXS-R7 that is connected to the unit
has stopped.

Avoid use under high temperature conditions.
Remove the AXS-R7 from the unit and contact a Sony
service representative.

Unsupported FPS
Change AXS(A) to AXS S48 Memory

Unsupported AXS memory was detected.

Recording cannot be performed. Change the
recording format for the AXS memory card, or change
the card to an AXS-A512548 or AXS-A1TS48.

Abnormal Lens Communication
Please Check “Lens IF” Setting

The type of the connected lens does not match the
unit’s setting.

Check the Technical > System Configuration > Lens
Interface setting in the menu.

Please Execute APR

The auto adjusting of the image sensor (APR) has not
been executed for a certain period.
Execute APR by pressing the MENU dial.

XXXX License Y days Remaining
(XXXX: Type of license, Y: Number of days remaining)

There are 2 days remaining before the license for the
software option will expire.

Lens I/F Error

A fault was detected in the lens I/F communication
when an E-mount lens is attached.
Check the connection to the E-mount lens.

* "SxS(B)" is displayed for the SxS memory card in slot B, “AXS(A)" is displayed for the AXS memory card in slot A of the AXS-R7,
and "AXS(B)" is displayed for the AXS memory card in slot B of the AXS-R7.
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ltems Saved in Files

Jable legend Project Menu
No: Not saved
- Not saved (temporary setting)
Item Sub-item File type
All
) Basic Setting Imager Mode Yes
ShOO“ﬂg Menu Project Frame Rate Yes
Input Color Space Yes
AXS Rec Format Yes
Item Sub-item File type SxS Rec Format Yes
All Sub Rec Format Yes
FPS Fixed/Variable Select Yes Base ISO Yes
FPS Select Yes SxS/Output De-Squeeze No
Shutter " Shutter Select Yes Assignable Button <1> Yes
Step/Cont. Select Yes <2> Yes
Add/Change Step Yes <3> Yes
Delete Step Yes <4> Yes
ND ND Position Yes <User 1> Yes
Exposure Index El Select Yes <User 2> Yes
White Balance " Color Temp. Select Yes <User 3> Yes
Add/Change Step Yes <User 4> Yes
Delete Step Yes <User 5> Yes
Auto White Balance - All File Load SD Card -
LUT Select SDI'1/2 Yes Save SD Card -
SDI 3/4 Yes File ID Yes
Monitor Yes Format SD Card -
HDMI Yes
VF LUT Yes
SxS Rec Yes
Sub Rec Yes
Look Category Yes
Preset Look Select Yes
User 3D LUT Select Yes
Look File Load User 3D LUT -

Reset User 3D LUT

Reset All User 3D LUTs

" Selection options added or edited by a user are also saved.
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TC/Media Menu

Monitoring Menu

Item

Sub-item

File type

All

Timecode

Mode

Yes

Manual Setting

Reset

TC Format

Yes

TC Source

Time Data Display

Yes

Clip Name Format

Camera ID

Yes

Reel Number

Yes

Camera Position

Yes

Format Media

AXS Slot A

AXS Slot B

SxS Slot A

SxS Slot B

SD Card

Update Media

AXS Slot A

AXS Slot B

SxS Slot A

SxS Slot B

Item Sub-item File type
All
Output Format SDI1/2 Yes
SDI 3/4 Yes
Monitor Yes
HDMI Yes
VF OSD Status Info Yes
Status Info Select Yes
Frame Line Yes
Frame Line Select Yes
VF Magnifier Ratio Yes
SDIOSD Status Info Yes
Status Info Select Yes
Frame Line Yes
Frame Line Select Yes
Monitor OSD Status Info Yes
Status Info Select Yes
Frame Line Yes
Frame Line Select Yes
HDMI OSD OSD Status -
Status Info A Project Yes
Timecode Yes
Audio Level Meter Yes
Look Status Yes
Output LUT Yes
Recording LUT Yes
VF Status Yes
Lens Status Yes
Status Info B Project Yes
Timecode Yes
Audio Level Meter Yes
Look Status Yes
Output LUT Yes
Recording LUT Yes
VF Status Yes
Lens Status Yes
Display Info Focus Distance Format Yes
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Item Sub-item File type Item Sub-item File type
All All
Frame Line A Center Marker Yes VF Function Double Speed Scan Yes
Aspect Ratio Yes Peaking Frequency Yes
Aspect Safety Zone Yes Zebra Yes
Picture Area Yes Zebra Select Yes
Safety Zone Yes Zebral Level Yes
User Frame Line Yes Zebral Aperture Level Yes
Frame Line B Center Marker Yes Zebra2 Level Yes
Aspect Ratio Yes
Aspect Safety Zone Yes
Picture Area Yes
Safety Zone Yes
User Frame Line Yes
Frame Line Color Yes
Center Marker Yes
Safety Area Yes
Surround View Type Yes
Aspect Ratio Type Yes
Aspect Ratio Select Yes
Mask Level Yes
Aspect Safety Area Yes
Frame Line on Playback Yes
User Frame Line Width Yes
Height Yes
H Position Yes
V Position Yes
VF Display VF LUT Yes
Status Info Yes
Status Info Select Yes
Frame Line Yes
Frame Line Select Yes
VF Magnifier Ratio Yes
Color Yes
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Audio Menu

Technical Menu

Item Sub-item File type Item Sub-item File type
All All
Audio Input CH-1 Audio Select Yes Test Signals Color Bars Yes
CH-2 Audio Select Yes Color Bars Type Yes
CH-1 Audio Level Yes 1kHz Tone on Color Bars Yes
CH-2 Audio Level Yes Test Saw Yes
MIC Reference Yes Switch & Rec Light Lock Operator Side Yes
Audio Monitor Monitor CH Yes Lock Assistant Side Yes
Monitor Level Yes Rec Light Yes
Audio Configuration Alarm Level Yes Rec Start/Stop Beep Yes
Input Limiter Mode ves System Configuration Fan Control Yes
AGC Level ves Lens Interface Yes
AGC Mono/Stereo ves SDI Rec Remote Trigger Yes
MIC Input Mono/Stereo Yes SD HDMI Yes
Phantom Power +48V Yes Shutter Mode Yes
Monitor Output CH Pair ves Authentication User Name No
Headphone Mono/ST Yes Password No
Network Setting Yes
LAN Yes
APR APR -
Reset -
Battery Near End:Info Battery Yes
End:Info Battery Yes
Near End:Sony Battery Yes
End:Sony Battery Yes
Near End:Other Battery Yes
End:Other Battery Yes
Detected Battery -
DC Voltage Alarm DC Low Voltage1 Yes
DC Low Voltage? Yes
DC(24V) Low VoltageT Yes
DC(24V) Low Voltage2 Yes
Control Display Brightness level Yes
Genlock Input Source Yes
Reference Lock Type -
Lens Configuration E-Mount Shading Comp. Yes
E-Mt Chro. Aber. Comp. Yes
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Maintenance Menu

Item Sub-item File type
All
Clock Set Time Zone Yes
Date Mode Yes
Date -
Time -
Language Select Yes
Hours Meter Camera(System) -

R7 Recorder(System) -

Camera(Resettable) -

R7 Recorder(Resettable) -

Reset-Cam(Resettable) -

Reset-R7(Resettable) -

Reset to Default Reset -

License Options Install: xxx -

Anamorphic -

Full-Frame -

Unique Device ID -

Firmware Camera -

AXS -

FW Update-camera -

FW Update-AXS-R7 -
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Licenses

MPEG-4 Visual Patent Portfolio
License

THIS PRODUCT IS LICENSED UNDER THE MPEG-4
VISUAL PATENT PORTFOLIO LICENSE FOR THE
PERSONAL AND NON-COMMERCIAL USE OF A
CONSUMER FOR

(i) ENCODING VIDEO IN COMPLIANCE WITH THE
MPEG-4 VISUAL STANDARD ("MPEG-4 VIDEQO")
AND/OR

(i) DECODING MPEG-4 VIDEO THAT WAS
ENCODED BY A CONSUMER ENGAGED IN A
PERSONAL AND NON-COMMERCIAL ACTIVITY
AND/OR WAS OBTAINED FROM A VIDEO PROVIDER
LICENSED BY MPEG LA TO PROVIDE MPEG-4 VIDEO.

NO LICENSE IS GRANTED OR SHALL BE IMPLIED
FOR ANY OTHER USE. ADDITIONAL INFORMATION
INCLUDING THAT RELATING TO PROMOTIONAL,
INTERNAL AND COMMERCIAL USES AND
LICENSING MAY BE OBTAINED FROM MPEG LA,
LLC. SEE HTTP://WWW.MPEGLA.COM

MPEG LA is offering licenses for (i) manufacturing/
sales of any storage media storing MPEG-4 Visual
video information (ii) distribution/broadcasting of
MPEG-4 Visual video information in any manner
(such as online video distribution service, internet
broadcasting, TV broadcasting).

Other usage of this product may be required to
obtain license from MPEGLA. Please contact MPEG
LA for any further information. MPEG LA. LL.C, 250
STEELE STREET, SUITE 300, DENVER, COLORADO
80206

http://www.mpegla.com

MPEG-4 AV( Patent Portfolio License

THIS PRODUCT IS LICENSED UNDER THE AVC
PATENT PORTFOLIO LICENSE FOR THE PERSONAL
USE OF A CONSUMER OR OTHER USES IN WHICH IT
DOES NOT RECEIVE REMUNERATION TO

(i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC
STANDARD (“AVC VIDEO") AND/OR

(if) DECODE AVC VIDEO THAT WAS ENCODED BY

A CONSUMER ENGAGED IN A PERSONAL ACTIVITY
AND/OR WAS OBTAINED FROM A VIDEO PROVIDER
LICENSED TO PROVIDE AVC VIDEO.

NO LICENSE IS GRANTED OR SHALL BE IMPLIED
FOR ANY OTHER USE. ADDITIONAL INFORMATION
MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE
HTTP://WWW.MPEGLA.COM

On Accessing Software to which the
GPL/LGPL Applies

This product uses software to which the GPL/LGPL
applies. This informs you that you have a right to
have access to, modify, and redistribute source
code for these software programs under the
conditions of the GPL/LGPL.

The source code is provided on the internet.

Use the following URL and follow the download
instructions.
http:.//www.sony.net/Products/Linux/common/
search.html

We would prefer that you do not contact us about
the contents of the source code.

For the content of these licenses, connect the unit
to a network and view the OSS Information screen
(page 66) on the web remote control screen.

Open Software Licenses

On the basis of license contracts between Sony
and the software copyright holders, this product
uses open software.

To meet the requirements of the software
copyright holders, Sony is obligated to inform you
of the content of these licenses.

For the content of these licenses, connect the unit
to a network and view the OSS Information screen
(page 66) on the web remote control screen.
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Specifications

General Specifications

Mass Approx. 3.9 kg (8 Ib 9.6 0z) (excluding
handle, VF attachment, bottom
cover)

Dimensions

See page 92.

Power requirements
12VDC(11Vto 17V)
24VDC(22Vto32V)
Power consumption
Approx. 60 W (when recording XAVC)
Operating temperature
0°Cto40°C(32°Fto 104 °F)
Storage temperature
—-20°Cto +60 °C (-4 °F to +140 °F)
Continuous operating time
Approx. 60 minutes (using BP-FLX75)
Recording format (video)
RAW SQ (4K, 17:9) (when the AXS-R7 is
attached)
X-OCN ST (6K 3:2, 4K 4:3, 4K 17:9)
(when the AXS-R7 is attached)
X-OCN LT (6K 3:2, 4K 4:3, 4K 17:9)
(when the AXS-R7 is attached)
XAVC-I Class480 (4K, QFHD)
XAVC-I Class300 (4K, QFHD)
MPEG HD422 (HD)
Apple ProRes 422 HQ (HD)
Apple ProRes 422 (HD)
Apple ProRes 422 Proxy (HD)
Recording format (audio)
LPCM 8CH (2CH recording/playback),
24-bit, 48 kHz
Recording frame rate
RAW SQ (when the AXS-R7 is attached):
4K 17:9/3.8K16:9
59.94P/50P/29.97P/25P/24P/
23.98P
X-OCN (when the AXS-R7 is attached):
6K 3:2
25P/24P/23.98P

6K 17:9/6K 1.85:1/4K €:5/4K 17:9
Surround View/4K 4:3/4K 4:3
Surround View/3.8K 16:9 Surround
View
29.97P/25P/24P/23.98P

4K 17:9/3.8K16:9
59.94P/50P/29.97P/25P/24P/
23.98P

XAVC-| Class480:

4K: 40962160
29.97P/25P/24P/23.98P

QFHD: 3840x2160
29.97P/25P/ 23.98P

XAVC-| Class300:

4K: 4096x2160
59.94P/50P/29.97P/25P/24P/
23.98P

QFHD: 3840x2160
59.94P/50P/29.97P/25P/23.98P

MPEG HD422(50Mbps):

HD: 19201080

29.97P/25P/23.98P/59.94i/50i
Apple ProRes 422 HQ:

HD: 19201080
23.98P/24P/25P/29.97P/50i/59.94i/
50P/59.94P

Apple ProRes 422:

HD: 1920x1080
23.98P/24P/25P/29.97P/50i/59.94i/
50P/59.94P

Apple ProRes 422 Proxy (HD)

HD: 1920x1080
23.98P/24P/25P/29.97P/50i/59.94i/
50P/59.94P

Recording/playback time
XAVC-I Class480 23.98P

Approx. 34 minutes when using SBP-

128B/C/D
XAVC-I Class300 23.98P

Approx. 54 minutes when using SBP-

128B/C/D
MPEG2 HD422

Approx. 108 minutes when using SBS-

64G1A/B

Apple ProRes 422 HQ (HD) 23.98P
Approx. 33 minutes when using
SBP-64A/B/C/D/E
Apple ProRes 422 (HD) 23.98P
Approx. 49 minutes when using
SBP-64A/B/C/D/E
Apple ProRes 422 Proxy (HD) 23.98P
Approx. 145 minutes when using
SBS-64G1A/B/C

[Note]

The recording and playback times are for a continuous
recording as a single clip. The actual times may be shorter,
depending on the number of clips recorded. The recording/
playback time may vary due to usage conditions and
memory characteristics.

Camera

Imaging device
35 mm full size, single-chip CMOS
image sensor
Number of pixels
24.8 M (total)

Built-in filters
ND filter A
Clear 0.3 0.6
(1/2) (1/4)
ND filterB  Clear  Clear 03 06
(1/2) (1/4)
0.9 09 1.2 15
(1/8) (1/8) (a716)  (1/32)
1.8 18 2.1 24
(1/64) (1/64) (1/128) (1/256)
ISO sensitivity

ISO 500 (D55 light source)
ISO 2500 (D55 light source)
Lens mount
PL mount (with lens mount adaptor)
E mount (without lens mount adaptor)

Flange focal length
PL mount: 52 mm
E mount: 18 mm

Latitude 15+ stops

Input/Qutput

Audio input
CH-1/CH-2: XLR-type 5-pin (female) (1),
LINE / AES/EBU / MIC / MIC+48V
selectable
DCinput
XLR-type 4-pin (male), 11 Vto 17 Vor
22Vto32VDC
DC output (12V)
Hirose 4-pin (1),
11 Vto 17V DC (Output voltage:
Same as input voltage, Maximum
output current: 1.0 A),
22 V1o 32V DC (Output voltage:
15V, Maximum output current:
0.8 A),
Using battery adaptor

[Notes]

® You can output a REC Tally signal and input a REC Trigger
signal through the 12V OUT connector.

e (Connect to the 12V OUT connector only devices with
current consumption of 1.0 A or lower when the input
voltageis 11 Vto 17V, or 0.8 A or lower when the input
voltageis 22 Vto 32 V.

DC output (24 V)
Fischer 3-pin (2),

11Vto 17V DC (Output voltage:
24V, Maximum output current:
1.0 A),
22 Vto 32V DC (Output voltage:
Same as input voltage, Maximum
output current: 2.0 A)
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[Note]

Connect to the 24V OUT connector only devices with current
consumption of 1.0 A or lower when the input voltage is
11Vto 17V, or 20 A or lower when the input voltage is 22 V
t032V.

SDI output BNC type (4)
3G-SDI: SMPTE ST424/425 Level B-DL/
DS
HD SDI: SMPTE ST292 compliant

AUX

LEMO 5-pin (1)
Viewfinder output

LEMO 26-pin (1)
Network

RJ45 type (1)
Remote control

8-pin (1)
MONITOR output

BNC type (1)

HD SDI: SMPTE ST292 compliant
Timecode input

TCIN: BNC type (1)
GENLOCK input

BNC type (1)
HDMI output

Type A (1)
External device connector

USB host: Type A (1)
Headphones output

Stereo mini jack (1)
Speaker output

Monaural

Media Slots

ExpressCard/34 slot (2)
SD card slot (1)

Type

Supplied Accessories

VF attachment (1)

Handle (1)

VF cable (A-2203-745-A) (1)

Shim (circular) (4-730-328-11) (1)
Shim (1/3 arc) (4-730-328-21) (15)

E mount lens cover (1)

Before Using This Unit (1)

Operating Instructions (CD-ROM) (1)

Optional Accessories

0.7-inch type viewfinder
DVF-EL200
7-inch type viewfinder
DVF-L700
VF cable for attaching DVF-L700
A-2201-632-A or A-2201-633-A
Portable Memory Recorder
AXS-R7
SxS memory cards (SxS Pro+/SxS-1)
SBP-64/128/256E, SBS-32/64/128G1C
Card Reader
SBAC-US30, SBAC-UT100, AXS-AR1
Shoulder Adaptor (attaches to VCT-14 using V
shoe)
VCT-FSA5
PL mount lens
SCL-PK6/F (Feet), SCL-PK6/M (Meters)
(6-lens kit: 20, 25, 35, 50, 85,
135 mm),
SCL-P11X15 (11 mm to 16 mm
zoom)
E mount lens
SELP28135G, SEL1635GM, SEL2470GM,
SEL70200GM, SEL100400GM,
SEL1224G, SEL35F147, SEL50F14Z,
SEL85F14GM, SELOOM28G,
SELTO0F28GM

Battery Pack
BP-FL75, BP-FLX75
AC Adaptor
AC-DN2B, AC-DN10
Microphone  ECM-680S, ECM-678%, ECM-674*
(*: EC-0.5X3F5M 3-pin XLR to 5-pin
XLR adaptor cable required)
Dual Battery Adaptor
BKW-L200 (connection via battery
connection adaptor)
SDI/HDMI Monitor
BVM series, PVYM series, LMD series
XQD memory cards (QDA-EX1 XQD to SxS
ExpressCard Adaptor required)
QD-S64E, QD-S32E, QD-N64, QD-
M128A, QD-M64A, QD-M32A, QD-
G128A/E, QD-G64A/E, QD-G32A/E

Design and specifications are subject to change
without notice.

Notes

e Always make a test recording, and verify
that it was recorded successfully. SONY
WILL NOT BE LIABLE FOR DAMAGES OF ANY
KIND INCLUDING, BUT NOT LIMITED TO,
COMPENSATION OR REIMBURSEMENT ON
ACCOUNT OF FAILURE OF THIS UNIT OR ITS
RECORDING MEDIA, EXTERNAL STORAGE
SYSTEMS OR ANY OTHER MEDIA OR STORAGE
SYSTEMS TO RECORD CONTENT OF ANY TYPE.

® Always verify that the unit is operating
properly before use. SONY WILL NOT BE LIABLE
FOR DAMAGES OF ANY KIND INCLUDING,
BUT NOT LIMITED TO, COMPENSATION OR
REIMBURSEMENT ON ACCOUNT OF THE LOSS
OF PRESENT OR PROSPECTIVE PROFITS DUE
TO FAILURE OF THIS UNIT, EITHER DURING THE
WARRANTY PERIOD OR AFTER EXPIRATION OF
THE WARRANTY, OR FOR ANY OTHER REASON
WHATSOEVER.

® SONY WILL NOT BE LIABLE FOR CLAIMS OF
ANY KIND MADE BY USERS OF THIS UNIT OR
MADE BY THIRD PARTIES.

® SONY WILL NOT BE LIABLE FOR THE LOSS,
REPAIR, OR REPRODUCTION OF ANY DATA
RECORDED ON THE INTERNAL STORAGE
SYSTEM, RECORDING MEDIA, EXTERNAL
STORAGE SYSTEMS OR ANY OTHER MEDIA OR
STORAGE SYSTEMS.

® SONY WILL NOT BE LIABLE FOR THE
TERMINATION OR DISCONTINUATION OF ANY
SERVICES RELATED TO THIS UNIT THAT MAY
RESULT DUE TO CIRCUMSTANCES OF ANY
KIND.
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